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Intel® Fortran Compiler Classic
and Intel® Fortran Compiler
Developer Guide and Reference

This document is for version 2021.13 of Intel® Fortran Compiler Classic (ifort) and version 2024.2 of Intel®
Fortran Compiler (i£x).

Attention

Intel® Fortran Compiler Classic (ifort) is now deprecated and will be discontinued in October 2024.
Intel recommends that customers transition now to using the LLVM-based Intel® Fortran Compiler
(ifx) for continued Windows* and Linux* support, new language support, new language features, and
optimizations.

For the latest information on transitioning from ifort to ifx, see the Porting Guide for ifort Users to
ifx.

This developer guide provides information about Intel® Fortran Compiler Classic (ifort) and its runtime
environment, and about Intel® Fortran Compiler (ifx), which is a new compiler based on the Intel Fortran
Compiler Classic (ifort) frontend and runtime libraries, uses LLVM backend technology.

Refer to the Intel® Fortran Compiler product page and the Release Notes for more information about features,
specifications, and downloads.

Use this guide to learn about:

e Compiler Setup: How to invoke the compiler on the command line or from within an IDE.

e Compiler Options: Information about options you can use to affect optimization, code generation, and
more.

e Language Reference: Information on language syntax and semantics, on adherence to various Fortran
standards, and on extensions to those standards.

e OpenMP* Support: Details about compiler support for OpenMP 5.2 and some OpenMP Version 6.0 TR12
features.

e Fortran Language Extensions: Information on using additional implementation features, including
creating a Component Object Model server, generating listing and map files, and more.

e Mixed-Language Programming: Information about Fortran and C interoperable procedures and data
types, as well as various specifics of mixed-language programming.

e Runtime Error Messages: Information about the errors processed by the Intel® Fortran runtime library
(RTL).

For more information, refer to Introducing the Intel® Fortran Compiler Classic and Intel® Fortran Compiler.

Notices and Important Information

e In this document, you may see features labeled as experimental. An experimental feature is one that
requires further testing and possible refinement. Depending on testing results, such features may be fully
defined and implemented or they may be removed in a future release.

e Support for 32-bit targets is deprecated in ifort and may be removed in a future release. i fx does not
support 32-bit targets.

e macOS is no longer supported for Intel® Fortran Compiler Classic (ifort).

Starting with the 2024.0 release, macOS is no longer supported in Intel® oneAPI Toolkits and components.


https://www.intel.com/content/www/us/en/developer/articles/guide/porting-guide-for-ifort-to-ifx.html
https://www.intel.com/content/www/us/en/developer/articles/guide/porting-guide-for-ifort-to-ifx.html
https://www.intel.com/content/www/us/en/developer/tools/oneapi/fortran-compiler.html
https://www.intel.com/content/www/us/en/developer/articles/release-notes/fortran-compiler-release-notes.html
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Using the Compiler Documentation

e Context Sensitive/F1 Help: To use the Context Sensitive/F1 Help feature, visit the Download
Documentation: Intel® Compiler (Current and Previous) page and follow the provided instructions.

e Download Previous Versions of the Developer Guide and Reference :Visit the Download
Documentation: Intel® Compiler (Current and Previous) page to download PDF or FAR HTML versions of
previous compiler documentation.

NOTE
For the best search experience, use a Google Chrome* browser to view your downloaded copy of the
Intel Fortran Compiler Developer Guide and Reference.

If you use Mozilla Firefox*, you may encounter an issue where the Search tab does not work. As a
workaround, you can use the Contents and Index tabs or a third-party search tool to find your
content.

Intel® Fortran Compiler Classic and Intel® Fortran Compiler
Introduction

Unless specified otherwise, assume the information in this document applies to all supported architectures
and all operating systems.

Architecture Support
The compiler supports Intel® 64 architecture.

OS Support
Compiler applications can run on the following operating systems:

e Linux operating systems for Intel® 64 architecture-based systems.
e Windows operating systems for Intel® 64 architecture-based systems.

You can use the compiler in the command-line or in a supported Integrated Development Environment (IDE):
e Microsoft Visual Studio* (Windows only)

The Intel Fortran Compiler (i£fx) is a new compiler based on the Intel Fortran Compiler Classic (i fort) front-
end and runtime libraries, using LLVM back-end technology. i fx supports features of the Fortran 2018
language, most of OpenMP* 5.2 and some OpenMP Version 6.0 TR12 directives and offloading features.

ifx is binary (.o/.0b7j) and module (.mod) file compatible; binaries and libraries generated with ifort can
be linked with binaries and libraries built with ifx, and .mod files generated with one compiler can be used
by the other. Both compilers use the ifort runtime libraries. ifx supports GPU offloading, which ifort does
not support. Fortran users that are uninterested in GPU offloading should continue to use ifort.

Standards Support

The compiler uses the latest standards including Fortran 2018, some Fortran 2023, most of OpenMP 5.2, and
some OpenMP 6.0 TR12 features.

Refer to the Conformance, Compatibility, and Fortran Features for more information.

Feature Requirements

This table lists dependent features and their corresponding required products. For certain compiler options,
the compilation may fail if the option is specified but the required product is not installed. In this case,
remove the option from the command line and recompile.

10


https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
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Feature Requirement
-mkl, -gmkl, —-gmkl-ilp64, /Qmkl and /Qmkl- Intel® oneAPI Math Kernel Library (oneMKL) install.

ilp64 options

Thread Checking Intel® Inspector install.

NOTE Intel® Inspector has been deprecated. See
Intel® Inspector End of Life Announcement for more
information.

Trace Analyzing and Collecting Intel® Trace Analyzer and Collector install.
Compiler options related to this feature may require

a set-up script. For further information, see the
product documentation.

NOTE Intel® Trace Analyzer and Collector has been
deprecated. See Intel® Trace Analyzer and Collector
End of Life Announcement for more information.

See the Release Notes for complete information on supported architectures, operating systems, and IDEs for
this release.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

Get Help and Support

Intel® Software Documentation

You can find product documentation for many released products at the Explore Our Documentation page. Or
you can visit the Intel® Fortran Compiler main page and scroll to the Documentation and Code Samples

section for all available documentation.

NOTE
On Windows, documentation is available from within the version of Microsoft Visual Studio. You must

install the documentation on your local system. To use the feature, visit the Download Documentation:
Intel® Compiler (Current and Previous) page and follow the instructions provided there. From the Help
menu, choose Intel Compilers and Libraries to view the installed user and reference
documentation.

Product Website and Support

To find product information, register your product, or contact Intel, visit the Get Help page and the Support
page to access a wide range of self-help resources. These pages contain comprehensive product information,

including:

e Links to Get Started, Documentation, Individual Support, and Registration.
e Links to information such as white papers, articles, and user forums.
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https://www.intel.com/content/www/us/en/developer/articles/tool/oneapi-standalone-components.html#onemkl
https://www.intel.com/content/www/us/en/developer/articles/tool/oneapi-standalone-components.html#inspector
https://www.intel.com/content/www/us/en/developer/articles/technical/inspector-deprecation.html
https://www.intel.com/content/www/us/en/developer/articles/tool/oneapi-standalone-components.html#trace
https://www.intel.com/content/www/us/en/developer/articles/technical/trace-analyzer-deprecation.html
https://www.intel.com/content/www/us/en/developer/articles/technical/trace-analyzer-deprecation.html
https://www.intel.com/PerformanceIndex
https://www.intel.com/PerformanceIndex
https://www.intel.com/content/www/us/en/resources-documentation/developer.html
https://www.intel.com/content/www/us/en/developer/tools/oneapi/fortran-compiler.html#gs.gpl0mm
https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
https://www.intel.com/content/www/us/en/developer/articles/guide/download-documentation-intel-compiler-current-and-previous.html
https://www.intel.com/content/www/us/en/developer/get-help/overview.html
https://www.intel.com/content/www/us/en/developer/tools/oneapi/support.html
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e Links to product information.
e Links to news and events.

Online Service Center

Each purchase of an Intel® Software Development Product includes a year of support services, which includes
priority customer support at our Online Service Center. Visit the Online Service Center to create and manage
your support and warranty requests.

NOTE To access support, you must register your product at the Intel Registration Center.

Release Notes

For detailed information on system requirements, late changes to the products, supported architectures,
operating systems, and Integrated Development Environments (IDE) see the Release Notes for the product.

Forums

You can find helpful information in the Intel Software user forums. You can also submit questions to the
forums. To see the list of the available forums, go to the Software Development Tools forum for general
information, or visit a specific forum for:

e Intel® Fortran Compilers

Related Information

Additional Product Information

For additional technical product information including programs, tools, and documentation, visit the
Development Tools page.

For additional product and programming information:

e Get Started with the Intel® Fortran Compiler Classic and Intel® Fortran Compiler
e Intel® Fortran Compiler main page

e Intel® Guides and Tutorials

e Intel® Intrinsics Guide

e Intel® oneAPI Programming Guide

e Intel® Technical Articles and How-Tos

Reference and Tutorial Information
The following commercially published documents provide reference or tutorial information about Fortran:

e Introduction to Programming with Fortran with coverage of Fortran 90, 95, 2003, 2008 and 77, by 1.D.
Chivers and J. Sleightholme; published by Springer, ISBN 9780857292322

e The Fortran 2003 Handbook: The Complete Syntax, Features and Procedures, by Adams, ].C., Brainerd,
W.S., Hendrickson, R.A., Maine, R.E., Martin, ]J.T., Smith, B.T., published by Springer Verlag, ISBN
9781846283789

e Fortran 95/2003 For Scientists and Engineers, by Chapman S.]., published by McGraw- Hill, ISBN
0073191574

e Modern Fortran Explained: Incorporating Fortran 2018, by Metcalf M., Reid J. and Cohen M., 2018,
published by Oxford University Press, ISBN-13: 978-0198811886

e Modern Fortran Explained: Incorporating Fortran 2023, by Metcalf M., Reid J., Cohen M., and Bader, R.
2024, published by Oxford University Press, ISBN-13: 978-0198876588
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e Parallel Programming with Co-arrays, by Robert W. Numrich, published by Hall/CRC Computational
Science, ISBN-13 978-0367571092

Intel does not endorse these books or recommend them over other books on the same subjects.

Compiler Setup

You can use the Intel® Fortran Compiler from the command line or Microsoft Visual Studio.

These IDEs are described in further detail in their corresponding sections.

Use the Command Line

This section provides information about the Command Line Interface (CLI).

Specify Component Locations

Before you invoke the compiler, you must set certain environment variables that define the location of
compiler-related components. Environment variables should be set for each terminal session before you
invoke the compiler. If you do not set the variables, the compiler can behave unpredictably. The compiler
includes environment configuration scripts to configure your build and development environment variables:

e On Linux, the file is a shell script called setvars. sh.
e On Windows, the file is a batch file called setvars.bat.

Set Environment Variables for CLI Development

NOTE

The Unified Directory Layout was implemented in 2024.0. If you have multiple toolkit versions
installed, the Unified layout ensures that your development environment contains the correct
component versions for each installed version of the toolkit.

The directory layout used before 2024.0, the Component Directory Layout, is still supported on new
and existing installations.

For detailed information about the Unified layout, including how to initialize the environment and
advantages with the Unified layout, refer to Use the setvars and oneapi-vars Scripts with Linux.

Compiler environment variables must first be configured if using the compiler from a Command Line
Interface (CLI). Environment variables are set up with a script called setvars in the Component Directory
Layout or oneapi-vars in the Unified Directory Layout. By default, changes to your environment made by
sourcing the setvars.sh or oneapi-vars.sh script apply only to the terminal session in which the
environment script was sourced. You must source the script for each new terminal session.

Detailed instructions on using the setvars.sh or oneapi-vars.sh script are found in Use the setvars and
oneapi-vars Scripts with Linux.

Optionally use one-time setup for setvars.sh as described in Use Modulefiles with Linux*.

Linux

Set the environment variables before using the compiler by sourcing the shell script setvars.sh. Depending
on the shell, you can use the source command or a . (dot) to source the shell script, according to the
following rules for a . sh script:
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Using source:
source /<install-dir>/setvars.sh <argl> <arg2> .. <argn>
Example:
source /opt/intel/oneapi/setvars.sh intel64
Using . (dot):
. /<install-dir>/setvars.sh <argl> <arg2> .. <argn>
Example:
. /opt/intel/oneapi/setvars.sh intel64
Use source /<install-dir>/setvars.sh --help for more setvars usage information.
The compiler environment script file accepts an optional target architecture argument <arg>:

e intel64: Generate code and use libraries for Intel® 64 architecture-based targets.
¢ —-include-intel-11vm: Adds the Intel Compiler's clang binaries folder (bin-11vm) to the PATH.

If you want the setvars.sh script to run automatically in all of your terminal sessions, add the source
setvars.sh command to your startup file. For example, inside your .bash profile entry for Intel® 64
architecture targets.

If the proper environment variables are not set, errors similar to the following may appear when attempting
to execute a compiled program:

./a.out: error while loading shared libraries:
libimf.so: cannot open shared object file: No such file or directory

Windows

Under normal circumstances, you do not need to run the setvars.bat batch file. The terminal shortcuts in
the Windows Start menu, Intel oneAPI command prompt for <target architecture> for Visual Studio
<year>, set these variables automatically.

For additional information, see Use the Command Line on Windows.

You need to run the setvars batch file if a command line is opened without using one of the provided
Command Prompt menu items in the Start menu, or if you want to use the compiler from a script of your
own.

The setvars batch file inserts DLL directories used by the compiler and libraries at the beginning of the
existing Path. Because these directories appear first, they are searched before any directories that were part
of the original path provided by Windows (and other applications). This is especially important if the original
Path includes directories with files that have the same names as those added by the compiler and libraries.

The setvars batch file takes multiple optional arguments; the following two arguments are recognized for
compiler and library initialization:

<install-dir>\setvars.bat [<argl>] [<arg2>]
Where <argl> is optional and can be:

e intel64: Generate code and use libraries for Intel® 64 architecture (host and target).
e —-include-intel-11lvm: Adds the Intel Compiler's clang binaries folder (bin-11vm) to the PATH.

The <arg2> is optional. If specified, it is one of the following:

e vs2022: Microsoft Visual Studio 2022
e vs2019: Microsoft Visual Studio 2019
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If you have more than one edition of Visual Studio installed on your system (example: 2022 Professional and
2022 Enterprise), the automatic search for an installation uses the following precedence (within a specific
year):

e Professional
e Enterprise
e Community

The preferred edition can be specified using the vS20??INSTALLDIR environment variables
(VS2022INSTALLDIR, VS2019INSTALLDIR, etc.).

If <argl1> is not specified, the script uses the intel64 argument by default. If <arg2> is not specified, the
script uses the highest installed version of Microsoft Visual Studio detected during the installation procedure.

See Also
oneAPI Development Environment Setup

Configure Your CPU or GPU System

Invoke the Compiler

Requirements Before Using the Command Line

You may need to set certain environment variables before using the command line. For more information,
see Specify the Location of Compiler Components.

Compiler Drivers

The Intel® Fortran Compiler Classic and Intel® Fortran Compiler each have a driver:

Compiler Notes Linux Driver Windows Driver
Intel® Fortran A Fortran compiler ifort ifort
Compiler Classic with full Fortran
2018 support.
Intel® Fortran A Fortran compiler ifx ifx
Compiler based on the Intel

Fortran Compiler
Classic (ifort)
front-end and
runtime libraries,
using LLVM back-
end technology.

Use the Compiler from the Command Line

Invoke the compiler on the using the ifort or ifx command. This page uses ifx as an example.
The syntax of the ifx command is:
ifx [option]input file

The ifx command can compile and link projects in one step, or can compile them and then link them as a
separate step.

In most cases, a single 1 £x command invokes the compiler and linker. You can also use 1d (Linux) or 1ink
(Windows) to build libraries of object modules. These commands provide syntax instructions at the command
line if you request it with the -help (Linux), or the /help or /? (Windows) options.
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The ifx command automatically references the appropriate runtime libraries when it invokes the linker. To
link one or more object files created by the compiler, you should use the ifx command instead of the 1ink
command.

The ifx command invokes a driver program that is the user interface to the compiler and linker. It accepts a
list of command options and file names and directs processing for each file. The driver program does the
following:

e Calls the compiler to process Fortran files.

e Passes the linker options to the linker.

e Passes object files created by the compiler to the linker.

e Passes libraries to the linker.

e Calls the linker or librarian to create the executable or library file.

Because the compiler driver calls other software components, they may return error messages. For instance,
the linker may return a message if it cannot resolve a global reference. The watch option can help clarify
which component is generating an error.

For a complete listing of compiler options, see the Alphabetical Option List.

Windows systems support characters in Unicode (multibyte) format. The compiler processes the file names
containing Unicode characters.

Syntax Rules

The following rules apply when specifying i fx on the command line:

Argument Description

options An option is specified by one or more letters preceded by a hyphen (-) for Linux or a
slash (/) for Windows. (You can use a hyphen (-) instead of a slash (/) for
Windows, but it is not the preferred method.)

Options cannot be combined with a single slash or hyphen; you must specify the
slash or hyphen for each option specified. For example: /1 /c is correct, but /1c is
not.

Options can take arguments in the form of file names, strings, letters, and numbers.
If a string includes spaces, they must be enclosed in quotation marks.

Some options take arguments in the form of file names, strings, letters, or numbers.
Except where otherwise noted, a space between the option and its argument(s) can
be entered or combined. For a complete listing of compiler options, see the Compiler
Options reference.

Some compiler options are case-sensitive. For example, c and C are two different
options.

Option names can be abbreviated, enter as many characters as are needed to
identify the option.

Compiler options remain in effect for the whole compilation unless overridden by a
compiler directive.

Certain options accept one or more keyword arguments following the option name
on Windows. To specify multiple keywords, you typically specify the option multiple
times. However, some options allow comma-separated keywords. For example:

e Options that use a colon can use an equal sign (=) instead.
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Argument Description

e Standard output and standard error can be redirected to a file, avoiding
displaying excess text, which slows down execution. Scrolling text in a terminal
window on a workstation can cause an I/O bottleneck (increased elapsed time)
and use more CPU time. See the examples in the next section.

Options on the command line apply to all files. In the following example, the -c and
-nowarn options apply to both files x.f and y. £:

ifx -¢ x.f -nowarn y.f

input file(s) Multiple input_files can be specified, using a space as a delimiter. When a file is not
in PATH or working directory, specify the directory path before the file name. The file
name extension specifies the type of file. See Understanding File Extensions.

Xlinker (Linux) Unless specified with certain options, the command line compiles and links the files
or /link you specify. To compile without linking, specify the c option.
(Windows) All compiler options must precede the /1ink (Windows) options. -Xx1inker can be

used anywhere on the command line, only single options/files can be specified after
-Xlinker. Options that appear following -X1linker or /1ink are passed directly to
the linker.

Examples of the ifx Command

This command compiles x. for, links, and creates an executable file. This command generates a temporary
object file, which is deleted after linking:

ifx x.for

This command compiles x. for and generates the object file x.o (Linux) or x.obj (Windows). The c option
prevents linking (it does not link the object file into an executable file):

Linux

ifx -c x.for
Windows

ifx x.for /c

This command links x.o or x.ob7 into an executable file. This command automatically links with the default
libraries:

Linux
ifx x.o0
Windows
ifx x.obj

This command compiles a.for, b.for, and c. for, creating three temporary object files, then linking the
object files into an executable file named a.out (Linux) or a.exe (Windows).

ifx a.for b.for c.for

Compile the source files that define modules before the files that reference the modules (in USE statements)
when using modules and compile multiple files.
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When you use a single ifx command, the order in which files are placed on the command line is significant.
For example, if the free-form source file moddef . £90 defines the modules referenced by the file
projmain.£90, use the following syntax:
ifx moddef.f90 projmain.f90
To specify a particular name for the executable file, specify the option -o (Linux) or /exe (Windows):
Linux
ifx x.for -o myprog.out
Windows
ifx x.for /exe:myprog.exe
To redirect output to a file and then display the program output (Linux only):

myprog > results.lis
more results.lis

To place standard output into file one.out and standard error into file two.out (Windows only):

ifx filenames /options 1>one.out 2>two.out
To place standard output and standard error into a single file both.out (Windows):

ifx filenames /options 1>both.out 2>&1

Other Methods for Using the Command Line to Invoke the Compiler

¢ Using makefiles from the Command Line: Use makefiles to specify a number of files with various
paths and to save this information for multiple compilations. For more information on using makefiles, see
Use Makefiles to Compile Your Application.

e Using the devenv Command from the Command Line (Windows only): Use devenv to set various
options for the IDE, and to build, clean, and debug projects from the command line. For more information
on the devenv command, see the devenv description in the Microsoft Visual Studio documentation.

¢ Using a Batch File from the Command Line: Create and use a .bat file to execute the compiler with a
desired set of options instead of retyping the command each time you need to recompile.

See Also

Specify the Location of Compiler Components
Understand File Extensions

Use Microsoft Visual Studio

Use Makefiles to Compile Your Application
watch compiler option

Use the Command Line on Windows

The compiler provides a shortcut to access the command line with the appropriate environment variables
already set.

To invoke the compiler from the command line:

1. Open the Windows Start menu.

2. Scroll down the list of apps (programs) in the Start menu and find the Intel oneAPI 2021 folder.

3. Left click on the folder name and select your component. The command prompts shown are dependent
on the versions of Microsoft Visual Studio you have installed on your machine.

4. Right click on the command prompt icon to pin it to your taskbar. This step is optional.

5. The command line opens.

You can use any command recognized by the Windows command prompt, plus some additional commands.
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Because the command line runs within the context of Windows, you can easily switch between the command
line and other applications for Windows or have multiple instances of the command line open simultaneously.

When you are finished working in a command line, use the exit command to close and end the session.

Run Fortran Applications from the Command Line

For programs run from the command line, the operating system searches directories listed in the PATH
environment variable to find the requested executable file.

The program can also be run by specifying the complete path of the executable file. On Windows, any DLLs
you are using must be in the same directory as the executable or in one specified in the path.

Multithreaded Programs

If the program is multithreaded, each thread starts on whichever processor is available at the time. On a
computer with one processor, the threads all run in parallel, but not simultaneously; the single processor
switches among them. On a computer with multiple processors, the threads can run simultaneously.

Use the -fpscomp filesfromcmd Option

If you specify the -fpscomp option with keyword filesfromcmd, the command line that executes the
program can include additional file names to satisfy OPEN statements in the program for which the file name
field (FILE specifier) has been left blank. The first file name on the command line is used for the first OPEN
statement executed, the second file name for the second OPEN statement, and so on.

Each file name on the command line must be separated from the names around it by one or more spaces, or
tab characters. You can enclose each name in quotation marks ("<filename>"), but this is not required
unless the argument contains spaces or tabs. A null argument consists of an empty set of quotation marks
with no file name enclosed ("").

The following example runs the program MYPROG.EXE from the command line:

MYPROG "" OUTPUT.DAT

Because the first file name argument is null, the first OPEN statement with a blank file name field produces
the following message:

File name missing or blank - please enter file name
UNIT number °?

The number is the unit number specified in the OPEN statement. The file name OUTPUT.DAT is used for the
second OPEN statement executed. If additional OPEN statements with blank file name fields are executed, you
will be prompted to add more file names.

Instead of using the -fpscomp option with keyword filesfromcmd, you can:

e Call the GETARG library routine to return the specified command-line argument. To execute the program in
the Microsoft Visual Studio IDE, provide the command-line arguments to be passed to the program using
Project > Properties. Choose the Debugging category and enter the arguments in the Command
Arguments text box.

e On Windows, call the GetOpenFileName Windows API routine to request the file name using a dialog box.

See Also
fpscomp compiler option

File Extensions

Input File Extensions

The Intel® Fortran Compiler interprets the type of each input file by the file name extension.
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The file extension determines if a file gets passed to the compiler or to the linker. The following types of files
are used with the compiler:

e Files passed to the compiler: .£90, .for, .f, .fpp, .1, .190, .ftn

Typical Fortran source files have a file extension of .£90, . for, and . f. When editing your source files,
you need to choose the source form, either free-source form or fixed-source form (or a variant of fixed
form called tab form). You can use a compiler option to specify the source form used by the source files
(see the description for the free or fixed compiler option) or you can use specific file extensions when
creating or renaming your files. For example, the compiler assumes that files with an extension of:

e .f90 or .i90 are free-form source files.
e .f, .for, .ftn, or .i are fixed-form (or tab-form) files.
e Files passed to the linker: .a, .1ib, .obj, .o, .exe, .res, .rbj, .def, .dll

The most common file extensions and their interpretations are:

File Name (OS File Name for File Name for Interpretation Action
Agnostic) Linux Windows
file.a file.lib Object library Passed to the
linker.
file.f Fortran fixed-form Compiled by the
) source Intel® Fortran
file.for .
Compiler.
file.ftn
file.1i
file.fpp On Linux, the file Fortran fixed-form  Automatically
names have the source preprocessed by
following the Intel® Fortran
uppercase preprocessor fpp;
extensions: then compiled by
file.FPP the In.tel® Fortran
Compiler.
file.F
file.FOR
file.FTN
file.£90 Fortran free-form Compiled by the
. . source Intel® Fortran
file.i90 i
Compiler.
file.F90 Fortran free-form Automatically
source preprocessed by
the Intel® Fortran
preprocessor fpp;
then compiled by
the Intel® Fortran
Compiler.
file.s file.asm Assembly file Passed to the
assembler.
file.o file.ob] Compiled object Passed to the

file

linker.
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When you compile from the command line, you can use the compiler configuration file to specify default
directories for input libraries. To specify additional directories for input files, temporary files, libraries, and for
the files used by the assembler and the linker, use compiler options that specify output file and directory
names.

Output File Extensions on Windows

On Windows operating systems, many compiler options allow you to specify the name of the output file being
created. These compiler options are summarized in the table below.

If you specify only a file name without an extension, a default extension is added for the file.

Compiler Option Default File Extension
/Fafile .ASM
/dll:file .DLL
/exe:file .EXE
/map:file .MAP
See Also

Invoke the Compiler

Use Makefiles for Compilation

This topic describes the use of makefiles to compile your application. You can use makefiles to specify a
number of files with various paths, and to save this information for multiple compilations.

Linux

To run make from the command line using the compiler, make sure that /usr/bin and /usr/local/bin are
in your PATH environment variable.

If you use the C shell, you can edit your .cshrc file and add the following:
setenv PATH /usr/bin:/usr/local/bin:S$SPATH

Then you can compile using the following syntax:
make -f yourmakefile

Where -f£ is the make command option to specify a particular makefile name.

Windows

To use a makefile to compile your source files, use the nmake command. For example, if your project is
your project.mak, you can use the following syntax:

Example:
nmake /f [makefile name.mak] FPP=[compiler name] LINK32=[linker name]
For example:

nmake /f your project.mak FPP=ifx LINK32=xilink

Argument Description
/£

The nmake option to specify a makefile.
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Argument Description
your_ project.mak The makefile used to generate object and executable files.
FPP The preprocessor/compiler that generates object and executable files.

(The name of this macro may be different for your makefile.)

LINK32 The linker that is used.

The nmake command creates object files (.ob7j) and executable files () from the information specified in the
your project.mak makefile.

Generate Build Dependencies for Compilation

Use the gen-dep compiler option to generate build dependencies for compilation.

Build dependencies include a list of all files included with INCLUDE statements and .mod files accessed with

USE statements. The resulting output can be used to create a makefile to with the appropriate dependencies
resolved.

Consider a source file that contains the following:

module b
include 'gendepOOlb.inc'
end module b

program gendep001

use b

a global = b _global
end

When you compile the source using the gen-dep option, the following output is produced:

b.mod : \
gendep001.£90
gendep001.0bj : \
gendep001.£90 gendep00lb.inc
This output indicates that the generated file, b.mod, depends on the source file, gendep001.£90. Similarly,
the generated file, gendep001.0bj, depends on the files, gendpe001.£90 and gendep001b.inc.

Use Microsoft Visual Studio

You can use the Intel® Fortran Compiler within the Microsoft Visual Studio integrated development
environment (IDE) to develop Fortran applications, including static library (.1LIB), dynamic link library
(.DLL), and main executable (.EXE) applications. This environment makes it easy to create, debug, and

execute programs. You can build your source code into several types of programs and libraries, using the IDE
or from the command line.

The IDE offers these major advantages:

e Makes application development quicker and easier by providing a visual development environment.
e Provides integration with the native Microsoft Visual Studio debugger.
¢ Makes other IDE tools available.

See Also

Performing Common Tasks with Microsoft Visual Studio
Using Microsoft Visual Studio Solution Explorer

Using Breakpoints in the Debugger
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Use Microsoft Visual Studio* Solution Explorer

Creating a Fortran project in Microsoft Visual Studio* causes a screen to appear. This screen shows an open
Solution named Consolel and a Project named Consolel. You will see that the source file
Consolel.f90 is open. The left pane shows the file, Consolel.£90, which is opened in the default
language-sensitive integrated development environment text editor. The text editor uses different colors to
identify the following:

Source comments (green)

Fortran standard language elements (blue)
Other language text (black)

Sample name (red)

Solution Explorer View

The right pane shows the Solution Explorer view, which lets you view different aspects of your solution,
such as the source files. The tabs displayed in Solution Explorer vary depending upon the products
installed, and the files associated with the current solution. To display the Solution Explorer view, select
View > Solution Explorer. To display the Properties view, select View > Properties Window.

To edit a file listed in the Solution Explorer, either double-click its file name or select File > Open and
specify the file.

The Output window displays compilation and linker messages. To display the Output window, select View >
Output. The Output window also links to the build log, if the Generate Build logs option is enabled in
either:

e Tools > Options > Intel Compilers and Libraries > IFORT Intel Fortran Classic > General for
ifort

_OR_
e Tools > Options > Intel Compilers and Libraries > IFX Intel Fortran > General for ifx

Create a New Project

The following steps show how to invoke the compiler from within Microsoft Visual Studio*. Exact steps may
vary depending on the version of Microsoft Visual Studio in use.

Step 1: Build a Binary

1. Launch Microsoft Visual Studio.
2. Select File > New > Project.
3. In the New Project window, select a project type under Fortran.

NOTE Set Fortran as the language in the Language drop down.

4. Select a template and click OK.
5. Select Build > Build Solution

The results of the compilation display in the Output window.
Step 2: Set Build Configurations

1. Right click on Project in Solution Explorer > Properties
2. Locate Fortran in the list and expand the heading.
3. Walk through the available properties to select your configuration.

The project and its files appear in the Solution Explorer view. For a COM Server project, you will see a
second page with additional user options.
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Add an Existing File to the Project

1. If not already open, open the project (use the File menu).
2. Select Project > Add > Existing Item.
3. In the Add Existing Item dialog box that appears, select the Fortran files to be added to the project.

Add a New File to the Project

If not already open, open the project (use the File menu).

Select Project > Add > New Item.

In the Add New Item dialog box that appears, choose the type of file.

Specify the file name. Click Open. The file name appears in the Solution Explorer view.

Use the Microsoft Visual Studio editor to type in source code. Be sure to save your work when you are
finished.

L o o

Organize Existing Source Code

If you have existing source code, you should organize it into directories before creating a project, although it
is easy to move files and edit your project definitions if you should later decide to reorganize your files.

Work with Fortran Modules

If your program uses Fortran modules, you do not need to explicitly add them to your project; they appear
as dependencies (.MOD files).

A module file is a precompiled, binary version of a module definition, stored as a .mod file. When you change
the source definition of a module, you can update the .mod file before you rebuild your project. To do this,
compile the corresponding source file separately by selecting the file in the Solution Explorer window and
selecting Build > Compile. If the module source file is part of your project, you do not need to compile the
file separately. When you build your project, the Intel® Fortran Compiler determines what files need to be
compiled.

To control the placement of module files in directories, use Project > Properties > Fortran > Output
Files > Module Path in the IDE or the compiler option module:path on the command line. The location you
specify is automatically searched for .mod files.

To control the search for module files in directories, select one of the following:
e In the IDE:

¢ Project > Properties > Fortran > Preprocessor > Default Include and Use Path
¢ Project > Properties > Fortran > Preprocessor > Ignore Standard Include Path
e On the Command Line:

e X and assume: [no]source_ include compiler options.

For a newly created project (or any other project), the IDE scans the file list for sources that define modules
and compiles them before compiling the program units that use them. The IDE automatically scans the
added project files for modules specified in USE statements, as well as any INCLUDE statements. It scans the
source files for all tools used in building the project.

See Also

Understand Project Types
I compiler option

X compiler option
assume compiler option

Perform Common Tasks with Microsoft Visual Studio*

This topic outlines the basic steps for using the Intel® Fortran Compiler with Microsoft Visual Studio*.
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Build and Run a Fortran Project

e To build the application, select Build > Build Solution. Any errors will be displayed in the Output
window. Double-click a message to go to the line in error.

e To run without debugging, select Debug > Start Without Debugging. The console window will remain
open after the program exits until you press Enter.

e To run under the debugger, first set a breakpoint at the first executable line of the program by clicking in
the gray column to the left of the source line. Then select Debug > Start Debugging. If the program
exits normally, the console window will be closed automatically.

Convert Compagq* Visual Fortran Projects

For information on converting projects from Compaqg* Visual Fortran to Intel® Fortran, see Convert and Copy
Projects.

See Also
Creating a New Project
Convert and Copy Projects

Select a Version of the Intel® Fortran Compiler

If you have more than one version of the Intel® Fortran Compiler installed, you can choose which version to
be used when building applications. You can also select different versions for different target platforms and
the version of the compiler you are using. The target platform you select determines the compiler versions
that appear in the Selected compiler drop-down box.

To select the compiler version:

1. Select Tools > Options > Intel Compilers and Libraries > IFORT Intel Fortran Classic >
Compilers for i fort or Tools > Options > Intel Compilers and Libraries > IFX Intel Fortran >
Compilers for ifx.

2. Select a compiler from Selected compiler. Click OK.

Use Visual Studio* IDE Automation Objects

This topic briefly describes the Automation interfaces provided by Intel® Fortran. Automation interfaces are
programmable objects used to access underlying IDE components and projects to provide experienced
developers with a means of automating common tasks and allow a finer degree of control over the IDE and
the Fortran projects being used within it.

You can use the Visual Studio* Object Browser (View > Object Browser) to view an object and its
associated properties. Open the following in the browser: Browse > Edit Custom Component Set > .NET
> Microsoft.VisualStudio.VFProject.

NOTE
The objects listed here are provided as an advanced feature for developers who are already familiar
with using Automation objects and the Visual Studio* object model.

Object Description
IVFCollection Contains the functionality that can be exercised on a collections object.
VFConfiguration Programmatically accesses the properties in the General property page of a

project's Property Pages dialog box. This object also allows access to the tools used
to build this configuration.

VFCustomBuildTool Programmatically accesses the properties in the Custom Build Step property page
in a project's Property Pages dialog box.
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VFDebugSettings

VFFile

VFFileConfiguration

VFFilter

VFFortranCompiler
Tool

VFFortranCompiler
Version

VFLibrarianTool
VFLinkerTool
VFManifestTool

VFMidITool

VFPlatform

VFPreBuildEventTo
ol

VFPreLinkEventToo
[

VFPostBuildEventT
ool

VFProject

VFResourceCompil
erTool

Contains properties that allow the user to programmatically manipulate the settings
in the Debug property page.

Describes the operations that can take place on a file in the active project.

Contains build information about a file (VFFile object), including such things as what
tool is attached to the file for that configuration.

Exposes the functionality on a folder in Solution Explorer for an Intel® Fortran
project.

Exposes the functionality of the IFORT tool.

Provides access to properties relating to the Intel® Fortran Compiler version.

Exposes the functionality of the LIB tool.
Exposes the functionality of the LINK tool.

Programmatically accesses the properties in the Manifest Tool folder of a project's
Property Pages dialog box.

Programmatically accesses the properties in the MIDL folder of a project's Property
Pages dialog box.

Provides access to properties relating to supported platforms.

Programmatically accesses the properties on the Pre-Build Event property page, in
the Build Events folder in a project's Property Pages dialog box.

Programmatically accesses the properties on the PreLink Event property page, in
the Build Events folder in a project's Property Pages dialog box.

Programmatically accesses the properties on the Post-Build Event property page,
in the Build Events folder in a project's Property Pages dialog box.

Exposes the properties on an Intel® Fortran project

Programmatically accesses the properties in the Resources folder in a project's
Property Pages dialog box.

The following example, written in Visual Basic*, demonstrates how to use automation objects to modify the
list of available platforms and versions in the Visual Studio* IDE Configuration Manager:

Imports
Imports
Imports
Imports
Imports
Imports

System
EnvDTE
EnvDTE80

System.Diagnostics
Microsoft.VisualStudio.VFProject
System.Collections

Public Module MultiPV
' Create a Console application before executing this module
' Module demonstrates Multi Platform & Multi Version Automation Support
' Variable definition

Dim Prj As Project ' VS project

Dim VFPrj As VFProject ' Intel VF project
Dim o As Object ' Object

Sub run()

' Get the Project

Prj =
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' Get Intel VF project
VEPrj = Prj.Object

' Get list of Supported platforms

Dim pList As ArrayList = New ArrayList () ' list of platforms
Dim cList As ArrayList = New ArrayList () ' lost of compilers

Dim i As Integer

plist = getSupportedPlatforms ()

For i = 0 To pList.Count - 1
cList = getCompilers(pList.Item(i))
printCompilers (pList.Item (i), cList)

Next

1

' Add configurations - x64

For i = 0 To pList.Count - 1
If pList.Item(i) <> "Win32" Then

addConfiguration(pList.Item(i))

End If

Next

Dim cfgsList As ArrayList = New ArrayList() ' list of configurations

cfgslist = getAllConfigurations()
' Set compiler
For i = 0 To pList.Count - 1
Dim pNm As String
Dim cvList As ArrayList = New ArrayList()
pNm = pList.Item(i)
cList = getCompilers (pNm)
cvlist = getCompilerVersions (pNm)
Dim j As Integer
For j = 0 To cvlist.Count - 1

Dim cv As String = cvList.Item(j)

If SetCmplrForPlatform(pNm, cv) Then
setActiveCfg (pNm)
SolutionRebuild ()

Dim sOut As String = GetOutput ()
Dim scv As String = CheckCompiler (sOut)
MsgBox (pNm + " " + cv + " " + scv)
End If
Next
Next
End Sub
' get context from Output window
Function GetOutput () As String
Dim win As Window
Dim w As OutputWindow
Dim wp As OutputWindowPane
Dim td As TextDocument
win = DTE.Windows.Item(Constants.vsWindowKindOutput)
w = win.Object
Dim i As Integer
For i = 1 To w.OutputWindowPanes.Count
wp = w.OutputWindowPanes.Item(i)
If wp.Name = "Build" Then

td = wp.TextDocument

td.Selection.SelectAll ()

Dim ts As TextSelection = td.Selection

GetOutput = ts.Text
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Exit Function
End If
Next
End Function
Function CheckCompiler (ByVal log As String) As String
Dim s As String
Dim beg As Integer
Dim end As Integer
beg = log.IndexOf ("Compiling with")
beg log.IndexOf ("Intel", beg )
end = log.IndexOf("]", beg )
s = log.Substring(beg , end - beg + 1)
CheckCompiler = s
End Function
Function SetCmplrForPlatform(ByVal plNm As String, ByVal vers As String) As Boolean
Dim pl As VFPlatform
Dim cll As IVFCollection
Dim cvs As IVFCollection
Dim cv As VFFortranCompilerVersion
Dim maj As String
Dim min As String
Dim ind As Integer
Try

ind = vers.IndexOf (".")
maj = vers.Substring (0, ind)
min = vers.Substring(ind + 1)
cll = VFPrj.Platforms
pl = cll.Item(plNm)
If pl Is Nothing Then
MsgBox ("Platform " + plNm + " not exist")
Exit Function
End If
cvs = pl.FortranCompilerVersions
Dim j As Integer
For j = 1 To cvs.Count

cv = cvs.Iltem(7)

If cv.MajorVersion.ToString() = maj And cv.MinorVersion.ToString() = min Then
pl.SelectedFortranCompilerVersion = cv
SetCmplrForPlatform = True
Exit Function

End If

Next
MsgBox ("Compiler version " + maj + "." + min + " not exist for platform " + plNm)
SetCmplrForPlatform = False
Catch ex As Exception
SetCmplrForPlatform = False
End Try
End Function
Function getSupportedPlatforms() As ArrayList
Dim list As ArrayList = New ArrayList()
Dim pl As VFPlatform
Dim pls As IVFCollection
pls = VFPrj.Platforms
Dim i As Integer
For i = 1 To pls.Count
pl = pls.Item (1)
list.Add (pl.Name)
Next
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End

getSupportedPlatforms = list
Function

Function getCompilers (ByVal plNm As String) As ArrayList

End

Dim list As ArrayList = New ArrayList()
Dim pl As VFPlatform
Dim pls As IVFCollection
Dim cvs As IVFCollection
Dim cv As VFFortranCompilerVersion
Dim j As Integer
pls = VFPrj.Platforms
pl = pls.Item(plNm)
cvs = pl.FortranCompilerVersions
For j = 1 To cvs.Count
cv = cvs.Item(])
list.Add(cv.DisplayName)
Next
getCompilers = list
Function

Function getCompilerVersions (ByVal plNm As String) As ArrayList

End
Sub

End
Sub

End

Dim list As ArrayList = New ArrayList()
Dim pl As VFPlatform
Dim pls As IVFCollection
Dim cvs As IVFCollection
Dim cv As VFFortranCompilerVersion
pls = VFPrj.Platforms
pl = pls.Item(plNm)
cvs = pl.FortranCompilerVersions
Dim j As Integer
For j = 1 To cvs.Count
cv = cvs.Item(])
Dim vers As String

vers = cv.MajorVersion.ToString() + "." + cv.MinorVersion.ToString()
list.Add (vers)

Next

getCompilerVersions = list

Function

printCompilers (ByVal plNm As String, ByVal list As ArrayList)
Dim s As String

s = "Platform " + plNm + Chr(13)

Dim i As Integer

For i = 0 To list.Count - 1

s +=" " + list.Item(i) + Chr(13)
Next
MsgBox (s)
Sub
addConfiguration (ByVal cfgNm As String)

Dim cM As ConfigurationManager

cM = Prj.ConfigurationManager
cM.AddPlatform(cfgNm, "Win32", True)
Sub

Function getAllConfigurations() As ArrayList

Dim list As ArrayList = New ArrayList()
Dim cM As ConfigurationManager
Dim i As Integer
Dim c As Configuration
cM = Prj.ConfigurationManager
For i = 1 To cM.Count
c = cM.Item (1)
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list.Add(c.ConfigurationName + "|" + c.PlatformName)
Next
getAllConfigurations = list
End Function
Sub setActiveCfg(ByVal pNm As String)
Dim scs As SolutionConfigurations = DTE.Solution.SolutionBuild.SolutionConfigurations
Dim i As Integer
Dim j As Integer
For i = 1 To scs.Count
Dim sc As SolutionConfiguration
Dim sctxs As SolutionContexts
sc = scs.Item (1)
sctxs = sc.SolutionContexts
For j = 1 To sctxs.Count
Dim sctx As SolutionContext = sctxs.Item(j)
If sctx.ConfigurationName = "Debug" And sctx.PlatformName = pNm Then
sc.Activate ()
Exit Sub
End If
Next
Next
End Sub
Sub SolutionRebuild()
DTE.Solution.SolutionBuild.Clean (True)
DTE.Solution.SolutionBuild.Build(True)
End Sub
End Module

Specify Fortran File Extensions

You can specify additional Fortran free format and fixed format file extensions to be recognized as valid file
extensions within the IDE. The IDE treats these additional extensions as compilable Fortran source files. You
can also remove or modify existing extensions.

When you add a new extension, the IDE checks the registry to determine whether the extension is already
associated with a language, tool, or file format. If there is such an association, a message informs you of this
and you will not be allowed to add the extension.

Specify Fortran File Extensions
To specify the Fortran file extensions:

1. Open Tools > Options.

2. In the left pane, go to Intel Compilers and Libraries > IFORT Intel Fortran Classic > General for
ifort or Intel Compilers and Libraries > IFX Intel Fortran > General for ifx.

3. Specify one or more Fortran File Extensions, each beginning with a period and separated by semi-
colons. You can specify extensions for both Free Format Extensions and Fixed Format Extensions.
Click OK.

These new settings take effect the next time you start Microsoft Visual Studio*.

Understand Solutions, Projects, and Configurations

The Microsoft Visual Studio* IDE consists of one or more projects contained within a solution. A solution can
contain multiple projects. If you have several Fortran applications that do different calculations but are
related, you can store all the individual projects in a single solution. Along with a solution file (.s1n), the IDE
creates a solution user options (. suo) file for storing IDE customization.

The following table summarizes the files created by Microsoft Visual Studio when a new project is created:
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File Extension Description
Project .sln Stores solution information, including the projects and items in the
Solution file solution and their locations on disk.
Project file .viproj Contains information used to build a single project or sub-project.
. VCXProj

Solution .suo Contains IDE customization for the solution, based on the selected
options file options.

Caution

¢ Directly modifying these files with a text editor is not supported.
e Before opening Compag* Visual Fortran 6.0 projects or Intel® Fortran 7.x projects in Microsoft
Visual Studio, review the guidelines listed in Convert and Copy Projects.

Each project can specify one or more configurations to build from its source files. A configuration specifies
such information as the type of application to build, the platform it runs on, and the tool settings to use when
building. Having multiple configurations extends the scope of a project, but maintains a consistent source
code base to work with.

Microsoft Visual Studio automatically creates Debug and Release (also known as Retail) configurations
when a new project is started. The default configuration is the Debug configuration. To specify the current
configuration, select Configuration Manager from the Build menu.

Specify build options in the Project > Properties dialog box, for one of the following:

e For all configurations (project-wide).
e For certain configurations (per configuration).
e For certain files (per file).

For example, specify compiler optimizations for all general configurations, but turn them off for certain
configurations or certain files.

Once the files in the project are specified and the configurations for your project build are set, including the
tool settings, build the project with the commands on the Build menu.

NOTE For a multiple-project solution, make sure that the executable project is designated as the
startup project (shown in bold in the Solution Explorer view). To modify the startup project, right-
click on the project and select Set as StartUp Project.

See Also
Convert and Copy Projects

Navigate Programmatic Components in a Fortran File

You can quickly navigate the code of the file currently open in the source editor using the Tree Navigation
Window. The Tree Navigation Window displays the following components of the file as nested, selectable
nodes in a tree:

e Programs

e Modules

e Subroutines with signature
e Functions with signature

e Types

e Interfaces

Nodes at each nested level are sorted alphabetically.
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Any changes you make to a file, such as adding or deleting a component or changing a signature, are
immediately reflected in the tree.

To navigate a file:

1. Select View > Other Windows > Tree Navigation Window.
The Tree Navigation Window tab appears near the Solution Explorer tab. When no Fortran project
is opened, the Tree Navigation Window is empty. When you open a Fortran file in the source editor,
all components of the file appear in the window.

2. Select a node in the tree to view the corresponding component in the source editor.
The cursor appears at the correct location in the file.

Specify Path, Library, and Include Directories

You can specify directories that the Microsoft Visual Studio* project system should search for certain types of
files.

To set path, library, and include directories for your Intel® Fortran project environment on a particular
machine:

1. Select Tools > Options.

2. In the left pane, select Intel Compilers and Libraries > IFORT Intel Fortran Classic > Compilers
for ifort or Intel Compilers and Libraries > IFX Intel Fortran > Compilers for ifx.

3. In the right pane, specify directories where the Microsoft Visual Studio* project system should look for
files:

o Executables: The directories to be searched for executable files. (Works like the PATH environment
variable.)
e Libraries: The directories to be searched for libraries. (Works like the LIB environment variable.)
¢ Includes: The directories to be searched for include files. (Works like the INCLUDE environment
variable.) You can use macros like s (VvSInstallDir) in directory names. For list of supported
macros, see Supported Build Macros.
4. Click OK.

Use the Reset buttons to restore original installation settings for Executables, Libraries, and Includes fields.
Reset restores initial settings for the currently selected compiler.

NOTE If you specify devenv or useenv on the command line to start the IDE, the IDE uses the PATH,
INCLUDE, and LIB environment variables as defined for that command line when performing a build. It
uses these values instead of the values defined in Tools > Options.

For more information on the devenv command, see the devenv description in the Microsoft Visual
Studio* documentation.

For more information on environment variables, see Supported Environment Variables.

See Also
Supported Environment Variables

Supported Build Macros

Set Compiler Options in the Microsoft Visual Studio* IDE Property Pages
To set compilation and related options for the current project:

1. Select the project name in the Solution Explorer view.
2. In the Project menu, select Properties.

The Intel® Fortran Compiler lets you specify compiler options for individual source files by selecting the file
name and clicking View > Property Pages.
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NOTE For convenience, context-sensitive pop-up menus containing commonly used menu options are
available by right-clicking on an item (for example, a file name or solution) in the IDE.

Display the Options

To display the Fortran Compiler option categories, click the Fortran folder in the left pane to display the
compiler option categories. The compiler options are found in the General category in the right pane. The
selected option within the General category is Suppress Startup Banner, with a default value of Yes. The
corresponding command line compiler option is nologo, as shown in the Help text at the bottom of the right
pane.

NOTE Option values that are different from the compiler defaults are displayed in bold.

Change Option Settings
To change the setting for a compiler option:

1. Select a category and then click the desired option. Click the button at the right of an option line to
display the available settings or display a dialog box. Available settings may include <inherit from
project defaults>, which resets the option value to the compiler default.

2. Select the desired setting and click OK.

To change the configuration (such as from Debug to Release), do one of the following:

e Select a different configuration in the Configuration: drop-down box in the upper-left of the window.
¢ Click the Configuration Manager button in the upper-right of the window and reset the configuration in
the dialog box that appears.

Fortran Option Categories

The Intel® Fortran Compiler options available from the IDE are grouped in categories. Some options appear in
multiple categories. Available options in each category may vary, depending on the platform you have
selected in the Platform box at the top of the dialog box. Options not listed in one of the categories can be
typed into the Command Line category window.

Command Line Category

The Command Line category contains the Additional Options field where you can type in an option as you
would from the command line. The IDE will process them as part of the Property Pages options for the
particular project. For instance, you can use the Command Line category to type in miscellaneous Intel®
Fortran Compiler options that are not represented in any of the listed categories. The option you specify in
the Command Line category takes precedence and overrides the equivalent setting in another category.

Supported Build Macros

The Intel® Fortran Compiler supports certain build macros for use in the Property Pages dialog boxes
associated with a project. Use these macros where character strings are accepted. The macro names are not
case-sensitive.

The following table lists macros supported by Visual Studio* that are also supported by the Intel® Fortran
Compiler.

Macro Name Format

Configuration name $ (ConfigurationName)
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Macro Name

Format

Platform name
Intermediate directory
Output directory
Input directory

Input path

Input name

Input filename

Input file extension
Inherit properties

Do not inherit properties
Project directory
Project path

Project name

Project filename
Project file extension
Solution directory
Solution path
Solution name
Solution filename
Solution file extension
Target directory
Target path

Target name

Target filename
Target file extension

Visual Studio* installation
directory

Visual C++* installation
directory

.NET Framework directory
.NET Framework version

.NET Framework SDK
Directory

S (PlatformName)
$(IntDir)

$ (OutDir)

$ (InputDir)

$ (InputPath)

$ (InputName)

$ (InputFileName)
S (InputExt)

S (Inherit)

$ (NoInherit)

$ (ProjectDir)

$ (ProjectPath)

$ (ProjectName)

S (ProjectFileName)
$ (ProjectExt)

S (SolutionDir)

$ (SolutionPath)

$ (SolutionName)

S (SolutionFileName)
$ (SolutionExt)

$ (TargetDir)

$ (TargetPath)

$ (TargetName)

S (TargetFileName)
$ (TargetExt)

$(VSInstallDir)

$ (VCInstallDir)

S (FrameworkDir)
S (FrameworkVersion)

$ (FrameworkSDKDir)
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The Intel® Fortran Compiler also supports the following macros (not supported by Visual Studio*).

Macro Name Format

Intel® Fortran IDE installation directory S(IFIDEInstallDir)

For additional information on using build macros, see the Microsoft MSDN* online documentation.

Use Manifests

The Intel® Compiler supports manifests, a Microsoft Visual Studio* feature. Manifests describe runtime
dependencies of a built application. A manifest file can be embedded in the assembly, which is the default
behavior, or can be a separate standalone file. You can use the Manifest Tool property pages, which are
accessed through Project > Properties, to change project settings that affect the manifest.

NOTE
In earlier releases, manifest files were embedded in the assembly, and were not able to be accessed or
changed.

Use Intel® Libraries with Microsoft Visual Studio*

You can use the compiler with Intel® oneAPI Math Kernel Library (oneMKL), which may be included as a part
of the product. Use the property pages to select the project configuration.

To specify oneMKL, select Project > Properties. In the Configuration Properties, select Configuration
Properties > Fortran > Libraries > Use Intel Math Kernel Library, then do the following:

To use oneMKL in your project, change the Use oneMKL property settings as follows:

e No: Disable use of oneMKL libraries.

e Parallel: Use parallel oneMKL libraries.

e Sequential: Use sequential oneMKL libraries.
e Cluster: Use cluster libraries.

For more information, see the Intel® oneAPI Math Kernel Library documentation.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

Use Source Editor Enhancements in Microsoft Visual Studio*

A number of Fortran source editor enhancements are available in Microsoft Visual Studio*.

Modules and Procedures Navigation Bar

A two-part navigation bar, located above the source editor pane, lets you navigate to a specific module (left
part) and procedure (right part). To enable the navigation bar, choose Navigation Bar in Tools >
Options > Text Editor > Fortran > General.

Source Editor Pane

Smart indenting: Smart indenting automatically indents block constructs (such as IF and DO) and left
justifies the corresponding end statement. To enable smart indenting, select it in Tools > Options > Text
Editor > Fortran > Tabs.
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Code snippet insertion: Code snippet insertion lets you insert a prototype construct (such as DO, WHILE,
or MODULE) from a list. Use the right-click context menu Snippet > Insert Snippet... option to display the
list and insert a snippet.

Delimiter matching: Delimiter (brace) matching lets you jump to a matching statement in a block construct
(IF...THEN...END IF, DO...END DO). Use Ctrl] to jump. To enable delimiter matching, use Automatic
delimiter highlighting in Tools > Options > Text Editor > General.

Call/Callers graph: Call/Caller information can be collected and shown visually in a graph that indicates the
call stacks that lead to a unit of code. To enable Call/Callers graph information, change Collect Call/Callers
graph information to True in Tools > Options > Text Editor > Fortran > Advanced > Browsing/
Navigation.

Fortran Editor Options Page
Use Tools > Options > Text Editor > Fortran > Advanced to view the Fortran Advanced Options page.

Browsing/Navigation Section

Collect Object Browser information: Choose this option to enable the display of procedures in your
project in a hierarchical tree. Once enabled, you can use View > Object Browser to display your
procedures.

NOTE If the procedures in your project do not show when browsing in My Solution, you can right-
click the message (No information. Try browsing a different component set.) and select View
Containers as a possible solution.

Disable Database: Choose this option to disable creation of the code browsing database. This may help
increase performance on slow machines. If you disable the database, all features that rely on code browsing
information will not work.

Enable Find all References: Choose this option to enable display of the location(s) in your code where a
symbol is referenced. When this option is enabled, you can use the right-click context menu Find All
References option to display a list of references to the selected symbol. Double-click a reference to find that
reference.

Enable Go To Definition: Choose this option to enable quick navigation to an object definition. When this
option is enabled, you can use the right-click context menu Go to Definition option to locate where the
selected object was declared, opening the associated source file if required. (If you have also enabled Scan
system includes, any objects declared in system modules such as IFWINTY cause the associated source for
that module to be opened.)

Scan system includes: Choose this option to scan system include files. This option is used with one or
more of the following options: Collect Object Browser Information, Enable Find All References,
Enable Go To Definition.

Intrinsics Section
Enable Intrinsic Parameter Info: Choose this option to enable the display of intrinsic function and
subroutine parameter information. When this option is enabled, you can type a name of an intrinsic

procedure, followed by an open parenthesis, and information about the procedure and its arguments
appears.

Enable Intrinsic Quick Info: Choose this option to enable the display of additional information when the
cursor is moved over an intrinsic function or subroutine name.

Miscellaneous Section
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Enumerate Comment Tasks: Choose this option to enable the display of a list of tasks consisting of source
files containing comments. Comments take the form of the ! character, followed by a token such as TO DO.
Valid tokens are listed in Tools > Options > Environment > Task List. When this option is enabled, you
can select Comments from the task list using View > Task List. Double-click a comment in the list to jump
to its location.

Highlight Matching Tokens: Choose this option to allow identifier highlighting and block delimiter
matching. When enabled, this option highlights all references to the identifier under the cursor.

Outlining Section

Enable Outlining: Choose this option to allow the collapsing of whole program units. When this option is
enabled, you can click the minus (-) or plus (+) symbols for PROGRAM, SUBROUTINE, FUNCTION, MODULE,
and BLOCK DATA statements.

Outline Statement Blocks: Choose this option to allow collapsing of block constructs such as IF and DO.
You must also choose Enable Outlining.

Create the Executable Program

When you are ready to create an executable image of your application, use the options on the Build menu.
You can:

Compile a file without linking.

Build a project or solution.

Rebuild a project or solution.

Batch build several configurations of a project.

Clean a project or solution (which deletes all files created during the Build).
Select the active solution and configuration.

Edit the project configuration.

When you have completed your project definition, you can build the executable program.

When you select Build <projectname> from the Build menu (or Build toolbar), the integrated
development environment (IDE) automatically updates dependencies, compiles and links all files in your
project. When you build a project, the IDE processes only the files in the project that have changed since the
last build and those files dependent on the changed files. The following example illustrates this.

NOTE To define the build order of projects, right-click on the solution and choose Properties >
Project Dependencies.

Example: Assume you have multiple projects (A, B, and C) in a solution with the following defined
dependencies:

e A dependsonB
e B dependsonC

If you build A, the build process verifies that B is up-to-date. During verification of B, C is also verified that it
is likewise up-to-date. When either, or both, are determined to be out of date, the appropriate build
operations will occur to update them. When C and B produce .1ib or .d11 output, the output of C is linked
into B and the output of B is linked into A.

The Rebuild <project name> option forces a new compilation of all source files listed for the project.

You either can choose to build a single project, the current project, or multiple project configurations (using
the Batch Build... option) in one operation. You can also choose to build the entire solution.

You can execute your program from the IDE using Debug > Start Without Debugging (Ctrl and F5) or
Debug > Start (F5). You can also execute your program from the command line prompt.

Compile Files in a Project

You can select and compile individual files in any project in your solution. To do this, select the file in the
Solution Explorer view. Then, do one of the following:
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e Select Compile from the Build menu (or Build toolbar).
¢ Right-click to display the pop-up menu and select Compile.

You can also use Compile from the Build menu (or Build toolbar) options when the source window is active
and has input focus.

Compilation Errors

When the compiler encounters an error in a file, compilation stops and the error is reported. You can change
this default behavior and allow compilation to continue despite an error in the current file. When you do this,
an error in the current file will cause the compiler to begin compiling the next file.

To enable Continue on errors behavior:

1. In Tools > Options > Intel Compilers and Libraries > IFORT Intel Fortran Classic for ifort or
Tools > Options > Intel Compilers and Libraries > IFX Intel Fortran for ifx, select the General
category.

2. Check Continue on errors and click OK.

To set the maximum number of errors to encounter before compilation stops, choose Configuration
Properties > Fortran > Diagnostics > Error Limit.

Convert and Copy Projects

Convert Projects

In general, you can open projects created by older versions of Intel® Fortran and use them directly. If the
projects were created in older versions of Microsoft Visual Studio*, the solution file is converted first and
then any non-Fortran projects it contains. Projects created in newer versions of Intel® Fortran might not be
usable in older versions.

Projects created in Compag* Visual Fortran 6.0 or later can usually be converted to Intel® Fortran as follows:

1. Open the Microsoft Visual Studio 6 workspace file (.dsw) in a newer version of Microsoft Visual Studio.
The project is converted to the new format.

2. Right click on the solution and select Extract Compaqg Visual Fortran Project Items. This option
is available only if your installation of Microsoft Visual Studio includes Microsoft Visual C++ (MSVC).

Some general conversion principles apply:

e It is good practice to make a backup copy of the project before starting conversions.

e Intel® Fortran projects are created and built in a particular version of Microsoft Visual Studio. If you open
the project in a later version, you will be prompted to convert the solution. Once converted, a solution
cannot be used in its previous environment.

e Compagq Visual Fortran 6.x projects can be converted to Intel® Fortran projects in Microsoft Visual Studio
2017, 2019, or 2022 environments. Fortran-only projects are simpler to convert.

NOTE Support for Microsoft Visual Studio 2017 is deprecated as of the Intel® oneAPI 2022.1 release,
and will be removed in a future release.

e Project conversion support is provided for Compaq Visual Fortran Version 6.x only. Compaq Visual Fortran
projects created with earlier versions may not convert correctly.

e Fortran source files, resource files, and MIDL files lose any custom build step information when converted
from Compagq Visual Fortran to Intel® Fortran. For other file types, custom build steps are propagated
during the project's conversion.

e Conversion of Fortran and C/C++ mixed language projects results in the creation of two separate projects
(a Fortran project and a C/C++ project) in a single solution.
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e Intel® Fortran projects that are created with a point release (for instance, 2022.x) are typically backward
compatible to the first release of that number (in this case, 2022.0). Projects are not backward-
compatible between major release numbers.

Copy Projects
You need to follow certain procedures to move a project's location if you copy a project to:

e Another disk or directory location on the same system.
¢ Another system where the Intel® Fortran Compiler is installed.

If you upgrade your operating system version on your current system, you should delete the *.suo and
* _NCB files in each main project directory before you open solutions with the new operating system.

It is good practice to clean a solution before moving and copying project files. To do this, select Clean in the
Build menu.

Copy an Existing Intel® Fortran Project to Another Disk or System

1. Copy all project files to the new location. You do not need to copy the subdirectories created for each
configuration. Keep the directory hierarchy intact by copying the entire project tree to the new
computer. For example, if a project resides in the folder \MyProjects\Projapp on one computer, you
can copy the contents of that directory, and all subdirectories, to the \MyProjects\Projapp directory
on another computer.

2. Delete the following files from the main directory at the new location. These files are disk- and
computer-specific and should not be retained:

e *_SUO files
e *_NCB files (if present)

3. If you copied the subdirectories associated with each configuration (for example, Debug and Release),
delete the contents of subdirectories at the new location. The files contained in these subdirectories are
disk- and computer-specific files and should not be retained. For example, Intel® Fortran module (.MOD)
files contained in these subdirectories should be recreated by the compiler, especially if a newer version
of Intel® Fortran has been installed.

NOTE The internal structure of module files can change between Intel® Fortran releases.

If you copied the project files to the same system or a system running the same platform and major
Intel® Fortran version, do the following steps to remove most or all of the files in the configuration
subdirectory:

Dpen the appropriate solution. In the File menu, either select Open Solution or select Recent
Solutions. If you use Open Solution, select the appropriate . sSIN file.

2elect Clean in the Build menu.

Bepeat the previous two steps for other configurations whose subdirectories have been copied.

4. If possible, after copying a project, verify that you can open the project at its new location using the
same Fortran version that it was created in. This ensures that the project has been moved successfully
and minimizes the chance of conversion problems. If you open the project with a later version of
Fortran, the project will be converted and you will not be able to convert the project back. For this
reason, making an archive copy of the project files before you start is recommended.

5. View the existing configurations. To view the existing configurations associated with the project, open
the solution and view available configurations using the drop-down box at the top of the screen.

6. Check and reset project options.

Because not all settings are transportable across different disks and systems, you should verify your
project settings on the new platform. To verify your project settings:

a. From the Project menu, choose Properties. The Project Property Pages dialog box appears.
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b. Configure settings as desired. Pay special attention to the following items:

e General: Review the directories for intermediate and output files. If you moved the project to
a different system, be aware that any absolute directory paths (such as C:\TEMP or \Myproj
\TEMP) will most likely need to be changed. Instead, use relative path directory names
(without a leading back slash), such as Debug
e Custom Build Step: Review for any custom commands that might change between platforms.
¢ Pre-build, Pre-link, and Post-build Steps in Build Events: Review for any custom
commands that may have changed.
7. Check your source code for directory paths referenced in INCLUDE or similar statements. Microsoft
Visual Studio* provides a multi-file search capability called Find in Files, available from the Edit
menu.

About Fortran Project Types

This section provides information about Fortran project types.

Understand Project Types

When you create a project in Visual Studio*, you must choose a project type. You need to create a project
for each binary executable file to be created. For example, the main Fortran program and a Fortran dynamic-
link library (DLL) would each reside in the same solution as separate projects.

The project type specifies what to generate and determines some of the options that the visual development
environment sets by default for the project. It determines, for instance, the options that the compiler uses to
compile the source files, the static libraries that the linker uses to build the project, and the default locations
for output files.

When you select a project type, an Application wizard (AppWizard) is launched, which guides you through
project set-up. The AppWizard supplies default settings for both the Release and Debug Configurations of
the project. For more information about configurations, see Understand Solutions Projects and
Configurations.

The following table lists the available Intel® Fortran Compiler project types. The first four projects listed are
main project types, requiring main programs. The last two are library projects, without main programs.

Project Type Key Features

Use Fortran Single window main projects without graphics (resembles character-cell
Console applications). Requires no special programming expertise.

Application

Projects (.EXE)

Use Fortran Single window main projects with graphics. The programming complexity is simple
Standard Graphics  to moderate, depending on the graphics and user interaction used.

Application

Projects (.EXE)

Use Fortran Multiple window main projects with graphics. The programming complexity is simple
QuickWin to moderate, depending on the graphics and user interaction used.

Application

Projects (.EXE)

Use Fortran Multiple window main projects with full graphical interface and access to all
Windowing Windows* API routines. Requires advanced programming expertise and knowledge
Application of the Call Windows API Routines.

Projects (.EXE)
Use Fortran Static Library routines to link into .EXE files.

Library Projects
(.LIB)
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Project Type Key Features

Use Fortran Library routines to associate during execution.
Dynamic-Link

Library Projects

(.pLL)

Use the Fortran COM

Server (.DLL) Fortran in-process COM server

If you need to use the command line to build your project, you can:

e Use the command line compiler options to specify the project type (see Specify Project Types with ifort
Command Options).
e Create the application from the command line (see Invoke the Intel® Fortran Compiler).

See Also
Understand Solutions Projects and Configurations

Create Fortran Applications that Use Windows* OS Features

Specify Project Types with ifort Command Options

This section provides the i fort command-line options that correspond to Microsoft Visual Studio* project
types.

Create Main Project Types

The first four projects described below are main project types, requiring main programs. You can create any
of the following project types with the i fort command:

e To create console application projects, you do not need to specify any options. (If you link separately,
specify the 1ink option /subsystem:console.) A console application is the default project type created.

e To create standard graphics application projects, specify the 1ibs option with keyword qwins (also sets
certain linker options).

e To create QuickWin application projects, specify the 1ibs option with keyword gwin (also sets certain
linker options).

e To create windowing application projects, specify the winapp option (also sets certain linker options).

Create Library Project Types

The following project types are library projects, without main programs. You can create them with the ifort
command:

e To create dynamic-link library (DLL) projects, specify the d11 option (which sets the 1ibs option with
keyword dl11).
e To create static library projects:

e If your application does not call any QuickWin or standard graphics routines, specify the 1ibs option
with keyword static and c options to create the object files.

e If your application calls QuickWin routines, specify the 1ibs option with keyword qwin and c options
to create the object files.

e If your application calls standard graphics routines, specify the 1ibs option with keyword qwins and
c options to create the object files.

e Use the LIB command to create the library.

See Also
Understand Project Types
Use Fortran Console Application Projects
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Use Fortran Standard Graphics Application Projects
Use Fortran QuickWin Application Projects

Use Fortran Windowing Application Projects

Use Fortran Dynamic-Link Library Projects

Use Fortran Static Library Projects

Use Fortran Console Application Projects

A Fortran Console application (.EXE) is a character-based Intel® Fortran program that does not require
screen graphics output.

Fortran Console projects operate in a single window and let you interact with your program through normal
read and write commands. Console applications are better suited to problems that require pure numerical
processing rather than graphical output or a graphical user interface. This type of application is also more
transportable to other platforms than the other types of application.

Fortran Console applications can be faster than Fortran Standard Graphics or Fortran QuickWin graphics
applications, because of the resources required to display graphical output (see Use the Console).

Any graphics routine that your program calls will produce no output, but will return error codes. A program
will not automatically exit if such an error occurs, so your code should be written to handle this condition.

With a Fortran Console project, you cannot use the QuickWin functions. However, you can use single- or
multi-threaded static libraries, DLLs, and dialog boxes.

As with all Windows* command consoles, you can toggle between console viewing modes by pressing ALT
and ENTER.

To create a console application from the IDE:

1. Select the Console Application project type.
2. Select from two templates: Empty project or Main program code, which includes sample code.

See Also
Use the Console

Use Fortran Standard Graphics Application Projects

A Fortran standard graphics application (.EXE) is an Intel® Fortran QuickWin program with graphics that runs
in a single QuickWin window. A standard graphics (QuickWin single window, sometimes called single
document) application looks similar to an MS-DOS* program when manipulating the graphics hardware
directly, without Windows*.

A Fortran standard graphics application allows graphics output (such as drawing lines and basic shapes) and
other screen functions, such as clearing the screen. Standard Graphics is a subset of QuickWin. You can use
all of the QuickWin graphics functions in these projects. You can use dialog boxes with all other project types.

You can select displayed text either as a bitmap or as text. Windows provides APIs for loading and unloading
bitmap files. Standard graphics applications should be written as multithreaded applications.

Fortran standard graphics (QuickWin single window) applications are normally presented in full-screen mode.
The single window can be either full-screen or have window borders and controls available. You can change
between these two modes by using ALT and ENTER.

If the resolution selected matches the screen size, the application covers the entire screen; otherwise, scroll
bars are present to resize the window. You cannot open additional windows in a standard graphics
application. Standard graphics applications have neither a menu bar at the top of the window, nor a status
bar at the bottom.

Fortran standard graphics applications are appropriate for problems that:

e Require numerical processing and some graphics.
¢ Do not require a sophisticated user interface.
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Create a Standard Graphics Application with the Microsoft Visual Studio* IDE

1. Select the QuickWin Application project type.
2. Select the Standard Graphics Application template.

When you select the Fortran standard graphics project type, the IDE includes the QuickWin library
automatically, which lets you use the graphics functions. When building from the command line, you must
specify the 1ibs option with keyword gwins. You cannot use the runtime functions meant for multiple-
window projects if you are building a standard graphics project. You cannot make a standard graphics
application a DLL.

See Also
Create Fortran Applications that Use Windows* Features

Use Fortran QuickWin Application Projects

Fortran QuickWin graphics applications (.EXE) are multi-threaded and are more versatile than standard
graphics (QuickWin single window ) applications because you can open multiple windows while your project is
executing. This multiple window capability is also referred to as multiple-document interface or MDI. Multiple
windows can be used in a variety of ways. For example, you might want to generate several graphic plots
and be able to switch between them while also having a window for controlling the execution of your
program. These windows can be full screen or reduced in size and can be placed in various parts of the
screen.

QuickWin library routines let you build applications with a simplified version of the Windows* interface using
Intel® Fortran. The QuickWin library provides a rich set of Windows* features, but it does not include the
complete Windows* Applications Programming Interface (API). If you need additional capabilities, you must
set up a Windows* application to call the Windows* API directly rather than using QuickWin to build your
program.

Applications that use a multiple-document interface (MDI) have a menu bar at the top of the window and a
status bar at the bottom. The QuickWin library provides a default set of menus and menu items that you can
customize with the QuickWin APIs. An application that uses MDI creates many "child" windows within an
outer application window. The user area in an MDI application is a child window that appears in the space
between the menu bar and status bar of the application window. Your application can have more than one
child window open at a time.

Fortran QuickWin applications can use the TFL.OGM module to access functions to control dialog boxes. These
functions allow you to display, initialize, and communicate with special dialog boxes in your application. They
are a subset of Windows* API functions, which Windows* applications can call directly.

NOTE QuickWin applications are only supported with ifort.

To create a QuickWin application in Visual Studio*:

1. Select the QuickWin Application project type.
2. Select the QuickWin Application template in the right pane.

When you select the Fortran QuickWin project type, the IDE includes the QuickWin library automatically,
which lets you use the graphics functions.

When building from the command line, you must specify the 1ibs compiler option with keyword qwin to
indicate a QuickWin application.

A QuickWin application covers the entire screen if the resolution selected matches the screen size; otherwise,
the window will contain scroll bars.

You cannot make a Fortran QuickWin application a DLL.

See Also
Create Fortran Applications that Use Windows* Features
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Use Fortran Windowing Application Projects

Fortran Windowing applications (.EXE) are main programs that you create when you choose the Fortran
Windowing Application project type. This type of project lets you call the Windows* APIs directly from Intel®
Fortran. This provides full access to the Windows* APIs, giving you a larger (and different) set of functions to
work with than QuickWin.

Although you can call some of the Windows* APIs from the other project types, Fortran Windowing
applications allow you to use the full set of API routines and use certain system features not available for the
other project types.

The IFWIN module contains interfaces to the most common Windows APIs. If you include the USE IFWIN
statement in your program, the most common Windows* API Routines are available to you. The IFWIN
module gives you access to a full range of routines including window management, graphic device interface,
system services, multimedia, and remote procedure calls.

Window management routines give your application the means to create and manage a user interface. You
can create windows to display output or prompt for input. Graphics Device Interface (GDI) functions provide
ways for you to generate graphical output for displays, printers, and other devices. Windows* system
functions allow you to manage and monitor resources such as memory, access to files, directories, and I/0O
devices. System service functions provide features that your application can use to handle special conditions
such as errors, event logging, and exception handling.

Using multimedia functions, your application can create documents and presentations that incorporate music,
sound effects, and video clips as well as text and graphics. Multimedia functions provide services for audio,
video, file I/O, media control, joystick, and timers.

Remote Procedure Calls (RPC) gives you the means to carry out distributed computing, letting applications
tap the resources of computers on a network. A distributed application runs as a process in one address
space and makes procedure calls that execute in an address space on another computer. You can create
distributed applications using RPC, each consisting of a client that presents information to the user and a
server that stores, retrieves, and manipulates data as well as handling computing tasks. Shared databases
and remote file servers are examples of distributed applications.

See Also
Call Windows* API Routines
Create Fortran Applications that Use Windows* OS Features

Use Fortran Static Library Projects

Fortran static libraries (.LIB) are blocks of code compiled and kept separate from the main part of your
program. The Fortran static library is one of the Fortran project types.

To create a static library from the integrated development environment (IDE), select the Static Library
project type. To create a static library from the command line, use the ¢ option to suppress linking and use
the LIB command.

NOTE

When compiling a static library from the command line, include the ¢ option to suppress linking.
Without this option, the compiler generates an error because the library does not contain a main
program.

When you create a static library, you are asked to specify whether you want to prevent the insertion of link
directives for default libraries. By default, this checkbox is selected, which means insertion of link directives
is prevented. Select this option if you plan to use this static library with other Fortran projects. The option
prevents the static library from specifying a version of the Fortran runtime library. When the static library is
linked with another Fortran project, the Fortran runtime library choice in the other Fortran project is used for
the static library as well.

You may decide against selecting this option if you plan to use this static library with C/C++ projects. If you
do select it, you need to explicitly name the Fortran runtime library to use in the Linker Additional
Dependencies property. You can change your selection after creating the project using the Fortran Disable
Default Library Search Rules property.
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A static library is a collection of source and object code defined in the Solution Explorer window. The
source code is compiled when you build the project. The object code is assembled into a .LIB file without
going through a linking process. The name of the project is used as the name of the library file by default.
Static libraries offer important advantages in organizing large programs and in sharing routines between
several programs. These libraries contain only subprograms, not main programs. A static library file has

a .LIB extension and contains object code.

When you associate a static library with a program, any necessary routines are linked from the library into
your executable program when it is built. Static libraries are usually kept in their own directories. If you use a
static library, only those routines actually needed by the program are incorporated into the executable image
(.EXE). This means that your executable image will be smaller than if you included all the routines in the
library in your executable image. The Linker determines which routines to include.

Because applications built with a static library all contain the same version of the routines in the library, you
can use static libraries to help keep applications current. When you revise the routines in a static library, you
can easily update all the applications that use it by relinking the applications.

If you have a library of substantial size, you should maintain it in a dedicated directory. Projects using the
library access it during linking.

When you link a project that uses the library, selected object code from the library is linked into that project's
executable code to satisfy calls to external procedures. Unnecessary object files are not included.

To debug a static library, you must use a main program that calls the library routines. Both the main program
and the static library should have been compiled using the debug option. After compiling and linking is
completed, open the Debug menu and choose Go to reach breakpoints, or use the step controls on the
Debug toolbar.

Use Static Libraries

To add static libraries to a main project in the IDE, use the Add Existing Item... option in the Project
menu. You can enter the path and library name with a .LIB extension in the dialog box that appears. If you
are using a makefile, you must add the library by editing the makefile for the main project. If you are
building your project from the command line, add the library name with a .1.IB extension and include the
path specification if necessary.

Use Fortran Dynamic-Link Library Projects

A dynamic-link library (.DLL) is a source-code library that is compiled and linked to a unit independently of
the applications that use it. A DLL shares its code and data address space with a calling application. A DLL
contains only subprograms, not main programs.

A DLL offers the organizational advantages of a static library, but with the advantage of a smaller executable
file at the expense of a slightly more complex interface. Object code from a DLL is not included in your
program's executable file, but is associated as needed in a dynamic manner while the program is executing.
More than one program can access a DLL at a time.

When routines in a DLL are called, the routines are loaded into memory at runtime, as they are needed. This
is most useful when several applications use a common group of routines. By storing these common routines
in a DLL, you reduce the size of each application that calls the DLL. In addition, you can update the routines
in the DLL without having to rebuild any of the applications that call the DLL.

With Intel® Fortran, you can use DLLs in two ways:

1. You can build a DLL with your own routines. In Visual Studio*, select Dynamic-link Library as your
project type. From the command line, use the DLL option with the ifort command.

2. You can build applications with the runtime library stored in a separate DLL instead of in the main
application file. In the integrated development environment, open a solution and do the following:

From the Project menu, select Properties to display the project properties dialog box.
Click the Fortran folder.

Select the Libraries category.

In the Runtime Library option, select an option ending with "DLL."
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From the command line, use the 1ibs compiler option with keyword d11 to build applications with the
runtime library stored in a separate DLL.

See Also
Create Fortran Applications that Use Windows* OS Features

Use the Console
On Windows* OS, a console window allows input and output of characters (not graphics).

For example, data written (explicitly or implicitly) by Fortran WRITE (or other) statements to Fortran logical
unit 6 display characters on a console window. Similarly, data read by Fortran READ (or other) statements to
unit 5 accept keyboard character input.

The console consists of two components:

e The actual console window that shows the characters on the screen.
e The console buffer that contains the characters to be displayed.

If the console screen buffer is larger than the console window, scroll bars are automatically provided. The
size of the console screen buffer must be larger (or equal to) the size of the console window. If the buffer is
smaller than the size of the console window, an error occurs. For applications that need to display more than
a few hundred lines of text, the ability to scroll quickly through the text is important.

Fortran Console applications automatically provide a console. Fortran QuickWin (and Fortran Standard
Graphics) applications do not provide a console, but display output and accept input from Fortran statements
by using the program window.

The following Fortran Project Types provide an application console window:

Project Type Description of Console Provided

Fortran Provides a console window intended to be used for character-cell applications that use
Console text only.

When running a Fortran Console application from the command prompt, the existing
console environment is used. When you run the application from Windows* or Developer
Studio* (by selecting Start Without Debugging in the Debug menu), a new console
environment is created.

Basic console use is described in Code Samples of Console Use.

Fortran Does not provide a console, but output to unit 6 and input to unit 5 are directed to the
QuickWin or application program window, which can handle both text and graphics. Because the
Fortran program window must handle both text and graphics, it is not as efficient as the console
Standard for just text-only use. A Fortran QuickWin or Fortran Standard Graphics program window
Graphics (or child window) provides a console-like window.

See Console Use for Fortran QuickWin and Fortran Standard Graphics Applications.

Fortran Does not provide a console window, but the user can create a console by using Windows*

Windows API routines. See Console Use for Fortran Windows* Applications and Fortran DLL
Applications.

Fortran DLL Does not provide a console window, but the user can create a console by using Win32
routines. See Console Use for Fortran Windows* Applications and Fortran DLL
Applications.

Fortran Static Depends upon the project type of the main application that references the object code in
Library the library (see above project types).

In addition to the Windows* API routines mentioned below, there are other routines related to console use
described in the Microsoft Platform SDK* documentation.

46



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference 1

Console Use for Fortran QuickWin and Fortran Standard Graphics Applications

For a Fortran QuickWin or Fortran Standard Graphics application, because the default program window
handles both graphics and text, the use of a QuickWin window may not be very efficient:

e QuickWin windows use lots of memory and therefore have size limitations.
e They can be slow to scroll.

Although you can access the console window using WRITE and READ (or other) statements, applications that
require display of substantial lines of text, consider creating a DLL that creates a separate console window for
efficiency. The DLL application needs to call Windows* API routines to allocate the console, display text,
accept keyed input, and free the console resources.

Basic use of a console is described in Code Samples of Console Use.

Console Use for Fortran Windows Applications and Fortran DLL Applications

With a Fortran Windows* or Fortran DLL application, attempting to write to the console using WRITE and
READ (or other) statements before a console is created results in a runtime error (such as error performing
WRITE).

A console created by a Fortran DLL is distinct from any application console window associated with the main
application. A Fortran DLL application has neither a console nor an application window created for it, so it
must create (allocate) its own console using Windows* API routines. When used with a Fortran QuickWin or
Fortran Standard Graphics application main program, the Fortran DLL can provide its main application with a
very efficient console window for text-only use.

Like a Fortran DLL application, a Fortran Windows application has neither a console nor an application
window created for it, so it must create its own console using Windows* API routines. After allocating a
console in a Fortran DLL, the handle identifier returned by the GetStdHandle Windows* API routine refers
to the actual console the DLL creates.

When the Fortran Windows application does create a console window, it is very efficient for text-only use.
The handle identifier returned by the GetStdHandle Call Windows* API Routines refers to the actual console
the Fortran Windows application creates.

For information about creating a console, see Allocate and Deallocate a Console below.

Code Samples for Console Use
The following sections shows sample code for using a console:

e Allocate and Deallocate a Console for Fortran Windows* and DLL Applications.
e Extend the Size of the Console Window and Console Buffer for console use in any project type.
e Write and Read Characters at a Cursor Position for console use in any project type.

Allocate and Deallocate a Console

To create a console, you use the AllocConsole routine. When you are done with the console, free its
resources with a FreeConsole routine. For example, the following code allocates the console, enlarges the
buffer size, writes to the screen, waits for any key to be pressed, and deallocates the console:

program test
! The following USE statement provides Fortran interfaces to Windows routines
USE IFWIN
! Begin data declarations
integer lines, length
logical status
integer * 8 fhandle
Type (T_COORD) wpos
! Set buffer size variables
length = 80
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lines = 90
! Begin executable code
! Allocate a console

status = AllocConsole() ! get a console window of the currently set size
fhandle = GetStdHandle (STD_OUTPUT HANDLE)

wpos.x = length ! must be >= currently set console window line length
wpos.y = lines ! must be >= currently set console window number of lines

! Set a console buffer bigger than the console window. This provides

! scroll bars on the console window to scroll through the console buffer

status = SetConsoleScreenBufferSize (fhandle, wpos)

! Write to the screen as needed. Add a READ to pause before deallocation

write (*,*) "This is the console output! It might display instructions or data "

write (*,*) " "

write (*,*) "Press any key when done viewing "

read (*,*)
! Deallocate the console to free its resources.

status = FreeConsole()
end program test

Calling Windows* API routines is described in Call Windows* API Routines.

If you are using a DLL, your DLL code will need to create subprograms and export their symbols to the main
program.

Basic use of a console is described in Extend the Size of the Console Window and Console Buffer and Write
and Read Characters at a Cursor Position.

Extend the Size of the Console Window and Console Buffer

When you execute a Fortran Console application, the console is already allocated. You can specify the size of
the console window, size of the console buffer, and the location of the cursor. If needed, you can extend the
size of the console buffer and console window by using the following Windows* API routines:

1. You first need to obtain the handle of the console window using the GetStdHandle routine. For
example:

! USE statements to include routine interfaces
use ifqwin
use ifport
use ifcore
use ifwin
! Data declarations
integer fhandle
logical lstat
! Executable code
fhandle = GetStdHandle (STD_OUTPUT HANDLE)
|
2. If needed, you can obtain the size of the:

e Console window by using the GetConsoleWindowInfo routine.
e Console buffer by using the GetConsoleScreenBufferInfo routine.

For example:

! USE statements to include routine interfaces
use ifqwin

use ifport

use ifcore

use ifwin

! Data declarations

integer fhandle
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logical lstat

Type (T_CONSOLE SCREEN BUFFER INFO) conbuf
type (T_COORD) dwSize

type (T _SMALL RECT) sriWindow

fhandle = GetStdHandle (STD OUTPUT HANDLE)

! Executable code to get console buffer size

lstat = GetConsoleScreenBufferInfo(fhandle, conbuf)
write (¥, %) " "

write (*,*) "Window coordinates= ", conbuf.srWindow
write (*,*) "Buffer size= ", conbuf.dwSize

|
3. To set the size of the console window and buffer, use the SetConsoleWindowInfo and
SetConsoleScreenBufferSize routines with the fhandle value returned previously:

! USE statements to include routine interfaces
use ifqwin

use ifport

use ifcore

use ifwin

! Data declarations

integer nlines, ncols

logical lstat

Type (T_COORD) wpos

Type (T_SMALL RECT) sr

Type (T_CONSOLE_SCREEN BUFFER INFO) cinfo

! Executable code to set console window size

sr.top = 0

sr.left = 0

sr.bottom = 40 ! <= console buffer height
=1

sr.right = 60 ! <=

console buffer width -1

lstat = SetConsoleWindowInfo (fhandle, .TRUE., sr)

! Executable code to set console buffer size
nlines = 100
ncols 80
wpos.x = ncols ! columns >= console window width
wpos.y = nlines ! lines >= console window height

lstat = SetConsoleScreenBufferSize (fhandle, wpos)
|

Write and Read Characters at a Cursor Position

You can position the cursor as needed using the SetConsoleCursorPosition routine before you write
characters to the screen:

! Use previous data declarations
! Position and write two lines
wpos.x = 5 ! 6 characters from left
wpos.y = 5 ! 6 lines down
lstat = SetConsoleCursorPosition (fhandle, wpos)

write(*,*) 'Six across Six down'
|

You read from the screen at an appropriate place, but usually you should set the cursor relative to the
starting screen location:

! Use previous and the following data declaration
CHARACTER (Len=50) charin
! Go back to beginning position of screen
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wpos.x = 0 ! 0 characters from left

wpos.y = 0 ! 0 lines down

lstat = SetConsoleCursorPosition (fhandle, wpos)
! Position character input at start of line 11

wpos.x = 0 ! first character from left

wpos.y = 10 ! 11 lines down

lstat = SetConsoleCursorPosition (fhandle, wpos)

read (*,*) charin
|

For console I/0, you can use Windows* OS routines WriteConsolelLine and ReadConsoleLine instead of
Fortran WRITE and READ statements.

See Also

Understand Project Types

Call Windows* API Routines

Use the Console

Code Samples of Console Use

Console Use for Fortran QuickWin and Fortran Standard Graphics Applications
Console Use for Fortran Windows* Applications and Fortran DLL Applications
Allocate and Deallocate a Console

Extend the Size of the Console Window and Console Buffer

Write and Read Characters at a Cursor Position

Create Fortran Applications That Use Windows Features

A separate document is available that details the process of creating features, titled Use Intel® Fortran to
Create and Build Windows-Based Applications.

The document covers:

¢ Create Fortran Windowing Applications: Windows-based applications use the Windows interface,
complete with tool bars, pull-down menus, dialog boxes, and other features. You can include data entry
and mouse control in your application and allow for interaction with programs written in other languages
or commercial programs such as Microsoft Excel.

e Create and Using Fortran DLLs: A dynamic-link library (DLL) contains one or more subprogram
procedures (functions or subroutines) that are compiled, linked, and stored separately from the
applications using them. Because the functions or subroutines are separate from the applications using
them, they can be shared or replaced easily.

e Use QuickWin: The Intel® Fortran QuickWin runtime library helps you turn graphics programs into simple
Windows applications. Though the full capability of Windows is not available through QuickWin, QuickWin
is simpler to learn and to use. QuickWin applications support pixel-based graphics, real-coordinate
graphics, text windows, character fonts, user-defined menus, mouse events, and editing (select/copy/
paste) of text, graphics, or both.

e Use Dialog Boxes for Application Controls: Dialog boxes are a user-friendly way to solicit application
control. As your application executes, you can make a dialog box appear on the screen. You can click a
dialog box control to enter data or choose what happens next. Using the dialog routines provided with
Intel® Fortran, you can add dialog boxes to your application. These routines define dialog boxes and their
controls (scroll bars, buttons, etc.), and call your subroutines to respond to user selections.

See Also
Intel® Software Documentation Library

Dialog Box Help

This section provides information about access to dialog boxes and information about compilers, libraries,
and converter dialog boxes.
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Options: General dialog box

To access the General page, click Tools > Options and then select Intel Compilers and Libraries >
IFORT Intel Fortran Classic > General for ifort or Intel Compilers and Libraries > IFX Intel
Fortran > General for ifx. Use this page to specify Fortran File Extensions and Build Options.

Build Options

Continue on Errors: Check this box to allow compilation to continue regardless of an error in the current
file. The compiler will begin compiling the next file. (To set the maximum number of errors to encounter
before compilation stops, choose Configuration Properties > Fortran > Diagnostics > Error Limit).

Generate Build Logs: Check this box to generate build logs.

Show Environment in Log: Check this box to show environment variable settings in the log file.

Fortran File Extensions

You can specify additional Fortran free format and fixed format file extensions to be recognized as valid file
extensions within the IDE. The IDE treats these additional extensions as compilable Fortran source files. You
can also remove or modify existing extensions that appear in the list.

When you add a new extension, the IDE checks the registry to determine whether the extension is already
associated with a language, tool, or file format. If there is such an association, a message informs you of this
and you will not be allowed to add the extension.

Headers: Specify one or more file extensions for header files, each beginning with a period and separated by
semicolons.

Sources: Specify one or more file extensions for source files, each beginning with a period and separated by
semicolons.

Click OK to save your changes.

Options: Compilers dialog box
To access the Compilers page:

1. Open Tools > Options.
2. In the left pane, select Intel Compilers and Libraries > IFORT Intel Fortran Classic > Compilers
for ifort or Intel Compilers and Libraries > IFX Intel Fortran > Compilers for ifx.

Compiler Selection for IFORT Intel Fortran Classic
Tabs Win32 and x64: Select Win32 or x64 target platforms.

Selected compiler: Selects the compiler version. The default value is <Latest>.

NOTE The compiler details are shown in the two boxes directly below.

Executables: Specifies the directory location for executable files. You may specify this setting for each
selected compiler.

Includes: Specifies the directory location for included files. You may specify this setting for each selected
compiler.

Libraries: Specifies the directory location for libraries. You may specify this setting for each selected
compiler.

Default options: Sets the default options for a selected compiler You may specify this setting for each
selected compiler.

Reset...: Resets the settings for the compiler.
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Compiler Selection for IFX Intel Fortran

Selected compiler: Selects the compiler version. The default value is <Latest>.

NOTE The compiler details are shown in the two boxes directly below.

Executables: Specifies the directory location for executable files. You may specify this setting for each
selected compiler.

Includes: Specifies the directory location for included files. You may specify this setting for each selected
compiler.

Libraries: Specifies the directory location for libraries. You may specify this setting for each selected
compiler.

Default options: Sets the default options for a selected compiler You may specify this setting for each
selected compiler.

Reset...: Resets the settings for the compiler.

See Also
Selecting the Compiler Version
Specifying Path, Library, and Include Directories

Options: Advanced dialog box

To access the Advanced page, expand the Tools > Options > Text Editor > Fortran nodes and select
Advanced. Here you can specify advanced options for text editing.

Browsing/Navigation Section

Collect Call/Callers graph information: Choose this option to enable or disable information collection for
the Call/Callers graph. Once enabled, you can right-click on a member name in the Code Editor, then click
Call Browser to view the member's call hierarchy.

Collect Object Browser information: Choose this option to enable the display of procedures in your
project in a hierarchical tree. Once enabled, you can use View > Object Browser to display your
procedures.

Disable Database: Choose this option to disable creation of the code browsing database. This may help
increase performance on slow machines. When you disable the database, all features that rely on code
browsing information do not work.

Enable Database Saving/Loading: Choose this option to save collected data to a file on disk so that all
source browsing features are available immediately when you open the project. When this option is disabled,
the code browsing database is generated via background source parsing, so many features that rely on code
browsing information do not work until this process completes. Saving and loading the database requires
some additional time when saving and loading the project.

Enable Find All References: Choose this option to enable display of the location(s) in your code where a
symbol is referenced. When this option is enabled, you can use the right-click context menu Find All
References option to display a list of references to the selected symbol. Double-click on a reference to find
that reference.

Enable Go To Definition: Choose this option to enable quick navigation to an object definition. When this
option is enabled, you can use the right-click context menu Go to Definition option to locate where the
selected object was declared, opening the associated source file if required. (If you have also enabled Scan
system includes, any objects declared in system modules such as IFWINTY cause the associated source for
that module to be opened.)
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Scan system includes: Choose this option to scan system include files. This option is used with one or
more of the following options: Collect Object Browser Information, Enable Find All References,
Enable Go To Definition.

Intrinsics Section

Enable Intrinsic Parameter Info: Choose this option to enable the display of intrinsic function and
subroutine parameter information. When this option is enabled, you can type a name of an intrinsic
procedure, followed by an open parenthesis, and information about the procedure and its arguments
appears.

Enable Intrinsic Quick Info: Choose this option to enable the display of additional information when the
mouse pointer is moved over an intrinsic function or subroutine name.

Miscellaneous Section

Enumerate Comment Tasks: Choose this option to enable the display of a list of tasks consisting of source
files containing comments. Comments take the form of the ! character, followed by a token such as TO DO.
Valid tokens are those listed in Tools > Options > Environment > Task List. When this option is enabled,
you can select Comments from the task list using either:

e View > Task List for Microsoft Visual Studio* 2017/2019

-OR-
¢ View > Other Windows > Task List for Microsoft Visual Studio 2022

You can double-click on a comment in the list to jump to its location.

Highlight Matching Tokens: Choose this option to allow identifier highlighting and block delimiter
matching. When enabled, this option highlights all references to the identifier under the cursor.

Outlining Section

Enable Outlining: Choose this option to allow the collapsing of whole program units. When this option is
enabled, you can click the minus (=) or plus (+) symbols for PROGRAM, SUBROUTINE, FUNCTION, MODULE,
and BLOCK DATA statements.

Outline Statement Blocks: Choose this option to allow collapsing of block constructs such as IF and DO.
You must also choose Enable Outlining.

Compiler Reference

This section contains compiler reference information. For example, it contains information about compiler
options, compiler limits, and libraries.

Compiler Limits

The amount of data storage, the size of arrays, and the total size of executable programs are limited only by
the amount of process virtual address space available, as determined by system parameters.

The table below shows the limits to the size and complexity of a single Intel® Fortran program unit and to
individual statements contained within it:

Language Element Limit

Actual number of arguments per CALL or Limited only by memory constraints
function reference
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Language Element Limit
Arguments in a function reference in a 255
specification expression

Array dimensions 31

(The Fortran 2018 standard supports a maximum array
dimension of 15.)

Array elements per dimension 2**31-1 on systems using IA-32 architecture

2**63-1 on systems using Intel® 64 architecture

Limited by current memory configuration.

Character lengths 2**31-1 on systems using IA-32 architecture

2**63-1 on systems using Intel® 64 architecture

Constants: character and Hollerith 7198

Constants: characters read in list- 2048 characters

directed I/0

Continuation lines Free-format lines can contain up to 10,000 characters. A
statement in either fixed or free format can contain up to
1,000,000 characters. Longer lines may reduce the number of

allowed continuations, subject to the limit on lexical tokens per

Data and I/0 implied DO nesting

DO, CASE, FORALL, WHERE, and block
IF statement nesting (combined)

DO loop index variable
Format group nesting

Fortran source line length

INCLUDE file nesting

Labels in computed or assigned GOTO
list

Lexical tokens per statement

Named common blocks

Nesting of array constructor implied DOs
Nesting of input/output implied DOs
Nesting of interface blocks

Nesting of DO, IF, or CASE constructs
Nesting of parenthesized formats
Number of arguments to MIN and MAX

Number of digits in a numeric constant
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statement.
31
512

9,223,372,036,854,775,807= 2**63-1
8

fixed format: 72 (or 132 if /extend source is in effect)

characters

free format: 10,000 characters
20 levels

Limited only by memory constraints

41,000

Limited only by memory constraints
31

31

Limited only by memory constraints
Limited only by memory constraints
Limited only by memory constraints
Limited only by memory constraints

Limited by statement length
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Language Element Limit

Parentheses nesting in expressions Limited only by memory constraints
Structure nesting 30

Symbolic name length 63 characters

Width field for a numeric edit descriptor 2**15-1 on systems using IA-32 architecture
2**31-1 on systems using Intel® 64 architecture

For limits of other edit descriptor fields, see Forms for Data
Edit Descriptors.

For more information on memory limits for large data objects, see:

The AUTOMATIC statement
The /F compiler option

The heap-array compiler option
The product Release Notes

See Also
Forms for Data Edit Descriptors

Compiler Options
This compiler supports many compiler options you can use in your applications.

The LLVM-based Intel® Fortran Compiler (ifx) supports many Intel® Fortran Compiler Classic compiler options,
but full implementation is not yet available. Implementation will be improved in future releases.

NOTE
macOS is no longer supported for Intel® Fortran Compiler Classic (ifort).

In this section, we provide the following:

An alphabetical list of compiler options that includes their short descriptions

Lists of deprecated and removed options

General rules for compiler options and the conventions we use when referring to options

Details about what appears in the compiler option descriptions

A description of each compiler option. The descriptions appear under the option's functional category.
Within each category, the options are listed in alphabetical order.

Several Clang compiler options are supported for the ifx compiler, such as some of the -fprofile options.
We do not document these options. For more information about Clang options, see the Clang documentation.

Note that for ifx, the Clang -fprofile options replace the functionality of the [Q]prof options that are only
supported for ifort.

For details about new functionality, such as new compiler options, see the Release Notes for the product.

Conventions Used for Compiler Options

The following conventions are used to describe compiler options.

compiler option name shortcuts The following conventions are used as shortcuts
when referencing compiler option names in
descriptions:

e No initial - or /
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/option or

-option

/option:argument oOr

-option=argument

/option: keyword or

-option=keyword

/option[:keyword ] or

-option[=keyword ]
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This shortcut is used for option names that are
the same for Linux and Windows except for the
initial character.

For example, Fa denotes:

e Linux: -Fa
e Windows: /Fa

[Q]option-name

This shortcut is used for option names that only
differ because the Windows form starts with a Q.

For example, [Q]ipo denotes:

e Linux: -ipo
e Windows: /Qipo

[g or QJoption-name

This shortcut is used for option names that only
differ because the Linux form starts with a g and
the Windows form starts with a Q.

For example, [g or QJopt-report denotes:

e Linux: -gopt-report
e Windows: /Qopt-report

More dissimilar compiler option names are shown in

full.

A slash before an option name indicates the option
is available on Windows. A dash before an option
name indicates the option is available on Linux
systems. For example:

e Linux : -help
¢ Windows: /help

NOTE If an option is available on all supported
operating systems, no slash or dash appears in
the general description of the option. The slash
and dash will only appear where the option
syntax is described.

Indicates that an option requires an argument
(parameter). For example, you must specify an
argument for the following options:

e Linux: -mtune=processor
e Windows: /tune:processor

Indicates that an option requires one of the
keyword values.

Indicates that the option can be used alone or with
an optional keyword.
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option[n] or Indicates that the option can be used alone or with
an optional value. For example, in —unroll[=n],
the n can be omitted or a valid value can be
option[=n] specified for n.

option[:n] or

option[-] Indicates that a trailing hyphen disables the option.
For example, /Qglobal hoist- disables the
Windows option /Qglobal hoist.

[no]option or Indicates that no or no- preceding an option

[no-]option disables the option. For example:

In the Linux option - [no-]global hoist,
-global hoist enables the option, while
-no-global hoist disables it.

In the Windows
option /[no]ltraceback, /traceback enables the
option, while /notraceback disables it.

In some options, the no appears later in the option
name. For example, -fno-common disables the
-fcommon option.

Alphabetical Option List

The following table lists current compiler options in alphabetical order.

NOTE

Several Clang compiler options are supported for the ifx compiler, such as some of the -fprofile
options. We do not document these options. For more information about Clang options, see the Clang
documentation.

Note that for ifx, the Clang -fprofile options replace the functionality of the [Q]prof options that
are only supported for ifort.

4Nportlib, 4Yportlib Determines whether the compiler links to the library of portability
routines.

align Tells the compiler how to align certain data items.

allow Determines whether the compiler allows certain behaviors.

altparam Allows alternate syntax (without parentheses) for PARAMETER
statements.

ansi-alias, Qansi-alias Tells the compiler to assume certain rules of the Fortran standard
regarding aliasing and array bounds.

arch Tells the compiler which features it may target, including which
instruction sets it may generate.

assume Tells the compiler to make certain assumptions.

auto Causes all local, non-SAVEd variables to be allocated to the runtime
stack.
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auto-scalar, Qauto-scalar

ax, Qax

Bdynamic

bigobj

bintext

Bstatic

Bsymbolic

Bsymbolic-functions

C

ccdefault

check

coarray, Qcoarray

coarray-config-file, Qcoarray-

config-file

coarray-num-images,
Qcoarray-num-images

complex-limited-range,
Qcomplex-limited-range

convert

cxxlib

D
dbglibs

debug (Linux* )
debug (Windows*)

debug-parameters

device-math-lib

diag, Qdiag
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Causes scalar variables of intrinsic types INTEGER, REAL, COMPLEX, and
LOGICAL that do not have the SAVE attribute to be allocated to the
runtime stack.

Tells the compiler to generate multiple, feature-specific auto-dispatch
code paths for Intel® processors if there is a performance benefit.

Specifies a directory that can be used to find include files, libraries, and
executables.

Enables dynamic linking of libraries at runtime.

Increases the number of sections that an object file can contain. This
feature is only available for ifort.

Places a text string into the object file (.obj) being generated by the
compiler. This feature is only available for ifort.

Enables static linking of a user's library.

Binds references to all global symbols in a program to the definitions
within a user's shared library.

Binds references to all global function symbols in a program to the
definitions within a user's shared library.

Causes the compiler to generate an object only and not link.

Specifies the type of carriage control used when a file is displayed at a
terminal screen.

Checks for certain conditions at runtime.
Enables the coarray feature.

Specifies the name of a Message Passing Interface (MPI) configuration
file.

Specifies the default number of images that can be used to run a coarray
executable.

Determines whether the use of basic algebraic expansions of some
arithmetic operations involving data of type COMPLEX is enabled. This
feature is only available for ifort.

Specifies the format of unformatted files containing numeric data.

Determines whether the compiler links using the C++ runtime libraries
provided by gcc.

Defines a symbol name that can be associated with an optional value.

Tells the linker to search for unresolved references in a debug runtime
library.

Enables or disables generation of debugging information.
Enables or disables generation of debugging information.

Tells the compiler to generate debug information for PARAMETERS used in
a program.

Enables or disables certain device libraries.

Controls the display of diagnostic information during compilation.



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference 1

diag-dump, Qdiag-dump

diag-error-limit, Qdiag-error-

limit

diag-file, Qdiag-file

diag-file-append, Qdiag-file-

append

diag-id-numbers, Qdiag-id-

numbers
d-lines, Qd-lines
dll

double-size

dryrun
dumpmachine
dynamic-linker
dyncom, Qdyncom
E

EP

exe
extend-source
extfor

extfpp

extlink

F (Windows*)
f66

f77rtl

Fa

FA (ifx only)

FA (ifort only)

falias, Oa

falign-functions, Qfnalign

falign-loops, Qalign-loops

Tells the compiler to print all enabled diagnostic messages.

Specifies the maximum number of errors allowed before compilation
stops.

Causes the results of diagnostic analysis to be output to a file.

Causes the results of diagnostic analysis to be appended to a file.

Determines whether the compiler displays diagnostic messages by using
their ID number values.

Compiles debug statements.
Specifies that a program should be linked as a dynamic-link (DLL) library.

Specifies the default KIND for DOUBLE PRECISION and DOUBLE COMPLEX
declarations, constants, functions, and intrinsics.

Specifies that driver tool commands should be shown but not executed.
Displays the target machine and operating system configuration.
Specifies a dynamic linker other than the default.

Enables dynamic allocation of common blocks at runtime.

Causes the preprocessor to send output to stdout.

Causes the preprocessor to send output to stdout, omitting #line
directives.

Specifies the name for a built program or dynamic-link library.
Specifies the length of the statement field in a fixed-form source file.
Specifies file extensions to be processed by the compiler as Fortran files.

Specifies file extensions to be recognized as a file to be preprocessed by
the Fortran preprocessor.

Specifies file extensions to be passed directly to the linker.
Specifies the stack reserve amount for the program.

Tells the compiler to apply FORTRAN 66 semantics.

Tells the compiler to use the runtime behavior of FORTRAN 77.
Specifies that an assembly listing file should be generated.

Produces an assembly listing without source or machine code
annotations. This description is only for ifx.

Specifies the contents of an assembly listing file. This description is only
for ifort.

Specifies whether or not a procedure call may have hidden aliases of local
variables not supplied as actual arguments.

Tells the compiler to align procedures on an optimal byte boundary.

Aligns loops to a power-of-two byte boundary. This feature is only
available for ifort.

59



1 Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

falign-stack

fast

fast-transcendentals, Qfast-
transcendentals

fasynchronous-unwind-tables

fcf-protection, Qcf-protection

fcode-asm

fcommon

Fd

feliminate-unused-debug-
types, Qeliminate-unused-
debug-types

fexceptions

ffat-lto-objects

ffnalias, Ow

ffp-accuracy

fimf-absolute-error, Qimf-
absolute-error

fimf-accuracy-bits, Qimf-
accuracy-bits

fimf-arch-consistency, Qimf-
arch-consistency

fimf-domain-exclusion, Qimf-
domain-exclusion

fimf-force-dynamic-target,
Qimf-force-dynamic-target

fimf-max-error, Qimf-max-
error

fimf-precision, Qimf-precision
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Tells the compiler the stack alignment to use on entry to routines. This
option is deprecated and will be removed in a future release. This feature
is only available for ifort.

Maximizes speed across the entire program.

Enables the compiler to replace calls to transcendental functions with
faster but less precise implementations. This feature is only available for
ifort.

Determines whether unwind information is precise at an instruction
boundary or at a call boundary.

Enables Intel® Control-Flow Enforcement Technology (Intel® CET)
protection, which defends your program from certain attacks that exploit
vulnerabilities. This option offers preliminary support for Intel® CET.

Produces an assembly listing with machine code annotations. This feature
is only available for ifort.

Determines whether the compiler treats common symbols as global
definitions.

Lets you specify a name for a program database (PDB) file created by the
compiler. This feature is only available for ifort.

Controls the debug information emitted for types declared in a
compilation unit. This feature is only available for ifort.

Enables exception handling table generation.

Determines whether a fat link-time optimization (LTO) object, containing
both intermediate language and object code, is generated during an
interprocedural optimization compilation (-c -ipo). This feature is only
available for ifort.

Determines whether aliasing is assumed within functions. This feature is
only available for ifort.

Lets you specify the required accuracy (precision) for floating-point
operations and library calls. This feature is only available for ifx.

Defines the maximum allowable absolute error for math library function
results.

Defines the relative error for math library function results, including
division and square root.

Ensures that the math library functions produce consistent results across
different microarchitectural implementations of the same architecture.

Indicates the input arguments domain on which math functions must
provide correct results.

Instructs the compiler to use runtime dispatch in calls to math functions.
This feature is only available for ifort.

Defines the maximum allowable relative error for math library function
results, including division and square root.

Lets you specify a level of accuracy (precision) that the compiler should
use when determining which math library functions to use.
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fimf-use-svml, Qimf-use-svml

finline

finline-functions
finline-limit
finstrument-functions,
Qinstrument-functions

fiopenmp, Qiopenmp

fixed

fkeep-static-consts , Qkeep-
static-consts

flink-huge-device-code

fltconsistency

flto

fma, Qfma

fmaintain-32-byte-stack-
align, Qmaintain-32-byte-
stack-align

fmath-errno

fmerge-constants

fmerge-debug-strings

fminshared

fmpc-privatize

fnsplit, Qfnsplit

fomit-frame-pointer

Instructs the compiler to use the Short Vector Math Library (SVML) rather
than the Intel® Fortran Compiler Classic and Intel® Fortran Compiler Math
Library (LIBM) to implement math library functions.

Tells the compiler to inline functions declared with !'DIR$ ATTRIBUTES
FORCEINLINE.

Enables function inlining for single file compilation.

Lets you specify the maximum size of a function to be inlined. This
feature is only available for ifort.

Determines whether routine entry and exit points are instrumented.

Enables recognition of OpenMP* features and tells the parallelizer to
generate multi-threaded code based on OpenMP* directives. Provides the
ability to offload to a GPU when -fopenmp-targets (or /Qopenmp-targets)
is also specified. This feature is only available for ifx.

Specifies source files are in fixed format.

Tells the compiler to preserve allocation of variables that are not
referenced in the source. This feature is only available for ifort.

Tells the compiler to place device code later in the linked binary. This is to
prevent 32-bit PC-relative relocations between surrounding Executable
and Linkable Format (ELF) sections when the device code is larger than
2GB. This feature is only available for ifx.

Enables improved floating-point consistency.

Enables whole program link time optimization (LTO). This feature is only
available for ifx.

Determines whether the compiler generates fused multiply-add (FMA)
instructions if such instructions exist on the target processor.

Tells the compiler to realign the stack to 32-byte if stack alignment is
uncertain for functions with external linkage, and retain 32-byte
alignment for other functions. This feature is only available for ifx.

Tells the compiler that errno can be reliably tested after calls to standard
math library functions.

Determines whether the compiler and linker attempt to merge identical
constants (string constants and floating-point constants) across
compilation units. This feature is only available for ifort.

Causes the compiler to pool strings used in debugging information.

Specifies that a compilation unit is a component of a main program and
should not be linked as part of a shareable object. This feature is only
available for ifort.

Enables or disables privatization of all static data for the MultiProcessor
Computing environment (MPC) unified parallel runtime. This feature is
only available for ifort.

Enables function splitting. This feature is only available for ifort.

Determines whether EBP is used as a general-purpose register in
optimizations.
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fopenmp, Qopenmp

fopenmp-concurrent-host-
device-compile, Qopenmp-
concurrent-host-device-
compile

fopenmp-declare-target-
scalar-defaultmap, Qopenmp-
declare-target-scalar-
defaultmap

fopenmp-default-allocator,
Qopenmp-default-allocator

fopenmp-device-code-split,
Qopenmp-device-code-split

fopenmp-device-lib

fopenmp-do-concurrent-
maptype-modifier, Qopenmp-
do-concurrent-maptype-
modifier

fopenmp-max-parallel-link-
jobs, Qopenmp-max-parallel-
link-jobs

fopenmp-target-buffers,
Qopenmp-target-buffers

fopenmp-target-default-sub-
group-size, Qopenmp-target-
default-sub-group-size

fopenmp-target-do-
concurrent, Qopenmp-target-
do-concurrent
fopenmp-target-loopopt,
Qopenmp-target-loopopt

fopenmp-target-simd,
Qopenmp-target-simd

fopenmp-targets, Qopenmp-
targets
foptimize-sibling-calls

fortlib

fpconstant
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Enables recognition of OpenMP* features and tells the parallelizer to
generate multi-threaded code based on OpenMP* directives.

Enables parallel compilation of host and target compilation steps when
performing OpenMP* offload compilations. This is an experimental
feature. This feature is only available for ifx.

Determines which implicit data-mapping/sharing rules are applied for a
scalar variable referenced in a TARGET directive. This feature is only
available for ifx.

Tells the compiler that all ALLOCATE statements should be treated as
though there were an explicit OpenMP ALLOCATE directive that preceded
them. This feature is only available for ifx.

Enables parallel compilation of SPIR-V* kernels for OpenMP offload
Ahead-Of-Time compilation. This feature is only available for ifx.

Enables or disables certain device libraries for an OpenMP* target.

Lets you specify the data movement for variables referenced inside the
DO CONCURRENT region when it is auto-offloaded. This feature is only
available for ifx.

Determines the maximum number of parallel actions to be performed
during device linking steps, where applicable. This feature is only
available for ifx.

Enables a way to overcome the problem where some OpenMP* offload
SPIR-V* devices produce incorrect code when a target object is larger
than 4GB. This feature is only available for ifx.

Lets you specify a default sub-group size globally for single program
multiple data (SPMD) kernels that are generated for OpenMP* target
constructs when offloading to SPIR64-based devices. This feature is only
available for ifx.

Determines whether a DO CONCURRENT construct is automatically
converted into an OpenMP* TARGET region. This feature is only available
for ifx.

Enables the loop optimizer and auto-vectorization for OpenMP* offloading
device compilation when option O2 or higher is set or specified. This
feature is only available for ifx.

Enables OpenMP* SIMD loop vectorization for OpenMP offloading device
compilation when option level O2 or higher is set or specified. This
feature is only available for ifx.

Enables offloading to a specified GPU target if OpenMP* features have
been enabled. This feature is only available for ifx.

Determines whether the compiler optimizes tail recursive calls.

Tells the C/C++ compiler driver to link to the Fortran libraries. This option
is primarily used by C/C++ for mixed-language programming.

Tells the compiler that single-precision constants assigned to double-
precision variables should be evaluated in double precision.
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fpe

fpe-all

fpic
fpie

fp-model, fp
fpp

fpp-name

fp-port, Qfp-port

fpreview-breaking-changes

fprofile-ml-use

fprotect-parens, Qprotect-
parens

fpscomp

fp-speculation, Qfp-
speculation

fp-stack-check, Qfp-stack-
check

free

fsanitize

fsource-asm

fstack-protector

fstack-security-check

fstrict-overflow, Qstrict-
overflow

fsycl

Allows some control over floating-point exception handling for the main
program at runtime.

Allows some control over floating-point exception handling for each
routine in a program at runtime.

Determines whether the compiler generates position-independent code.

Tells the compiler to generate position-independent code. The generated
code can only be linked into executables.

Controls the semantics of floating-point calculations.
Runs the Fortran preprocessor on source files before compilation.
Lets you specify an alternate preprocessor to use with Fortran.

Rounds floating-point results after floating-point operations. This feature
is only available for ifort.

Lets a user tell the compiler that they are willing to give up backward
compatibility guarantees and lets the compiler enable new backward
breaking changes that will appear in the next major release. This feature
is only available for ifx.

Enables the use of a pre-trained machine learning model to predict
branch execution probabilities driving profile-guided optimizations. This
feature is only available for ifx.

Determines whether the optimizer honors parentheses when floating-
point expressions are evaluated.

Controls whether certain aspects of the runtime system and semantic
language features within the compiler are compatible with Intel® Fortran
or Microsoft* Fortran PowerStation.

Tells the compiler the mode in which to speculate on floating-point
operations.

Tells the compiler to generate extra code after every function call to
ensure that the floating-point stack is in the expected state. This feature
is only available for ifort.

Specifies source files are in free format.

Enables the specified code sanitizer to detect certain issues at runtime.
This feature is only available for ifx.

Produces an assembly listing with source code annotations. This feature is
only available for ifort.

Enables or disables stack overflow security checks for certain (or all)
routines.

Determines whether the compiler generates code that detects some
buffer overruns.

Determines whether strict overflow is enabled for signed addition,
subtraction, and multiplication wrap arounds using twos-complement
representation. This feature is only available for ifx.

Enables linking Fortran object files with DPC++ SYCL-based object files.
This feature is only available for ifx.
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fsycl-dead-args-optimization

fsycl-device-code-split

fsycl-device-lib

fsycl-instrument-device-code

fsycl-link-huge-device-code

fsycl-targets

ftarget-compile-fast

ftarget-register-alloc-mode

ftrapuv, Qtrapuv

ftz, Qftz

fuse-ld

fvec-peel-loops, Qvec-peel-
loops

fvec-remainder-loops, Qvec-
remainder-loops

fvec-with-mask, Qvec-with-
mask

fverbose-asm

fvisibility
fzero-initialized-in-bss, Qzero-
initialized-in-bss

g

gcc-name

gdwarf

64

Enables elimination of DPC++ dead kernel arguments. This feature is
only available for ifx.

Specifies a SYCL* device code module assembly. This feature is only
available for ifx.

Enables or disables certain device libraries for a SYCL* target. This
feature is only available for ifx.

Enables or disables linking of the Instrumentation and Tracing Technology
(ITT) device libraries for VTune™. This feature is only available for ifx.

Tells the compiler to place device code later in the linked binary. This is to
prevent 32-bit PC-relative relocations between surrounding Executable
and Linkable Format (ELF) sections when the device code is larger than
2GB. This is a deprecated option that will be removed in a future release.
This feature is only available for ifx.

Tells the compiler to generate code for specified device targets. This
option is only valid for linking against SYCL-based objects. This feature is
only available for ifx.

Tells the compiler to perform less aggressive optimizations to reduce
compilation time at the expense of generating less optimal target code.
This is an experimental feature.This feature is only available for ifx.

Specifies a register allocation mode for specific hardware for use by
supported target backends. This feature is only available for ifx.

Initializes stack local variables to an unusual value to aid error detection.
Flushes subnormal results to zero.

Tells the compiler to use a different linker instead of the default linker,
which is Id on Linux and link on Windows.

Enables peel loop vectorization. This feature is only available for ifx.

Enables remainder loop vectorization. This feature is only available for ifx.

Enables vectorization for short trip-count loops with masking. This feature
is only available for ifx.

Produces an assembly listing with compiler comments, including options
and version information.

Specifies the default visibility for global symbols or the visibility for
symbols in a file.

Determines whether the compiler places in the DATA section any
variables explicitly initialized with zeros.

Tells the compiler to generate a level of debugging information in the
object file.

Lets you specify the name of the GCC compiler that should be used to set
up the link-time environment, including the location of standard libraries.

Lets you specify a DWARF Version format when generating debug
information.
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Ge

gen-dep

gen-depformat

gen-depshow

gen-interfaces

GF

global-hoist, Qglobal-hoist

grecord-gcc-switches

GS

Gs

gsplit-dwarf
guard

gxx-name

heap-arrays

help

homeparams

hotpatch

I
idirafter
iface

init, Qinit

inline

inline-factor, Qinline-factor

Enables stack-checking for all functions. This is a deprecated option. The
replacement option is /GsO0.

Tells the compiler to generate build dependencies for the current
compilation.

Specifies the form for the output generated when option gen-dep is
specified.

Determines whether certain features are excluded from dependency
analysis. Currently, it only applies to intrinsic modules.

Tells the compiler to generate an interface block for each routine in a
source file.

Enables read-only string-pooling optimization.

Enables certain optimizations that can move memory loads to a point
earlier in the program execution than where they appear in the source.

Causes the command line options that were used to invoke the compiler
to be appended to the DW_AT_producer attribute in DWARF debugging
information. This feature is only available for ifort.

Determines whether the compiler generates code that detects some
buffer overruns.

Lets you control the threshold at which the stack checking routine is
called or not called.

Creates a separate object file containing DWARF debug information.
Enables the control flow protection mechanism.

Lets you specify the name of the g++ compiler that should be used to set
up the link-time environment, including the location of standard libraries.

Puts automatic arrays and arrays created for temporary computations on
the heap instead of the stack.

Displays all supported compiler options or supported compiler options
within a specified category of options.

Tells the compiler to store parameters passed in registers to the stack.
This feature is only available for ifort.

Tells the compiler to prepare a routine for hotpatching. This feature is
only available for ifort.

Specifies an additional directory for the include path.
Adds a directory to the second include file search path.

Specifies the default calling convention and argument-passing convention
for an application.

Lets you initialize a class of variables to zero or to various numeric
exceptional values.

Specifies the level of inline function expansion.

Specifies the percentage multiplier that should be applied to all inlining
options that define upper limits. This feature is only available for ifort.
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inline-forceinline, Qinline-
forceinline
inline-level, Ob

inline-max-per-compile,
Qinline-max-per-compile

inline-max-per-routine,
Qinline-max-per-routine

inline-max-size, Qinline-max-
size

inline-max-total-size, Qinline-
max-total-size

inline-min-caller-growth,
Qinline-min-caller-growth
inline-min-size, Qinline-min-
size

intconstant

integer-size
intel-freestanding

intel-freestanding-target-os
ip, Qip

ip-no-inlining, Qip-no-inlining
ip-no-pinlining, Qip-no-
pinlining

ipo, Qipo

ipo-c, Qipo-c

ipo-jobs, Qipo-jobs

ipo-S, Qipo-S

ipo-separate, Qipo-separate

isystem
I
L
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Instructs the compiler to force inlining of functions suggested for inlining
whenever the compiler is capable doing so. This feature is only available
for ifort.

Specifies the level of inline function expansion.

Specifies the maximum number of times inlining may be applied to an
entire compilation unit. This feature is only available for ifort.

Specifies the maximum number of times the inliner may inline into a
particular routine. This feature is only available for ifort.

Specifies the lower limit for the size of what the inliner considers to be a
large routine. This feature is only available for ifort.

Specifies how much larger a routine can normally grow when inline
expansion is performed. This feature is only available for ifort.

Lets you specify a procedure size n for which procedures of size <= n do
not contribute to the estimated growth of the caller when inlined. This
feature is only available for ifort.

Specifies the upper limit for the size of what the inliner considers to be a
small routine. This feature is only available for ifort.

Tells the compiler to use FORTRAN 77 semantics to determine the kind
parameter for integer constants.

Specifies the default KIND for integer and logical variables.
Lets you compile in the absence of a gcc environment.
Lets you specify the target operating system for compilation.

Determines whether additional interprocedural optimizations for single-
file compilation are enabled. This feature is only available for ifort.

Disables full and partial inlining enabled by interprocedural optimization
options. This feature is only available for ifort.

Disables partial inlining enabled by interprocedural optimization options.
This feature is only available for ifort.

Enables interprocedural optimization between files.

Tells the compiler to optimize across multiple files and generate a single
object file. This feature is only available for ifort.

Specifies the number of commands (jobs) to be executed simultaneously
during the link phase of Interprocedural Optimization (IPO). This feature
is only available for ifort.

Tells the compiler to optimize across multiple files and generate a single
assembly file. This feature is only available for ifort.

Tells the compiler to generate one object file for every source file. This
feature is only available for ifort.

Specifies a directory to add to the start of the system include path.
Tells the linker to search for a specified library when linking.

Tells the linker to search for libraries in a specified directory before
searching the standard directories.
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libdir

libs
list

list-line-len

list-page-len

logo

m

m32, m64 , Qm32 , Qmb64

m80387

map

map-opts, Qmap-opts

march

masm

mauto-arch, Qauto-arch

mbranches-within-32B-
boundaries, Qbranches-
within-32B-boundaries
mcmodel

mconditional-branch,
Qconditional-branch

MD

minstruction, Qinstruction

mno-gather, Qgather-

mno-scatter, Qscatter-

module

Controls whether linker options for search libraries are included in object
files generated by the compiler.

Tells the compiler which type of runtime library to link to.
Tells the compiler to create a listing of the source file.

Specifies the line length for the listing generated when option list is
specified.

Specifies the page length for the listing generated when option list is
specified.

Displays the compiler version information.

Tells the compiler which features it may target, including which
instruction set architecture (ISA) it may generate.

Tells the compiler to generate code for a specific architecture. Option m32
(and /Qm32) is deprecated and will be removed in a future release. 32-
bit options are only available for ifort.

Specifies whether the compiler can use x87 instructions.
Tells the linker to generate a link map file.

Maps one or more compiler options to their equivalent on a different
operating system. This feature is only available for ifort.

Tells the compiler to generate code for processors that support certain
features.

Tells the compiler to generate the assembler output file using a selected
dialect.

Tells the compiler to generate multiple, feature-specific auto-dispatch
code paths for x86 architecture processors if there is a performance
benefit.

Tells the compiler to align branches and fused branches on 32-byte
boundaries for better performance.

Tells the compiler to use a specific memory model to generate code and
store data.

Lets you identify and fix code that may be vulnerable to speculative
execution side-channel attacks, which can leak your secure data as a
result of bad speculation of a conditional branch direction. This feature is
only available for ifort.

Tells the linker to search for unresolved references in a multithreaded,
dynamic-link runtime library.

Determines whether MOVBE instructions are generated for certain Intel®
processors. This feature is only available for ifort.

Disables the generation of gather instructions in auto-vectorization. This
feature is only available for ifx.

Disables the generation of scatter instructions in auto-vectorization. This
feature is only available for ifx.

Specifies the directory where module files should be placed when created
and where they should be searched for.
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momit-leaf-frame-pointer

mp1l, Qprec

mstringop-inline-threshold,

Qstringop-inline-threshold

mstringop-strategy,
Qstringop-strategy

MT

mtune, tune

multiple-processes , MP

names

no-bss-init, Qnobss-init

nodefaultlibs

nofor-main

no-intel-lib, Qno-intel-lib
nolib-inline

nolibsycl

nostartfiles

nostdlib

(0]

o
object
Od
Ofast
Os

Ot

pad, Qpad

pad-source, Qpad-source
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Determines whether the frame pointer is omitted or kept in leaf functions.

Improves floating-point precision and consistency. This feature is only
available for ifort.

Tells the compiler to not inline calls to buffer manipulation functions such
as memcpy and memset when the number of bytes the functions handle
are known at compile time and greater than the specified value. This
feature is only available for ifort.

Lets you override the internal decision heuristic for the particular
algorithm used when implementing buffer manipulation functions such as
memcpy and memset. This feature is only available for ifort.

Tells the linker to search for unresolved references in a multithreaded,
static runtime library.

Performs optimizations for specific processors but does not cause
extended instruction sets to be used (unlike -march).

Creates multiple processes that can be used to compile large numbers of
source files at the same time.

Specifies how source code identifiers and external names are interpreted.

Tells the compiler to place in the DATA section any uninitialized variables
and explicitly zero-initialized variables. This option is deprecated and will
be removed in a future release. This feature is only available for ifort.

Prevents the compiler from using standard libraries when linking.
Specifies that the main program is not written in Fortran.

Disables linking to specified Intel® libraries, or to all Intel® libraries.
Disables inline expansion of standard library or intrinsic functions.

Disables linking of the SYCL* runtime library. This feature is only
available for ifx.

Prevents the compiler from using standard startup files when linking.

Prevents the compiler from using standard libraries and startup files when
linking.

Specifies the code optimization for applications.

Specifies the name for an output file.

Specifies the name for an object file.

Disables all optimizations.

Sets certain aggressive options to improve the speed of your application.

Enables optimizations that do not increase code size; it produces smaller
code size than O2.

Enables all speed optimizations.

Compiles and links for function profiling with gprof(1). This feature is only
available for ifort.

Enables the changing of the variable and array memory layout.

Specifies padding for fixed-form source records.
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par-affinity, Qpar-affinity

parallel, Qparallel (ifort only)

parallel, Qparallel (ifx only)

parallel-source-info,
Qparallel-source-info

par-num-threads, Qpar-num-
threads

par-runtime-control, Qpar-
runtime-control

par-schedule, Qpar-schedule

par-threshold, Qpar-threshold

pc, Qpc
pdbfile

pie

prec-div, Qprec-div

prec-sqrt, Qprec-sqrt

preprocess-only
print-multi-lib

prof-data-order, Qprof-data-
order

prof-dir, Qprof-dir

prof-file, Qprof-file
prof-func-groups
prof-func-order, Qprof-func-
order

prof-gen, Qprof-gen
prof-hotness-threshold,

Qprof-hotness-threshold

prof-src-dir, Qprof-src-dir

Specifies thread affinity. This feature is only available for ifort.

Tells the auto-parallelizer to generate multithreaded code for loops that
can be safely executed in parallel. This description is only for ifort.

Tells the compiler to attempt to generate multithreaded code for DO
CONCURRENT loops. This description is only for ifx.

Enables or disables source location emission when OpenMP* or auto-
parallelism code is generated.

Specifies the number of threads to use in a parallel region. This feature is
only available for ifort.

Generates code to perform runtime checks for loops that have symbolic
loop bounds. This feature is only available for ifort.

Lets you specify a scheduling algorithm for loop iterations. This feature is
only available for ifort.

Sets a threshold for the auto-parallelization of loops. This feature is only
available for ifort.

Enables control of floating-point significand precision.

Lets you specify the name for a program database (PDB) file created by
the linker. This feature is only available for ifort.

Determines whether the compiler generates position-independent code
that will be linked into an executable.

Improves precision of floating-point divides.

Improves precision of square root implementations. This feature is only
available for ifort.

Causes the Fortran preprocessor to send output to a file.
Prints information about where system libraries should be found.

Enables or disables data ordering if profiling information is enabled. This
feature is only available for ifort.

Specifies a directory for profiling information output files. This feature is
only available for ifort.

Specifies an alternate file name for the profiling summary files. This
feature is only available for ifort.

Enables or disables function grouping if profiling information is enabled.
This feature is only available for ifort.

Enables or disables function ordering if profiling information is enabled.
This feature is only available for ifort.

Produces an instrumented object file that can be used in profile guided
optimization. This feature is only available for ifort.

Lets you set the hotness threshold for function grouping and function
ordering. This feature is only available for ifort.

Determines whether directory information of the source file under
compilation is considered when looking up profile data records. This
feature is only available for ifort.
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prof-src-root, Qprof-src-root

prof-src-root-cwd, Qprof-src-

root-cwd

prof-use, Qprof-use
prof-value-profiling, Qprof-
value-profiling

pthread

Qcov-dir

Qcov-file

Qcov-gen

Qinline-dllimport

Qinstall

Qlocation

gmkl, Qmkl

gmkl-ilp64, Qmkl-ilp64

gmkl-sycl-impl, Qmkl-sycl-
impl

qopenmp, Qopenmp

gopenmp-lib, Qopenmp-lib
gopenmp-link
gopenmp-simd, Qopenmp-
simd

gopenmp-stubs, Qopenmp-
stubs

gopenmp-threadprivate,
Qopenmp-threadprivate
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Lets you use relative directory paths when looking up profile data and
specifies a directory as the base. This feature is only available for ifort.

Lets you use relative directory paths when looking up profile data and
specifies the current working directory as the base. This feature is only
available for ifort.

Enables the use of profiling information during optimization. This feature
is only available for ifort.

Controls which values are value profiled. This feature is only available for
ifort.

Tells the compiler to use pthreads library for multithreading support.

Specifies a directory for profiling information output files that can be used
with the codecov or tselect tool. This feature is only available for ifort.

Specifies an alternate file name for the profiling summary files that can
be used with the codecov or tselect tool. This feature is only available for
ifort.

Produces an instrumented object file that can be used with the codecov
or tselect tool. This feature is only available for ifort.

Determines whether dllimport functions are inlined. This feature is only
available for ifort.

Specifies the root directory where the compiler installation was
performed.

Specifies the directory for supporting tools.

Tells the compiler to link to certain libraries in the Intel® oneAPI Math
Kernel Library ( oneMKL ). On Windows systems, you must specify this
option at compile time.

Tells the compiler to link to the ILP64-specific version of the Intel® oneAPI
Math Kernel Library ( oneMKL). On Windows systems, you must specify
this option at compile time.

Lets you link to one or more specific Intel® oneAPI Math Kernel (oneMKL)
SYCL libraries. This feature is only available for ifx

You can substitute the option named -qopenmp for option -fopenmp or -
fiopenmp (ifx), and you can substitute the option named /Qopenmp for
option /Qiopenmp (ifx).

Lets you specify an OpenMP* runtime library to use for linking. This
feature is only available for ifort.

Controls whether the compiler links to static or dynamic OpenMP*
runtime libraries.
Enables or disables OpenMP* SIMD compilation.

Enables compilation of OpenMP* programs in sequential mode.

Lets you specify an OpenMP* threadprivate implementation.
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qgopt-args-in-regs, Qopt-args-
in-regs

gopt-assume-safe-padding,
Qopt-assume-safe-padding

qopt-block-factor, Qopt-block-
factor

gopt-dynamic-align, Qopt-
dynamic-align

gopt-for-throughput, Qopt-
for-throughput
Qoption

gopt-jump-tables, Qopt-
jump-tables

qopt-malloc-options

gopt-matmul, Qopt-matmul

qgopt-mem-layout-trans,
Qopt-mem-layout-trans

gopt-multiple-gather-scatter-
by-shuffles, Qopt-multiple-
gather-scatter-by-shuffles

qgopt-multi-version-
aggressive, Qopt-multi-
version-aggressive

qopt-prefetch, Qopt-prefetch

qopt-prefetch-distance, Qopt-
prefetch-distance (ifort only)

qopt-prefetch-distance, Qopt-
prefetch-distance (ifx only)

qopt-prefetch-issue-excl-hint,
Qopt-prefetch-issue-excl-hint

qgopt-prefetch-loads-only, /
Qopt-prefetch-loads-only

gopt-ra-region-strategy,
Qopt-ra-region-strategy
qopt-report, Qopt-report (ifort
only)

qopt-report, Qopt-report (ifx
only)

Determines whether calls to routines are optimized by passing arguments
in registers instead of on the stack. This option is deprecated and will be
removed in a future release. This feature is only available for ifort.

Determines whether the compiler assumes that variables and dynamically
allocated memory are padded past the end of the object. This feature is
only available for ifort.

Lets you specify a loop blocking factor. This feature is only available for
ifort.

Enables or disables dynamic data alignment optimizations.

Determines how the compiler optimizes for throughput depending on
whether the program is to run in single-job or multi-job mode. This
feature is only available for ifx.

Passes options to a specified tool.

Enables or disables generation of jump tables for switch statements. This
feature is only available for ifort.

Lets you specify an alternate algorithm for malloc(). This feature is only
available for ifort.

Enables or disables a compiler-generated Matrix Multiply (matmul) library
call.

Controls the level of memory layout transformations performed by the
compiler.

Enables or disables the optimization for multiple adjacent gather/scatter
type vector memory references.

Tells the compiler to use aggressive multi-versioning to check for pointer
aliasing and scalar replacement. This feature is only available for ifort.

Enables or disables prefetch insertion optimization.

Specifies the prefetch distance to be used for compiler-generated
prefetches inside loops. This description is only for ifort.

Specifies the prefetch distance to be used for compiler-generated
prefetches inside loops. This description is only for ifx.

Supports the prefetchW instruction in Intel® microarchitecture code name
Broadwell and later. This feature is only available for ifort.

Specifies that the compiler should only prefetch for loads inside the loop
and ignore the stores, if any. This feature is only available for ifx.

Selects the method that the register allocator uses to partition each
routine into regions. This feature is only available for ifort.

Tells the compiler to generate an optimization report. This description is
only for ifort.

Enables the generation of a YAML file that includes optimization
transformation information. This description is only for ifx.
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gopt-report-annotate, Qopt-
report-annotate

qgopt-report-annotate-
position, Qopt-report-
annotate-position
qopt-report-embed, Qopt-
report-embed
qopt-report-file, Qopt-report-
file

qopt-report-filter, Qopt-
report-filter
qgopt-report-format, Qopt-
report-format
qopt-report-help, Qopt-
report-help
gopt-report-names, Qopt-
report-names
qgopt-report-per-object, Qopt-
report-per-object
qopt-report-phase, Qopt-
report-phase
qgopt-report-routine, Qopt-
report-routine
qopt-report-stdout, Qopt-
report-stdout

gopt-streaming-stores, Qopt-
streaming-stores

qgopt-subscript-in-range,
Qopt-subscript-in-range
gopt-zmm-usage, Qopt-zmm-
usage

qoverride-limits, Qoverride-
limits

Qpar-adjust-stack

Qpatchable-addresses

Qsfalign
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Enables the annotated source listing feature and specifies its format. This
feature is only available for ifort.

Enables the annotated source listing feature and specifies the site where
optimization messages appear in the annotated source in inlined cases of
loop optimizations. This feature is only available for ifort.

Determines whether special loop information annotations will be
embedded in the object file and/or the assembly file when it is generated.
This feature is only available for ifort.

Specifies whether the output for the generated optimization report goes
to a file, stderr, or stdout.

Tells the compiler to find the indicated parts of your application, and
generate optimization reports for those parts of your application. This
feature is only available for ifort.

Specifies the format for an optimization report. This feature is only
available for ifort.

Displays the optimizer phases available for report generation and a short
description of what is reported at each level. This feature is only available
for ifort.

Specifies whether mangled or unmangled names should appear in the
optimization report. This feature is only available for ifort.

Tells the compiler that optimization report information should be
generated in a separate file for each object. This feature is only available
for ifort.

Specifies one or more optimizer phases for which optimization reports are
generated. This feature is only available for ifort.

Tells the compiler to generate an optimization report for each of the
routines whose names contain the specified substring. This feature is only
available for ifort.

Specifies that the generated report should go to stdout.

Enables generation of streaming stores for optimization.

Determines whether the compiler assumes that there are no "large"
integers being used or being computed inside loops. This feature is only
available for ifort.

Defines a level of zmm registers usage.

Lets you override certain internal compiler limits that are intended to
prevent excessive memory usage or compile times for very large,
complex compilation units.

Tells the compiler to generate code to adjust the stack size for a fiber-
based main thread. This feature is only available for ifort.

Tells the compiler to generate code such that references to statically
assigned addresses can be patched. This feature is only available for ifort.

Specifies stack alignment for functions. This option is deprecated and will
be removed in a future release. This feature is only available for ifort.
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gsimd-honor-fp-model,
Qsimd-honor-fp-model

gsimd-serialize-fp-reduction,
Qsimd-serialize-fp-reduction

Quse-msasm-symbols

Qvc

rcd, Qred

real-size

recursive

reentrancy

S

safe-cray-ptr, Qsafe-cray-ptr
save, Qsave

save-temps , Qsave-temps

scalar-rep, Qscalar-rep

shared

shared-intel
shared-libgcc
show

simd, Qsimd

SOX

stand

standard-realloc-lhs

standard-semantics

static

static-intel

Tells the compiler to obey the selected floating-point model when
vectorizing SIMD loops. This feature is only available for ifort.

Tells the compiler to serialize floating-point reduction when vectorizing
SIMD loops. This feature is only available for ifort.

Tells the compiler to use a dollar sign ("$") when producing symbol
names. This feature is only available for ifort.

Specifies which version of Microsoft Visual C++* (MSVC) or Microsoft
Visual Studio* that the compiler should link to. This feature is only
available for ifort.

Enables fast float-to-integer conversions. This is a deprecated option.
There is no replacement option. This feature is only available for ifort.

Specifies the default KIND for real and complex declarations, constants,
functions, and intrinsics.

Tells the compiler that all routines should be compiled for possible
recursive execution.

Tells the compiler to generate reentrant code to support a multithreaded
application.

Causes the compiler to compile to an assembly file only and not link.
Tells the compiler that Cray* pointers do not alias other variables.
Causes variables to be placed in static memory.

Tells the compiler to save intermediate files created during compilation.

Enables or disables the scalar replacement optimization done by the
compiler as part of loop transformations. This feature is only available for
ifort.

Tells the compiler to produce a dynamic shared object instead of an
executable.

Causes Intel-provided libraries to be linked in dynamically.
Links the GNU libgcc library dynamically.
Controls the contents of the listing generated when option list is specified.

Enables or disables compiler interpretation of SIMD directives. This
feature is only available for ifort.

Tells the compiler to save the compilation options and version humber in
the executable file. It also lets you choose whether to include lists of
certain routines.

Tells the compiler to issue compile-time messages for nonstandard
language elements.

Determines whether the compiler uses the current Fortran Standard rules
or the old Fortran 2003 rules when interpreting assignment statements.

Determines whether the current Fortran Standard behavior of the
compiler is fully implemented.

Prevents linking with shared libraries.

Causes Intel-provided libraries to be linked in statically.
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static-libgcc
static-libstdc++
syntax-only
sysroot

-

tcollect, Qtcollect

tcollect-filter, Qtcollect-filter

Tf

threads

traceback

U

u (Windows*)
undef

unroll, Qunroll

unroll-aggressive, Qunroll-
aggressive

use-asm, Quse-asm

v
vec, Qvec

vec-guard-write, Qvec-guard-
write

vec-threshold, Qvec-threshold

vecabi, Qvecabi (ifort only)

vecabi, Qvecabi (ifx only)

vms

warn

watch
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Links the GNU libgcc library statically.

Links the GNU libstdc++ library statically.

Tells the compiler to check only for correct syntax.

Specifies the root directory where headers and libraries are located.
Tells the linker to read link commands from a file.

Inserts instrumentation probes calling the Intel® Trace Collector API. This
feature is only available for ifort.

Lets you enable or disable the instrumentation of specified functions. You
must also specify option [Q]tcollect. This feature is only available for ifort.

Tells the compiler to compile the file as a Fortran source file.

Tells the linker to search for unresolved references in a multithreaded
runtime library.

Tells the compiler to generate extra information in the object file to
provide source file traceback information when a severe error occurs at
runtime.

Undefines any definition currently in effect for the specified symbol .
Undefines all previously defined preprocessor values.

Disables all predefined symbols .

Tells the compiler the maximum number of times to unroll loops.

Determines whether the compiler uses more aggressive unrolling for
certain loops. This feature is only available for ifort.

Tells the compiler to produce objects through the assembler. This is a
deprecated option. There is no replacement option. This feature is only
available for ifort.

Specifies that driver tool commands should be displayed and executed.
Enables or disables vectorization.

Tells the compiler to perform a conditional check in a vectorized loop. This
feature is only available for ifort.

Sets a threshold for the vectorization of loops.

Determines which vector function application binary interface (ABI) the
compiler uses to create or call vector functions. This description is only
for ifort.

Determines which vector function application binary interface (ABI) the
compiler uses to create or call vector functions. This description is only
for ifx.

Causes the runtime system to behave like HP* Fortran on OpenVMS*
Alpha systems and VAX* systems (VAX FORTRAN*).

Passes options to the assembler for processing.
Specifies diagnostic messages to be issued by the compiler.

Tells the compiler to display certain information to the console output
window.
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WB Turns a compile-time bounds check into a warning.
what Tells the compiler to display its detailed version string.
winapp Tells the compiler to create a graphics or Fortran Windows application and

link against the most commonly used libraries.

Winline Warns when a function that is declared as inline is not inlined. This
feature is only available for ifort.

WI, link Passes options to the linker for processing.

Wp Passes options to the preprocessor.

wrap-margin Provides a way to disable the right margin wrapping that occurs in
Fortran list-directed output.

X Removes standard directories from the include file search path.

X, Qx Tells the compiler which processor features it may target, including which
instruction sets and optimizations it may generate.

xHost, QxHost Tells the compiler to generate instructions for the highest instruction set
available on the compilation host processor.

Xlinker Passes a linker option directly to the linker.

Xopenmp-target Enables options to be passed to the specified tool in the device

compilation tool chain for the OpenMP* target. This feature is only
available for ifx.

Xsycl-target Enables options to be passed to the specified tool in the device
compilation tool chain for the SYCL* target. This feature is only available
for ifx.

zero, Qzero Initializes to zero variables of intrinsic type INTEGER, REAL, COMPLEX, or

LOGICAL that are not yet initialized. This is a deprecated option. The
replacement option is /Qinit:[no]zero or -init=[no]zero.

Zi, Z7 Tells the compiler to generate full debugging information in either an
object (.obj) file or a project database (PDB) file.

Zo Enables or disables generation of enhanced debugging information for
optimized code. This feature is only available for ifort.

General Rules for Compiler Options

This section describes general rules for compiler options and it contains information about how we refer to
compiler option names in descriptions.

Compiler options may be case sensitive, and may have different meanings depending on their case. For
example, option c prevents linking, but option C checks for certain conditions at runtime.

Options specified on the command line apply to all files named on the command line.

Options can take arguments in the form of file names, strings, letters, or numbers. If a string includes
spaces, the string must be enclosed in quotation marks.

Compiler options can appear in any order.

Unless you specify certain options, the command line will both compile and link the files you specify.
You can abbreviate some option names, entering as many characters as are needed to uniquely identify
the option.

Certain options accept one or more keyword arguments following the option name. For example,
architecture option x option accepts several keywords.

To specify multiple keywords, you typically specify the option multiple times.
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e To disable an option, specify the negative form of the option if one exists.

e If there are enabling and disabling versions of an option on the command line, the last one on the
command line takes precedence.

e Compiler options remain in effect for the whole compilation unless overridden by a compiler directive.

e Linux

You cannot combine options with a single dash. For example, this form is incorrect: -Ec; this form is
correct: -E -c
e Windows

You cannot combine options with a single slash. For example: This form is incorrect: /Ec; this form is
correct: /E /c
e All compiler options must precede /1ink options, if any, on the command line.
e Compiler options remain in effect for the whole compilation unless overridden by a compiler directive.
e You can sometimes use a comma to separate keywords. For example, the following is valid:

ifx /warn:usage,declarations test.f90
e You can disable one or more optimization options by specifying option /0d last on the command line.

NOTE

The /0d option is part of a mutually-exclusive group of options that includes /04, /01, /02, /03,
and /0x. The last of any of these options specified on the command line will override the previous
options from this group.

How We Refer to Compiler Option Names in Descriptions
Within documentation, compiler option names that are very different are spelled out in full.

However, many compiler option names are very similar except for initial characters. For these options, we
use the following shortcuts when referencing their names in descriptions:

¢ No initial - or/

This shortcut is used for option names that are the same for Linux and Windows except for the initial
character.

For example, Fa denotes:

e Linux: -Fa
e Windows: /Fa

¢ [Q]option-name
This shortcut is used for option names that only differ because the Windows form starts with a Q.
For example, [Q]ipo denotes:

e Linux: -ipo
e Windows: /Qipo

e [q or Q]option-name

This shortcut is used for option names that only differ because the Linux form starts with a q and the
Windows form starts with a Q.

For example, [g or Q]opt-report denotes:

e Linux: —gopt-report
e Windows: /Qopt-report
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What Appears in the Compiler Option Descriptions
This section contains details about what appears in the option descriptions.

Following sections include individual descriptions of all the current compiler options. The option descriptions
are arranged by functional category. Within each category, the option names are listed in alphabetical order.

Each option description contains the following information:

e The primary name for the option and a short description of the option.

e Syntax: This section shows the syntax on Linux systems and the syntax on Windows systems. If the
option is not valid on a particular operating system, it will specify None.

e Arguments: This section shows any arguments (parameters) that are related to the option. If the option
has no arguments, it will specify None.

e Default: This section shows the default setting for the option.

e Description: This section shows the full description of the option. It may also include further information
on any applicable arguments.

e IDE Equivalent: This section shows information related to the Intel® Integrated Development Environment
(Intel® IDE) Property Pages on Linux and Windows systems. It shows on which Property Page the option
appears, and under what category it's listed. The Windows IDE is Microsoft Visual Studio .NET. If the
option has no IDE equivalent, it will specify None. Note that in this release, there is no IDE support for
Fortran on Linux.

e Alternate Options (does not apply to SYCL): This section lists any options that are synonyms for the
described option. If there are no alternate option names, it will show None. Some alternate option names
are deprecated and may be removed in future releases. Many options have an older spelling where
underscores ("_") instead of hyphens ("-") connect the main option names. The older spelling is a valid
alternate option name.

Some option descriptions may also have the following:

e Example (or Examples): This section shows one or more examples that demonstrate the option.
e See Also: This section shows where you can get further information on the option or it shows related
options.

Optimization Options

This section contains descriptions for compiler options that pertain to optimization. They are listed in
alphabetical order.

falias, Oa

Specifies whether or not a procedure call may have
hidden aliases of local variables not supplied as actual
arguments.

Syntax
Linux OS:
-falias
-fno-alias
Windows OS:
/Oa

/Oa-

Arguments

None
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Default

—frno-alias Procedure calls do not alias local variables.
or /Oa-

Description

This option specifies whether or not the compiler can assume that during a procedure call, local variables in
the caller that are not present in the actual argument list and not visible by host association, are not
referenced or redefined due to hidden aliasing. The Fortran standard generally prohibits such aliasing.

If you specify -falias (Linux*) or /0a (Windows*), aliasing during a procedure call is assumed; this can
possibly affect performance.

If you specify -fno-alias or /0Oa- (the default), aliasing during a procedure call is not assumed.

IDE Equivalent

None

Alternate Options

None

See Also
ffnalias compiler option

fast
Maximizes speed across the entire program.

Syntax
Linux OS:

-fast
Windows OS:

/fast

Arguments

None
Default

OFF The optimizations that maximize speed are not enabled.

Description

This option maximizes speed across the entire program.
Linux

On ifx, it sets the following options:

-ipo, -03, -static, -fp-model fast

On ifort, it sets the following options:

-ipo, -03, -no-prec-div,-static, -fp-model fast=2, and -xHost
Windows

On ifx, it sets the following options:
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/03, /Qipo, /fp:fast
On ifort, it sets the following options:
/03, /Qipo, /Qprec-div-, /fp:fast=2, and /QxHost

On ifort, when option fast is specified, you can override the [Q] xHost option setting by specifying a
different processor-specific [Q]x option on the command line. However, the last option specified on the
command line takes precedence.

For example (all are ifort examples):
Linux

If you specify option -fast -xSSE3, option -xSSE3 takes effect. However, if you specify -xSSE3 -fast,
option -xHost takes effect.

Windows

If you specify option /fast /QxSSE3, option/0xSSE3 takes effect. However, if you specify /QxSSE3 /fast,
option /QxHost takes effect.

On ifort, for implications on non-Intel processors, refer to the [Q] xHost documentation.

NOTE

Option fast sets some aggressive optimizations that may not be appropriate for all
applications. The resulting executable may not run on processor types different from the one
on which you compile. You should make sure that you understand the individual
optimization options that are enabled by option fast.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also
fp-model, fp compiler option
XHost, QxHost

compiler option

X, QX

compiler option
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ffnalias, Ow

Determines whether aliasing is assumed within
functions. This feature is only available for ifort.

Syntax

Linux OS:
-ffnalias
-fno-fnalias
Windows OS:
/0w

/Ow-

Arguments

None
Default

—ffnalias Aliasing is assumed within functions.
or /0w

Description
This option determines whether aliasing is assumed within functions.

If you specify -fno-fnalias or /Ow-, aliasing is not assumed within functions, but it is assumed across
calls.

If you specify -ffnalias or /Ow, aliasing is assumed within functions.

IDE Equivalent

None

Alternate Options

None
See Also
falias compiler option

foptimize-sibling-calls
Determines whether the compiler optimizes tail
recursive calls.

Syntax

Linux OS:
-foptimize-sibling-calls
-fno-optimize-sibling-calls
Windows OS:

None

Arguments

None
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Default

~foptimize-sibling-calls The compiler optimizes tail recursive calls.

Description

This option determines whether the compiler optimizes tail recursive calls. It enables conversion of tail
recursion into loops.

If you do not want to optimize tail recursive calls, specify -fno-optimize-sibling-calls.

Tail recursion is a special form of recursion that doesn't use stack space. In tail recursion, a recursive call is
converted to a GOTO statement that returns to the beginning of the function. In this case, the return value of
the recursive call is only used to be returned. It is not used in another expression. The recursive function is
converted into a loop, which prevents modification of the stack space used.

IDE Equivalent

None

Alternate Options

None

fprotect-parens, Qprotect-parens
Determines whether the optimizer honors parentheses
when floating-point expressions are evaluated.

Syntax

Linux OS:
—-fprotect-parens
-fno-protect-parens

Windows OS:
/Qprotect-parens

/Qprotect-parens-
Arguments
None

Default

Parentheses are ignored when determining the order of expression
evaluation.

-fno-protect-parens
or /Qprotect-parens-

Description

This option determines whether the optimizer honors parentheses when determining the order of floating-
point expression evaluation.

When option -fprotect-parens (Linux*) or /Qprotect-parens (Windows*) is specified, the optimizer will
maintain the order of evaluation imposed by parentheses in the code.

When option -fno-protect-parens (Linux*) or /Qprotect-parens- (Windows¥*) is specified, the
optimizer may reorder floating-point expressions without regard for parentheses if it produces faster
executing code.
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IDE Equivalent

None

Alternate Options
Linux: -assume protect parens

Windows: /assume:protect parens

Example

Consider the following expression:
A+ (B+C)

By default, the parentheses are ignored and the compiler is free to re-order the floating-point operations
based on the optimization level, the setting of option -fp-model (Linux*) or /fp (Windows*), etc. to
produce faster code. Code that is sensitive to the order of operations may produce different results (such as
with some floating-point computations).

However, if -fprotect-parens (Linux*) or /Qprotect-parens (Windows*) is specified, parentheses
around floating-point expressions (including complex floating-point and decimal floating-point) are honored

and the expression will be interpreted following the normal precedence rules, that is, B+C will be computed
first and then added to A.

This may produce slower code than when parentheses are ignored. If floating-point sensitivity is a specific
concern, you should use option —-fp-model precise (Linux*) or /fp:precise (Windows*) to ensure
precision because it controls all optimizations that may affect precision.

See Also
fp-model, fp compiler option

GF
Enables read-only string-pooling optimization.

Syntax
Linux OS:

None

Windows OS:
/GF

Arguments

None
Default

OFF Read/write string-pooling optimization is enabled.

Description

This option enables read only string-pooling optimization.

IDE Equivalent

None
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Alternate Options

None

nolib-inline
Disables inline expansion of standard library or
intrinsic functions.

Syntax

Linux OS:

-nolib-inline

Windows OS:

None

Arguments

None

Default

OFF The compiler inlines many standard library and intrinsic functions.
Description

This option disables inline expansion of standard library or intrinsic functions. It prevents the unexpected
results that can arise from inline expansion of these functions.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

(0]
Specifies the code optimization for applications.

Syntax
Linux OS:
-0[n]
Windows OS:
/0[n]
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Arguments

n Is the optimization level. Possible values are 1, 2, or 3. On Linux*
systems, you can also specify 0.

Default

02 Optimizes for code speed.

However, on Linux* systems, if option -g is specified, the default is -00 unless option -02 (or
higher) is also explicitly specified in the command line.

Description

This option specifies the code optimization for applications.

Option Description
O (Linux*) This is the same as specifying 02.
00 (Linux) Disables all optimizations.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

This option causes certain warn options to be ignored. This is the default
if you specify option —-debug (with no keyword).

01 Enables optimizations for speed and disables some optimizations that
increase code size and affect speed.
To limit code size, this option:

* Enables global optimization; this includes data-flow analysis, code
motion, strength reduction and test replacement, split-lifetime
analysis, and instruction scheduling.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

The 01 option may improve performance for applications with very large
code size, many branches, and execution time not dominated by code
within loops.

02 Enables optimizations for speed. This is the generally recommended
optimization level.
Vectorization is enabled at 02 and higher levels.

On ifort systems using IA-32 architecture: Some basic loop optimizations
such as Distribution, Predicate Opt, Interchange, multi-versioning, and
scalar replacements are performed.

This option also enables:

¢ Inlining of intrinsics

e Intra-file interprocedural optimization, which includes:
e inlining
e constant propagation
o forward substitution
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Option

Description

03

e routine attribute propagation
variable address-taken analysis
e dead static function elimination
e removal of unreferenced variables
 The following capabilities for performance gain:

e constant propagation

e copy propagation

e dead-code elimination

e global register allocation

e global instruction scheduling and control speculation
e loop unrolling

e optimized code selection

e partial redundancy elimination

e strength reduction/induction variable simplification
e variable renaming

¢ exception handling optimizations

e tail recursions

e peephole optimizations

e structure assignment lowering and optimizations

e dead store elimination

This option may set other options, especially options that optimize for
code speed. This is determined by the compiler, depending on which
operating system and architecture you are using. The options that are set
may change from release to release.

On Windows* systems, this option is the same as the 0Ox option.

On Linux systems, the -debug inline-debug-info option will be
enabled by default if you compile with optimizations (option -02 or
higher) and debugging is enabled (option -g).

Many routines in the shared libraries are more highly optimized for Intel®
microprocessors than for non-Intel microprocessors.

Performs 02 optimizations and enables more aggressive loop
transformations such as Fusion, Block-Unroll-and-Jam, and collapsing IF
statements.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

When 03 is used with options -ax or -x (Linux) or with options /Qax

or /0x (Windows), the compiler performs more aggressive data
dependency analysis than for 02, which may result in longer compilation
times.

The 03 optimizations may not cause higher performance unless loop and
memory access transformations take place. The optimizations may slow
down code in some cases compared to 02 optimizations.

The 03 option is recommended for applications that have loops that
heavily use floating-point calculations and process large data sets.
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Option Description

Many routines in the shared libraries are more highly optimized for Intel®
microprocessors than for non-Intel microprocessors.

The last 0 option specified on the command line takes precedence over any others.
IDE Equivalent

Windows

Visual Studio: General > Optimization (/0d, /01, /02, /03, /fast)
Optimization > Optimization (/0d, /01, /02, /03, /fast)

Alternate Options

02 Linux: None
Windows: /0x

See Also

od compiler option
fltconsistency compiler option
fast compiler option

od
Disables all optimizations.

Syntax
Linux OS:

None

Windows OS:
/0d

Arguments
None

Default

OFF The compiler performs default optimizations.

Description

This option disables all optimizations. It can be used for selective optimizations, such as a combination of /0d
and /0b1l (disables all optimizations, but enables inlining).

This option also causes certain /warn options to be ignored.

ifort only: On IA-32 architecture, this option sets the /0y- option.
IDE Equivalent

Windows

Visual Studio: Optimization > Optimization
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Alternate Options
Linux: -00

Windows: /optimize:0

See Also
o compiler option (see 00)

Ofast

Sets certain aggressive options to improve the speed
of your application.

Syntax
Linux OS:
-Ofast
Windows OS:

None

Arguments
None
Default

OFF The aggressive optimizations that improve speed are not enabled.

Description
This option improves the speed of your application.
It sets compiler options -03, -no-prec-div, and -fp-model fast=2.

This option is provided for compatibility with gcc.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

See Also

0 compiler option

prec-div, Qprec-div compiler option
fast compiler option

fp-model, fp compiler option
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Os

Enables optimizations that do not increase code size;
it produces smaller code size than O2.

Syntax
Linux OS:
-Os
Windows OS:
/0s

Arguments

None
Default

OFF Optimizations are made for code speed. However, if O1 is specified, Os is the default.

Description

This option enables optimizations that do not increase code size; it produces smaller code size than 02. It
disables some optimizations that increase code size for a small speed benefit.

This option tells the compiler to favor transformations that reduce code size over transformations that
produce maximum performance.

IDE Equivalent

Visual Studio
Visual Studio: Optimization > Favor Size or Speed

Alternate Options

None

See Also
o compiler option
ot compiler option

Ot
Enables all speed optimizations.

Syntax
Linux OS:

None

Windows OS:
/0t

Arguments

None
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Default
/ot Optimizations are made for code speed.

If od is specified, all optimizations are disabled. If 01 is specified, Os is the default.
Description

This option enables all speed optimizations.
IDE Equivalent

Windows

Visual Studio: Optimization > Favor Size or Speed (/0t, /Os)

Alternate Options

None

See Also
0 compiler option
0s compiler option

Advanced Optimization Options

This section contains descriptions for compiler options that pertain to advanced optimization. They are listed
in alphabetical order.

ansi-alias, Qansi-alias
Tells the compiler to assume certain rules of the
Fortran standard regarding aliasing and array bounds.

Syntax

Linux OS:
-ansi-alias
-no-ansi-alias
Windows OS:
/Qansi-alias

/Qansi-alias-

Arguments

None
Default

—ansi-alias Programs adhere to the Fortran standard's rules regarding aliasing and

or /Qansi-alias array bounds.

Description

This option tells the compiler to assume certain rules of the Fortran standard regarding aliasing and array
bounds.

It tells the compiler to assume that the program adheres to the following rules of the Fortran standard:
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e Arrays cannot be accessed outside of declared bounds.
e A dummy argument may have its definition status changed only through that dummy argument, unless it
has the TARGET attribute.

This option is similar to option assume nodummy aliases with the additional restriction on array bounds.

If -no-ansi-alias (Linux*) or /Qansi-alias- (Windows*) is specified, the compiler assumes that the
program might not follow the Fortran standard's rules regarding dummy argument aliasing and array
bounds; this can possibly affect performance.

IDE Equivalent

None
Alternate Options

None

See Also
assume compiler option, setting [no]Jdummy_aliases

coarray, Qcoarray
Enables the coarray feature.

Syntax
Linux OS:

—-coarray[=keyword]

Windows OS:
/Qcoarray|[: keyword]

Arguments
keyword Specifies the memory system where the coarrays will be implemented. Possible values are:
shared Indicates that multiple images will be created. This is the default.
single Indicates a configuration where the image does not contain self-
replication code. This results in an executable with a single running
image.
This configuration can be useful for debugging purposes, even though
there are no inter-image interactions.
Default
OFF Coarrays are not enabled unless you specify this option.
Description

This option enables the coarray features first introduced in the Fortran 2008 Standard. It enables any coarray
syntax in your program. If this option is not specified, coarray syntax is rejected.

It also tells the driver to link against appropriate libraries, and to create the appropriate executables.

Keywords can be specified multiple times; however, if keyword single is specified anywhere on the
command line, it takes precedence.
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You can specify option [Q]coarray-num-images to specify the default number of images that can be used
to run a coarray executable. If you do not specify that option, you get the number of execution units on the
current system.

You can specify the [Q]coarray-config-file option to specify the name of a Message Passing Interface
(MPI) configuration file.

Options [Q] coarray-num-images and [Q]coarray-config-file are valid for all keyword values.

NOTE
Coarrays are only supported on 64-bit architectures.

IDE Equivalent

Windows

Visual Studio: Language > Enable Coarrays

Alternate Options

None

Examples

The following command runs a coarray program using n images:
/Qcoarray /Qcoarray-num-images:n ! Windows systems
-coarray -coarray-num-images=n ! Linux systems
The following command runs a coarray program using the MPI configuration file specified by filename:
/Qcoarray /Qcoarray-config-file:filename ! Windows systems
-coarray -coarray-config-file=filename ! Linux systems
The following command illustrates precedence:
Linux* systems:

-coarray=single -coarray=shared ! single takes precedence; single always takes
precedence

Windows* systems:

/Qcoarray:single /Qcoarray:shared ! single takes precedence; single always takes
precedence

See Also

coarray-num-images, Qcoarray-num-images compiler option
coarray-config-file, Qcoarray-config-file compiler option
Coarrays

Using Coarrays

coarray-config-file, Qcoarray-config-file

Specifies the name of a Message Passing Interface
(MPI) configuration file.
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Syntax
Linux OS:

-coarray-config-file=filename

Windows OS:

/Qcoarray-config-file: filename

Arguments

filename Is the name of the MPI configuration file. You can specify a path.
Default

OFF When coarrays are enabled, the compiler uses default settings for MPI.

Description

This option specifies the name of a Message Passing Interface (MPI) configuration file. This file is used by the
compiler when coarrays are processed; it configures the MPI for multi-node operations.

This option has no affect unless you also specify the [Q]coarray option, which is required to create the
coarray executable.

Note that when a setting is specified in environment variable FOR_COARRAY_CONFIG_FILE, it overrides the
compiler option setting.

IDE Equivalent

Windows

Visual Studio: Language > MPI Configuration File

Alternate Options

None

See Also
coarray, Qcoarray compiler option

coarray-num-images, Qcoarray-num-images
Specifies the default number of images that can be
used to run a coarray executable.

Syntax
Linux OS:

-coarray-num-images=n
Windows OS:
/Qcoarray-num-images:n
Arguments

n Is the default number of images. The limit is determined from the system
configuration.
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Default
OFF The number of images is determined at runtime.
Description

This option specifies the default number of images that can be used to run a coarray executable.

This option has no affect unless you also specify the [Q] coarray option. This option is required to create the
coarray executable.

You can specify option [Q] coarray-num-images to specify the default number of images that can be used
to run a coarray executable. If you do not specify that option, you get the number of execution units on the
current system.

Note that when a setting is specified in environment variable FOR_COARRAY_NUM_IMAGES, it overrides the
compiler option setting.

IDE Equivalent

Windows

Visual Studio: Language > Coarray Images

Alternate Options

None

See Also
coarray, Qcoarray compiler option

complex-limited-range, Qcomplex-limited-range
Determines whether the use of basic algebraic
expansions of some arithmetic operations involving
data of type COMPLEX is enabled. This feature is only
available for ifort.

Syntax

Linux OS:
-complex-limited-range
-no-complex-limited-range
Windows OS:
/Qcomplex-limited-range
/Qcomplex-limited-range-
Arguments

None

Default

-no-complex-limited-range Basic algebraic expansions of some arithmetic operations

or /Qcomplex-limited-range- involving data of type COMPLEX are disabled.
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Description

This option determines whether the use of basic algebraic expansions of some arithmetic operations involving
data of type COMPLEX is enabled.

When the option is enabled, this can cause performance improvements in programs that use a lot of
COMPLEX arithmetic. However, values at the extremes of the exponent range may not compute correctly.

IDE Equivalent

Windows
Visual Studio: Floating point > Limit COMPLEX Range

Alternate Options

None

fvec-peel-loops, Qvec-peel-loops
Enables peel loop vectorization. This feature is only
available for ifx.

Syntax

Linux OS:
-fvec-peel-loops
-fno-vec-peel-loops
Windows OS:
/Qvec-peel-loops

/Qvec-peel-loops-

Arguments

None
Default

-fno-vec-peel-loops No peel loop vectorization occurs.

or /Qvec-peel-loops-

Description

This option enables vectorization of peeling loops created during loop vectorization. It causes the compiler to
perform additional steps to vectorize a peel loop that was created to improve alignment of memory
references in the main vectorized loop.

The peel loop can be vectorized only when the masked mode of vectorization is enabled by specifying option
-fvec-with-mask or /Qvec-with-mask.

The vectorization of a peel loop cannot be enforced because the compiler uses the cost model to determine
whether it should be done.

IDE Equivalent

None

Alternate Options

None
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See Also

fvec-with-mask, Qvec-with-mask compiler option

fvec-remainder-loops, Qvec-remainder-loops compiler option

fvec-remainder-loops, Qvec-remainder-loops
Enables remainder loop vectorization. This feature is

only available for ifx.

Syntax
Linux OS:

-fvec-remainder-loops

-fno-vec-remainder-loops

Windows OS:
/Qvec-remainder-loops

/Qvec-remainder-loops-—

Arguments

None

Default

-fno-vec-remainder-loops
or /Qvec-remainder-loops-—

Description

No remainder loop vectorization occurs.

This option enables vectorization of remainder loops created during loop vectorization. It causes the compiler
to perform additional steps to vectorize the remainder loop that was created for the vectorized main loop.

The compiler uses the cost model to determine vector factor and mode of vectorization for remainder loops.

The vectorization of remainder can be enforced using !DIR$ VECTOR VECREMAINDER on the loop.

IDE Equivalent

None

Alternate Options

None

See Also

fvec-vec-peel-loops, Qvec-peel-loops conpreropuon
fvec-with-mask, Qvec-with-mask compiler option

VECTOR directive

fvec-with-mask, Qvec-with-mask

Enables vectorization for short trip-count loops with
masking. This feature is only available for ifx.

Syntax
Linux OS:

-fvec-with-mask
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-fno-vec-with-mask
Windows OS:
/Qvec-with-mask

/Qvec-with-mask-

Arguments

None

Default

—fno-vec-with-mask No vectorization for short trip-count loops with masking occurs.

or /Qvec-with-mask-

Description

This option enables a special mode of vectorization, which is applicable for loops with small number of
iterations known at compile time. The peeling and remainder loops created during vectorization also fit into
this category.

In this mode, the compiler uses a vector factor that is the lowest power-of-two integer greater than the
known (maximum) number of loop iterations. Usually, such vectorized loops have one iteration with most of
operations masked.

IDE Equivalent

None

Alternate Options

None

See Also
fvec-vec-peel-loops, Qvec-peel-loops compiler option
fvec-remainder-loops, Qvec-remainder-loops compiler option

heap-arrays

Puts automatic arrays and arrays created for
temporary computations on the heap instead of the
stack.

Syntax
Linux OS:

-heap-arrays [size]
-no-heap-arrays
Windows OS:
/heap-arrays|[:size]
/heap-arrays-
Arguments

size Is an integer value representing the size of the arrays in kilobytes. Arrays smaller than size are
put on the stack.
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Default

-no-heap-arrays The compiler puts automatic arrays and temporary arrays in the stack storage

or /heap-arrays- area.

Description

This option puts automatic arrays and arrays created for temporary computations on the heap instead of the
stack.

If size is specified:

e Automatic (temporary) arrays that have a compile-time size greater than the value specified for size are
put on the heap, rather than on the stack. If the compiler cannot determine the size at compile time, it
puts the automatic array on the heap.

e The value is only used when the total size of the temporary array or automatic array can be determined at
compile time, using compile-time constants.

Any arrays known at compile-time to be larger than size are allocated on the heap instead of the stack. For
example, if 10 is specified for size:

e All automatic and temporary arrays equal to or larger than 10 KB are put on the heap.
e All automatic and temporary arrays smaller than 10 KB are put on the stack.

If size is omitted, and the size of the temporary array or automatic array cannot be determined at compile
time, it is assumed that the total size is greater than size and the array is allocated on the heap.

Linux
You can use the shell command unlimit to increase the size of the runtime stack before execution.
Windows

You can use compiler option /F to tell the linker to increase the size of the runtime stack to allow for large
objects on the stack.

IDE Equivalent

Windows

Visual Studio: Optimization > Heap Arrays

Alternate Options

None

Example

In Fortran, an automatic array gets its size from a runtime expression. In the following example, array X is
affected by the heap-array option; array Y is not:

RECURSIVE SUBROUTINE F( N )

INTEGER :: N

REAL :: X ( N ) ! an automatic array

REAL :: Y ( 1000 ) ! an explicit-shape local array on the stack

Temporary arrays are often created before making a routine call, or when an array operation detects overlap.
In the following example, the array assignment uses a temporary intermediate array because there is clearly
an overlap between the right-hand side and the left-hand side of the assignment:

integer a(10000)
a(2:) = a(l:ubound(a,dim=1)-1)

If you specify the heap-arrays option and omit size, the compiler creates the temporary array on the heap.
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If you specify the heap-arrays option with size 50, the compiler creates the temporary array on the stack.
This is because the size of the temporary intermediate array can be determined at compile time (40Kb), and
it's size is less than the size value.

In the following example, a contiguous array is created from the array slice declaration and passed on:
call somesub(a(1:10000:2))
If you specify the heap-arrays option and omit size, the compiler creates the temporary array on the heap.

If you specify the heap-arrays option with size 25, the compiler creates the temporary array on the stack.
This is because the size of the temporary intermediate array at compile time is only 20Kb.

See Also
F compiler option

mno-gather, Qgather-
Disables the generation of gather instructions in auto-
vectorization. This feature is only available for ifx.

Syntax
Linux OS:

-mno-gather

Windows OS:
/Qgather-

Arguments

None
Default

OFF Gather instructions are enabled in auto-vectorization.

Description

This option disables the generation of gather instructions in auto-vectorization.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

Examples

The following shows examples of using this option:

Linux

ifx -c -mno-gather -mno-scatter t.f90
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Windows

ifx /c /Qgather- t.f90

See Also
mno-scatter, Qscatter- compiler option

mno-scatter, Qscatter-

Disables the generation of scatter instructions in auto-
vectorization. This feature is only available for ifx.

Syntax
Linux OS:

-mno-scatter

Windows OS:

/Qscatter-

Arguments

None
Default
OFF Scatter instructions are enabled in auto-vectorization.

Description

This option disables the generation of scatter instructions in auto-vectorization.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

Examples

The following shows examples of using this option:

Linux

ifx -c -mno-scatter t.f90
Windows

ifx /c /Qscatter- t.f90

See Also
mno-gather, Qgather- compiler option
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pad, Qpad
Enables the changing of the variable and array
memory layout.

Syntax
Linux OS:
-pad
-nopad
Windows OS:
/Qpad
/Qpad-

Arguments

None
Default

-nopad or /Qpad- Variable and array memory layout is performed by default methods.

Description
This option enables the changing of the variable and array memory layout.

This option is effectively not different from the align option when applied to structures and derived types.
However, the scope of pad is greater because it applies also to common blocks, derived types, sequence
types, and structures.

IDE Equivalent

None

Alternate Options

None

See Also
align compiler option

qmkl, Qmkl

Tells the compiler to link to certain libraries in the
Intel® oneAPI Math Kernel Library (oneMKL). On
Windows systems, you must specify this option at
compile time.

Syntax
Linux OS:
-gmkl[=11ib]
Windows OS:
/Qmkl[:11ib]
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Arguments
lib Indicates which oneMKL library files should be linked. Possible values are:
parallel Tells the compiler to link using the threaded libraries in
oneMKL. This is the default if the option is specified with no
lib.
sequential Tells the compiler to link using the sequential libraries in
oneMKL.
cluster Tells the compiler to link using the cluster-specific libraries
and the sequential libraries in oneMKL.
Default
OFF The compiler does not link to the oneMKL library.

Description
This option tells the compiler to link to certain libraries in the Intel® oneAPI Math Kernel Library (oneMKL).
On Linux* systems, dynamic linking is the default when you specify -qgmk1.
On C++ systems, to link with oneMKL statically, you must specify:
-gmkl -static-intel

On Windows* systems, static linking is the default when you specify /omk1. To link with oneMKL dynamically,
you must specify:

/Qmkl /libs:dll or /Qmkl /MD

If both option -gmk1 (or /Qmk1) and —gmk1-ilp64 (or /Qmkl-1ilp64) are specified on the command line, the
rightmost specified option takes precedence.

For more information about using oneMKL libraries, see the article titled: Intel® oneAPI Math Kernel Library
Link Line Advisor.

NOTE
If you specify options [q or Qlmkl and -fsycl on the command line, you link to the
combined oneMKL* SYCL library.

To link to a specific oneMKL SYCL library, specify options [gq or Q]mkl, -fsycl, and
[d or Qlmkl-sycl-impl.

NOTE

On Windows* systems, this option adds directives to the compiled code, which the linker
then reads without further input from the driver. You do not need to specify a separate link
command.

On Linux* systems, the driver must add the library names explicitly to the link command. You must
use option -gmk1 to perform the link to pull in the dependent libraries.
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IDE Equivalent

Visual Studio

Visual Studio: Libraries > Intel® oneAPI Math Kernel Library

Alternate Options

Linux on ifort: -mk1 (this is a deprecated option)

See Also

gqmkl-ilp64, QOmkl-ilpé64 compiler option
gmkl-sycl-impl, Omkl-sycl-impl compiler option
static-intel compiler option

MD compiler option

1libs compiler option

gmkl-ilp64, Qmkl-ilp64

Tells the compiler to link to the ILP64-specific version
of the Intel® oneAPI Math Kernel Library (oneMKL). On
Windows systems, you must specify this option at
compile time.

Syntax

Linux OS:
-gmkl-ilp64[=1ib]
Windows OS:
/Qmkl-ilp64[:1ib]

Arguments
lib Indicates which ILP64-specific oneMKL library files should be linked. Possible values are:
parallel Tells the compiler to link using the threaded libraries in
oneMKL. This is the default if the option is specified with no
lib.
sequential Tells the compiler to link using the sequential libraries in
oneMKL.
cluster Tells the compiler to link using the cluster-specific libraries
and the sequential libraries in oneMKL.
Default
OFF The compiler does not link to the oneMKL library.
Description

This option tells the compiler to link to the ILP64-specific version of the Intel® oneAPI Math Kernel Library
(oneMKL).

If both option -gmk1-ilp64 (or /Qmkl-ilp64) and —-gmkl (or /Qmkl) are specified on the command line, the
rightmost specified option takes precedence.
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For more information about using oneMKL libraries, see the article titled: Intel® oneAPI Math Kernel Library
Link Line Advisor.

Linux

Dynamic linking is the default when you specify -qmk1-i1p64.

On C++ systems, to link with oneMKL statically, you must specify:
-gmkl-ilp64 -static-intel

The driver must add the library names explicitly to the link command. You must use option —-gmkl-ilp64 to
perform the link to pull in the dependent libraries.

Windows

Static linking is the default when you specify /Qmkl-ilp64. To link with oneMKL dynamically, you must
specify:

/Omk1l-ilp64 /libs:dll or /Qmkl-ilp64 /MD
This option adds directives to the compiled code, which the linker then reads without further input from the
driver. You do not need to specify a separate link command.

IDE Equivalent

Visual Studio

Visual Studio: Libraries > Use ILP64 interfaces

Alternate Options

None

See Also

gmkl compiler option
static-intel compiler option
MD compiler option

libs compiler option

qgmkl-sycl-impl, Qmkl-sycl-impl

Lets you link to one or more specific Intel® oneAPI
Math Kernel (oneMKL) SYCL libraries. This feature is
only available for ifx.

Syntax
Linux OS:

-gmkl-sycl-impl=arg[, arg,...]
Windows OS:

/QOmkl-sycl-impl:argl, arg,...]

Arguments
arg Tells the compiler which oneMKL* SYCL-specific library to link to. Possible values are:
blas Links to the BLAS SYCL library.
dft Links to the Discrete Fourier Transform (DFT) SYCL library.
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lapack Links to the LAPACK SYCL library.
rng Links to the Random Number Generator (RNG) SYCL
library.

sparse Links to the Sparse BLAS SYCL library.

stats Links to the Summary Statistic SYCL library.

vm Links to the Vector Mathematics (VM) SYCL library.
Default
OFF You must specify this option to link to a specific oneMKL* SYCL library.
Description

This option lets you link to one or more specific Intel® oneAPI Math Kernel (oneMKL) SYCL libraries.

It is not supported for static linking.

NOTE
When using this option, you must also specify option -fsycl and -gmkl (Linux) or /omk1l
(Windows).

For information about available SYCL drivers, refer to Invoke the Compiler.

IDE Equivalent

None

Alternate Options

None

Examples

The following shows examples of using this option:

ifx -fsycl -gmkl -gmkl-sycl-impl=blas file.o // Linux
ifx /fsycl /Qmkl /Qmkl-sycl-impl:blas file.obj // Windows

If you do not also specify option -fsycl and [g or Q]lmkl, you will see a diagnostic warning. For example,
the following commands will produce such a diagnostic on Linux systems:

ifx -gmkl -gmkl-sycl-impl=blas file.o
ifx -fsycl -gmkl-sycl-impl=blas file.o

See Also
gmkl, omkl compiler option

qopt-args-in-regs, Qopt-args-in-regs

Determines whether calls to routines are optimized by
passing arguments in registers instead of on the
stack. This is a deprecated option that may be
removed in a future release. This feature is only
available for ifort.

104



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference 1

Architecture Restrictions

Only available on IA-32 architecture. IA-32 support has been deprecated, and will be removed in a future
release.

Syntax

Linux OS:
-gopt-args-in-regs[=keyword]
Windows OS:

/Qopt-args—-in-regs|:keyword]

Arguments
keyword Specifies whether the optimization should be performed and under what conditions. Possible
values are:
none The optimization is not performed. No arguments are passed in registers. They are
put on the stack.
seen Causes arguments to be passed in registers when they are passed to routines
whose definition can be seen in the same compilation unit.
all Causes arguments to be passed in registers, whether they are passed to routines
whose definition can be seen in the same compilation unit, or not. This value is
only available on Linux* systems.
Default
-gopt-args—in-regs=seen Arguments are passed in registers when they are passed to routines

or /Qopt-args-in-regs:seen whose definition is seen in the same compilation unit.

Description

This option determines whether calls to routines are optimized by passing arguments in registers instead of
on the stack. It also indicates the conditions when the optimization will be performed.

This is a deprecated option that may be removed in a future release. There is no replacement option.

This option can improve performance for Application Binary Interfaces (ABIs) that require arguments to be
passed in memory and compiled without interprocedural optimization (IPO).

Note that on Linux* systems, if all is specified, a small overhead may be paid when calling "unseen”
routines that have not been compiled with the same option. This is because the call will need to go through a
"thunk" to ensure that arguments are placed back on the stack where the callee expects them.

IDE Equivalent

None

Alternate Options

None
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qopt-assume-safe-padding, Qopt-assume-safe-padding
Determines whether the compiler assumes that

variables and dynamically allocated memory are

padded past the end of the object. This feature is only

available for ifort.

Architecture Restrictions

Only available on all architectures that support Intel® Advanced Vector Extensions 512 (Intel® AVX-512)

Foundation instructions

Syntax

Linux OS:
-gopt-assume-safe-padding
-gno-opt-assume-safe-padding
Windows OS:
/Qopt-assume-safe-padding
/Qopt-assume-safe-padding-
Arguments

None

Default

-gno-opt-assume-safe-padding
or /Qopt-assume-safe-padding-

Description

The compiler will not assume that variables and dynamically allocated
memory are padded past the end of the object. It will adhere to the
sizes specified in your program.

This option determines whether the compiler assumes that variables and dynamically allocated memory are

padded past the end of the object.

When you specify option [g or Q]opt-assume-safe-padding, the compiler assumes that variables and
dynamically allocated memory are padded. This means that code can access up to 64 bytes beyond what is

specified in your program.

The compiler does not add any padding for static and automatic objects when this option is used, but it
assumes that code can access up to 64 bytes beyond the end of the object, wherever the object appears in
the program. To satisfy this assumption, you must increase the size of static and automatic objects in your

program when you use this option.

This option may improve performance of memory operations.

IDE Equivalent

None

Alternate Options

None

qopt-block-factor, Qopt-block-factor

Lets you specify a loop blocking factor. This feature is

only available for ifort.
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Syntax

Linux OS:
-gopt-block-factor=n
Windows OS:
/Qopt-block-factor:n

Arguments

n Is the blocking factor. It must be an integer. The compiler may ignore
the blocking factor if the value is 0 or 1.

Default

OFF The compiler uses default heuristics for loop blocking.

Description

This option lets you specify a loop blocking factor.

IDE Equivalent

None

Alternate Options

None

qopt-dynamic-align, Qopt-dynamic-align
Enables or disables dynamic data alignment

optimizations.

Syntax

Linux OS:
-gopt-dynamic-align
-gno-opt-dynamic-align
Windows OS:
/Qopt-dynamic-align
/Qopt-dynamic-align-
Arguments

None

Default

ifort: —-gopt-dynamic-align
or /Qopt-dynamic-align

The compiler may generate code dynamically
dependent on alignment. It may do optimizations
based on data location for the best performance. The
result of execution on some algorithms may depend
on data layout.
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The compiler does not generate code dynamically
dependent on alignment.

ifx: —-gno-opt-dynamic-align
or /Qopt-dynamic-align-

Description
This option enables or disables dynamic data alignment optimizations.

If you specify -gqno-opt-dynamic-align or /Qopt-dynamic-align-, the compiler generates no code
dynamically dependent on alignment. It will not do any optimizations based on data location and results will
depend on the data values themselves.

When you specify [q or Qlopt-dynamic-align, the compiler may implement conditional optimizations
based on dynamic alignment of the input data. These dynamic alignment optimizations may result in
different bitwise results for aligned and unaligned data with the same values.

Dynamic alignment optimizations can improve the performance of some vectorized code, especially for long
trip count loops, but there is an associated cost of increased code size and compile time. Disabling such
optimizations can improve the performance of some other vectorized code. It may also improve bitwise
reproducibility of results, factoring out data location from possible sources of discrepancy.

IDE Equivalent

None

Alternate Options

None

qopt-for-throughput, Qopt-for-throughput
Determines how the compiler optimizes for throughput
depending on whether the program is to run in single-
job or multi-job mode. This feature is only available
for ifx.

Syntax
Linux OS:

-gopt-for-throughput=value
Windows OS:
/Qopt-for-throughput:value

Arguments

value Is one of the values "multi-job" or "single-job".

Default

OFF If this option is not specified, the compiler will not optimize for throughput performance.
Description

This option determines whether throughput performance optimization occurs for a program that is run as a
single job or one that is run in a multiple job environment.

The memory optimizations for a single job versus multiple jobs can be tuned in different ways by the
compiler. For example, the cost model for loop tiling and prefetching are different for a single job versus
multiple jobs. When a single job is running, more memory is available and the tunings will be different.
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IDE Equivalent

None

Alternate Options

None

qopt-jump-tables, Qopt-jump-tables

Enables or disables generation of jump tables for
switch statements. This feature is only available for
ifort.

Syntax

Linux OS:
-gopt-jump-tables=keyword
-gno-opt-jump-tables
Windows OS:
/Qopt-jump-tables: keyword

/Qopt-jump-tables-

Arguments
keyword Is the instruction for generating jump tables. Possible values are:
never Tells the compiler to never generate jump tables. All switch
statements are implemented as chains of if-then-elses.
This is the same as specifying —~-gno-opt-jump-tables
(Linux*) or /Qopt-jump-tables- (Windows*).
default The compiler uses default heuristics to determine when to
generate jump tables.
large Tells the compiler to generate jump tables up to a certain
pre-defined size (64K entries).
n Must be an integer. Tells the compiler to generate jump
tables up to n entries in size.
Default
-gopt-jump-tables=default The compiler uses default heuristics to determine

or /Qopt-jump-tables:default when to generate jump tables for switch statements.

Description

This option enables or disables generation of jump tables for switch statements. When the option is enabled,
it may improve performance for programs with large switch statements.

IDE Equivalent

None

Alternate Options

None
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qopt-malloc-options
Lets you specify an alternate algorithm for malloc().
This feature is only available for ifort.

Syntax
Linux OS:
-gopt-malloc-options=n
Windows OS:
None
Arguments
n Specifies the algorithm to use for malloc(). Possible values are:
0 Tells the compiler to use the default
algorithm for malloc(). This is the default.
1 Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=2 and
M_TRIM_THRESHOLD=0x10000000.
2 Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=2 and
M_TRIM_THRESHOLD=0x40000000.
3 Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=0 and
M_TRIM_THRESHOLD=-1.
4 Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=0,
M_TRIM_THRESHOLD=-1,
M_TOP_PAD=4096.
Default
-gopt-malloc-options=0 The compiler uses the default algorithm when malloc() is called.
No call is made to mallopt().
Description

This option lets you specify an alternate algorithm for malloc().

If you specify a non-zero value for n, it causes alternate configuration parameters to be set for how malloc()
allocates and frees memory. It tells the compiler to insert calls to mallopt() to adjust these parameters to
malloc() for dynamic memory allocation. This may improve speed.

IDE Equivalent

None
Alternate Options
None

See Also

malloc(3) man page
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mallopt function (defined in malloc.h)

gopt-matmul, Qopt-matmul
Enables or disables a compiler-generated Matrix
Multiply (matmul) library call.

Syntax

Linux OS:
-gopt-matmul
-gno-opt-matmul
Windows OS:
/Qopt-matmul

/Qopt-matmul -

Arguments

None

Default

-gno-opt-matmul The matmul library call optimization does not occur unless this option is

or /Qopt-matmul- enabled or certain other compiler options are specified (see below).

Description
This option enables or disables a compiler-generated Matrix Multiply (MATMUL) library call.

The [g or Qlopt-matmul option tells the compiler to identify matrix multiplication loop nests (if any) and
replace them with a matmul library call for improved performance. The resulting executable may improve
performance on Intel® microprocessors.

NOTE
This option is dependent upon the OpenMP* library. If your product does not support
OpenMP, this option will have no effect.

This option has no effect unless option 02 or higher is set.

NOTE
Many routines in the MATMUL library are more highly optimized for Intel® microprocessors
than for non-Intel microprocessors.

IDE Equivalent

Visual Studio
Visual Studio: Optimization > Enable Matrix Multiply Library Call

Alternate Options
None

See Also
0 compiler option
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qopt-mem-layout-trans, Qopt-mem-layout-trans
Controls the level of memory layout transformations
performed by the compiler.

Syntax

Linux OS:
-gqopt-mem-layout-trans[=n]
-gno-opt-mem-layout-trans
Windows OS:
/Qopt-mem-layout-trans/[:n]

/Qopt-mem-layout-trans-

Arguments
n Is the level of memory layout transformations. Possible values are:

0 Disables memory layout transformations.

This is the same as specifying
-gno-opt-mem-layout-trans (Linux*)
or /Qopt-mem-layout-trans- (Windows*).

1 Enables basic memory layout transformations.

2 Enables more memory layout transformations. This is the
same as specifying [qg or Q]opt-mem-layout-trans with
no argument.

3 Enables more memory layout transformations like copy-in/
copy-out of structures for a region of code. This setting
should only be used when targeting systems that have
more than 4GB of physical memory per core.

4 Enables more aggressive memory layout transformations.
This setting should only be used when targeting systems
that have more than 4GB of physical memory per core.

Default
-gopt-mem-layout-trans=0 No memory layout transformations are performed.

or /Qopt-mem-layout-trans:0

Description

This option controls the level of memory layout transformations performed by the compiler. This option can
improve cache reuse and cache locality.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201
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IDE Equivalent

None

Alternate Options

None

qopt-multi-version-aggressive, Qopt-multi-version-aggressive
Tells the compiler to use aggressive multi-versioning

to check for pointer aliasing and scalar replacement.

This feature is only available for ifort.

Syntax

Linux OS:
-gopt-multi-version-aggressive
-gno-opt-multi-version-aggressive
Windows OS:
/Qopt-multi-version-aggressive

/Qopt-multi-version-aggressive-

Arguments

None
Default

-gno-opt-multi-version-aggressive The compiler uses default heuristics when checking

or /Qopt-multi-version-aggressive- for pointer aliasing and scalar replacement.

Description

This option tells the compiler to use aggressive multi-versioning to check for pointer aliasing and scalar
replacement. This option may improve performance.

The performance can be affected by certain options, such as /arch or /Qx (Windows*) or -m or -x (Linux*).

IDE Equivalent

None

Alternate Options

None

qopt-multiple-gather-scatter-by-shuffles, Qopt-multiple-gather-scatter-by-shuffles
Enables or disables the optimization for multiple

adjacent gather/scatter type vector memory

references.

Syntax

Linux OS:
-gopt-multiple-gather-scatter-by-shuffles

-gqno-opt-multiple-gather-scatter-by-shuffles
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Windows OS:
/Qopt-multiple-gather-scatter-by-shuffles

/Qopt-multiple-gather-scatter-by-shuffles-

Arguments

None

Default

varies When this option is not specified, the compiler uses default heuristics for
optimization.

Description

This option controls the optimization for multiple adjacent gather/scatter type vector memory references.
This optimization hint is useful for performance tuning. It tries to generate more optimal software sequences
using shuffles.

If you specify this option, the compiler will apply the optimization heuristics. If you specify
-gqno-opt-multiple-gather-scatter-by-shuffles
or /Qopt-multiple-gather-scatter-by-shuffles-, the compiler will not apply the optimization.

NOTE
Optimization is affected by optimization compiler options, such as [Q]x, -march (Linux*),
and /arch (Windows*).

To override the effect of this option (or the default) per loop basis, you can use directive VECTOR
[NO]MULTIPLE_GATHER_SCATTER_BY_SHUFFLE.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

VECTOR directive

%, Ox compiler option
march compiler option
arch compiler option

qopt-prefetch, Qopt-prefetch
Enables or disables prefetch insertion optimization.
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Syntax
Linux OS:

-gopt-prefetch[=n]
-gqno-opt-prefetch
Windows OS:

/Qopt-prefetchl:n]

/Qopt-prefetch-
Arguments

n

Default

ifort: —-gqno-opt-prefetch
or /Qopt-prefetch-

ifx: varies

Description

Is the level of software prefetching optimization desired. Possible

values are:

0

1to>s

Disables software prefetching. This is the
same as specifying —qno-opt-prefetch
(Linux*) or /Qopt-prefetch- (Windows*).

Enables different levels of software
prefetching. If you do not specify a value for
n, the default is ~-gopt-prefetch=2

or /Qopt-prefetch:2. Use lower values to
reduce the amount of prefetching.

Prefetch insertion optimization is disabled.

The default can change depending on certain option
settings.

If you specify option -gno-opt-prefetch

(or /Qopt-prefetch-), or you specify option 00 or
01 explicitly or implicitly, prefetch insertion
optimization is disabled.

If you specify option 02 or above explicitly or
implicitly, the default is option -qopt-prefetch=2
(or /Qopt-prefetch:2).

This option enables or disables prefetch insertion optimization. The goal of prefetching is to reduce cache
misses by providing hints to the processor about when data should be loaded into the cache.

This option enables prefetching when higher optimization levels are specified.

IDE Equivalent

Visual Studio

Visual Studio: Optimization > Prefetch Insertion
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Alternate Options

None

See Also
gopt-prefetch-distance, Qopt-prefetch-distance compiler option (ifort)
gopt-prefetch-distance, Qopt-prefetch-distance compiler option (ifx)

qopt-prefetch-distance, Qopt-prefetch-distance (ifort only)
Specifies the prefetch distance to be used for
compiler-generated prefetches inside loops. This

description is only for ifort.

Syntax
Linux OS:

-gopt-prefetch-distance=nl[, nZ2]
Windows OS:
/Qopt-prefetch-distance:nl[, n2]

Arguments

ni, n2 Is the prefetch distance in terms of the number of (possibly
vectorized) iterations. Possible values are non-negative numbers >=0.
n2 is optional.
nl = 0 turns off all compiler issued prefetches from memory to L2. n2
= 0 turns off all compiler issued prefetches from L2 to L1. If n2 is
specified and n1 > 0, n1 should be >= n2.

Default

OFF The compiler uses default heuristics to determine the prefetch distance.

Description

This option specifies the prefetch distance to be used for compiler-generated prefetches inside loops. The unit
(n1 and optionally n2) is the number of iterations. If the loop is vectorized by the compiler, the unit is the
number of vectorized iterations.

The value of n1 will be used as the distance for prefetches from memory to L2 (for example, the vprefetchl
instruction). If n2 is specified, it will be used as the distance for prefetches from L2 to L1 (for example, the
vprefetchO instruction).

This option is ignored if option —gopt-prefetch=0 (Linux*) or /Qopt-prefetch:0 (Windows*) is specified.

IDE Equivalent

None

Alternate Options

None

Example

Consider the following Linux* examples:

-gqopt-prefetch-distance=64, 32
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The above causes the compiler to use a distance of 64 iterations for memory to L2 prefetches, and a distance
of 32 iterations for L2 to L1 prefetches.

-qopt-prefetch-distance=24

The above causes the compiler to use a distance of 24 iterations for memory to L2 prefetches. The distance
for L2 to L1 prefetches will be determined by the compiler.

-gqopt-prefetch-distance=0, 4
The above turns off all memory to L2 prefetches inserted by the compiler inside loops. The compiler will use
a distance of 4 iterations for L2 to L1 prefetches.

-gopt-prefetch-distance=16,0

The above causes the compiler to use a distance of 16 iterations for memory to L2 prefetches. No L2 to L1
loop prefetches are issued by the compiler.

See Also
gopt-prefetch, Qopt-prefetch compiler option
PREFETCH directive

qopt-prefetch-distance, Qopt-prefetch-distance (ifx only)
Specifies the prefetch distance to be used for
compiler-generated prefetches inside loops. This
description is only for ifx.

Syntax
Linux OS:

-gopt-prefetch-distance=n
Windows OS:

/Qopt-prefetch-distance:n

Arguments

n Is the prefetch distance in terms of the number of (possibly-
vectorized) iterations. Possible values are non-negative numbers >=0.
n = 0 turns off all compiler issued prefetches from memory to L1.

Default

OFF The compiler uses default heuristics to determine the prefetch distance.

Description

This option specifies the prefetch distance to be used for compiler-generated prefetches inside loops. The unit
n is the number of iterations. If the loop is vectorized by the compiler, the unit is the number of vectorized
iterations.

The value of n will be used as the distance for prefetches from memory to L1 (for example, the vprefetch0
instruction).

Linux
This option is ignored if option -qopt-prefetch=0 or option -gno-opt-prefetch is specified.
Windows

This option is ignored if option /Qopt-prefetch=0 or option /Qopt-prefetch- is specified.
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IDE Equivalent

None

Alternate Options

None

Examples

Consider the following Linux examples:
-gopt-prefetch-distance=24

The above causes the compiler to use a distance of 24 iterations for memory to L1 prefetches.
-gopt-prefetch-distance=0

The above turns off all memory to L1 prefetches inserted by the compiler inside loops.
-gopt-prefetch-distance=16

The above causes the compiler to use a distance of 16 iterations for memory to L1 prefetches.

See Also

gopt-prefetch, Qopt-prefetch compiler option
PREFETCH directive

qopt-prefetch-issue-excl-hint, Qopt-prefetch-issue-excl-hint
Supports the prefetchW instruction in Intel®

microarchitecture code name Broadwell and later. This

feature is only available for ifort.

Syntax

Linux OS:
-gopt-prefetch-issue-excl-hint
Windows OS:

/Qopt-prefetch-issue-excl-hint

Arguments

None

Default

OFF The compiler does not support the PREFETCHW
instruction for this microarchitecture.

Description

This option supports the PREFETCHW instruction in Intel® microarchitecture code name Broadwell and later.
When you specify this option, you must also specify option [q or Q]opt-prefetch.

The prefetch instruction is merely a hint and does not affect program behavior. If executed, this instruction
moves data closer to the processor and invalidates any other cached copy in anticipation of the line being
written to in the future.

IDE Equivalent

None
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Alternate Options

None

See Also
gopt-prefetch/Qopt-prefetch con1pHeropﬂon

qopt-prefetch-loads-only, Qopt-prefetch-loads-only
Specifies that the compiler should only prefetch for
loads inside the loop and ignore the stores, if any.
This feature is only available for ifx.

Syntax

Linux OS:
-gopt-prefetch-loads-only
Windows OS:
/Qopt-prefetch-loads-only

Arguments

None
Default

OFF The compiler prefetches for both loads and stores.

Description

This option specifies that the compiler should only prefetch for loads inside the loop and ignore the stores, if
any.

Linux
This option is ignored if option —~gopt-prefetch=0 or option -gno-opt-prefetch is specified.
Windows

This option is ignored if option /Qopt-prefetch=0 or option /Qopt-prefetch- is specified.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation.

IDE Equivalent

None

Alternate Options

None

See Also
gopt-prefetch, Qopt-prefetch compiler option
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qopt-ra-region-strategy, Qopt-ra-region-strategy
Selects the method that the register allocator uses to
partition each routine into regions. This feature is only
available for ifort.

Syntax

Linux OS:
-gqopt-ra-region-strategyl[=keyword]
Windows OS:

/Qopt-ra-region-strategyl: keyword]

Arguments
keyword Is the method used for partitioning. Possible values are:
routine Creates a single region for each routine.
block Partitions each routine into one region per
basic block.
trace Partitions each routine into one region per
trace.
loop Partitions each routine into one region per
loop.
default The compiler determines which method is
used for partitioning.
Default

-gopt-ra-region-strategy=default
or /Qopt-ra-region-strategy:default

Description

The compiler determines which method is used for
partitioning. This is also the default if keyword is not
specified.

This option selects the method that the register allocator uses to partition each routine into regions.

When setting default is in effect, the compiler attempts to optimize the tradeoff between compile-time

performance and generated code performance.

This option is only relevant when optimizations are enabled (option 01 or higher).

IDE Equivalent

None

Alternate Options

None

See Also
o0 compiler option
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qopt-streaming-stores, Qopt-streaming-stores

Enables generation of streaming stores for
optimization.

Syntax

Linux OS:
-gqopt-streaming-stores=keyword
-gno-opt-streaming-stores
Windows OS:
/Qopt-streaming-stores: keyword

/Qopt-streaming-stores-—

Arguments

keyword Specifies whether streaming stores are generated. Possible values are:

always

never

auto

Default

-gopt-streaming-stores=auto
or /Qopt-streaming-stores:auto

Description

Enables generation of streaming stores for
optimization. The compiler optimizes under
the assumption that the application is
memory bound.

When this option setting is specified, it is
your responsibility to also insert any memory
barriers (fences) as required to ensure
correct memory ordering within a thread or
across threads. See the Examples section for
one way to do this.

Disables generation of streaming stores for
optimization. Normal stores are performed.

This setting has the same effect as
specifying -qno-opt-streaming-stores
or /Qopt-streaming-stores-.

Lets the compiler decide which instructions
to use.

The compiler decides whether to use streaming stores
or normal stores.

This option enables generation of streaming stores for optimization. This method stores data with
instructions that use a non-temporal buffer, which minimizes memory hierarchy pollution.

This option may be useful for applications that can benefit from streaming stores.

IDE Equivalent

None
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Alternate Options

None

Example

The following example shows one way to insert memory barriers (fences) when specifying
-gopt-streaming-stores=always Or /Qopt-streaming-stores:always. It uses the procedure interface
for sfence from the module IFCORE, which maps to the C/C++ function _mm_sfence:

program main
implicit none

INTEGER, PARAMETER :: dp = selected real kind(15, 307)

integer, parameter :: k5 = selected int kind(5)
integer, parameter :: k15 = selected int kind(15)
integer (kind=k5), parameter :: i5 = 10

integer (kind=k15) :: il5

integer (kind=k15) :: sizeof

REAL (KIND=dp) :: a(ib)

REAL (KIND=dp) :: b(i5)

REAL (KIND=dp) c(i5)

sizeof = size(a)
call subl(a,b,c,sizeof,sizeof,sizeof)

contains

subroutine subl(a, b, ¢, lent, nl, n2)

use IFCORE, only : for sfence

integer (kind=k1l5) lent, nl, n2, i, j

REAL (KIND=dp) a(lent), b(lent), c(lent), d(lent)
!Somp parallel do

do j =1, nl
a(j) = 1.0 *J
b(j) = 2.0 * j*j
c(j) = 3.0 *j * %]
enddo

!Somp end parallel do
call for sfence()
!Somp parallel do
doi=1, n2

a(i) = a(i) + b(i) * c(i)
write (*,*)a (i)
enddo

!Somp end parallel do
end subroutine

end

See Also
ax, Qax compiler option
x, Ox compiler option

qopt-subscript-in-range, Qopt-subscript-in-range
Determines whether the compiler assumes that there
are no "large" integers being used or being computed
inside loops. This feature is only available for ifort.
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Syntax

Linux OS:
-gopt-subscript-in-range
-gno-opt-subscript-in-range
Windows OS:
/Qopt-subscript-in-range

/Qopt-subscript-in-range-

Arguments

None
Default

-gno-opt-subscript-in-range The compiler assumes there are "large" integers being used or being
or /Qopt-subscript-in-range- computed within loops.

Description

This option determines whether the compiler assumes that there are no "large" integers being used or being
computed inside loops.

If you specify [g or Q]opt-subscript-in-range, the compiler assumes that there are no "large" integers
being used or being computed inside loops. A "large" integer is typically > 231,

This feature can enable more loop transformations.

IDE Equivalent

None

Alternate Options

None

Example

The following example shows how these options can be useful. Variable m is declared as type
integer(kind=8) (64-bits) and all other variables inside the subscript are declared as type integer(kind=4)
(32-bits):

Ali +3 + (n +%k *m]

qopt-zmm-usage, Qopt-zmm-usage
Defines a level of zmm registers usage.

Syntax
Linux OS:

—-gopt-zmm-usage=keyword
Windows OS:

/Qopt-zmm-usage: keyword
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Arguments
keyword Specifies the level of zmm registers usage. Possible values are:
low Tells the compiler that the compiled program is unlikely to
benefit from zmm registers usage. It specifies that the
compiler should avoid using zmm registers unless it can
prove the gain from their usage.
high Tells the compiler to generate zmm code without
restrictions.
Default

varies The default is low when you specify [Q]xCORE-AVX512.
The default is high when you specify [Q]xCOMMON-AVX512.

Description

This option may provide better code optimization for Intel® processors that are on the Intel®
microarchitecture formerly code-named Skylake.

This option defines a level of zmm registers usage. The low setting causes the compiler to generate code
with zmm registers very carefully, only when the gain from their usage is proven. The high setting causes
the compiler to use much less restrictive heuristics for zmm code generation.

It is not always easy to predict whether the high or the low setting will yield better performance. Programs
that enjoy high performance gains from the use of xmm or ymm registers may expect performance
improvement by moving to use zmm registers. However, some programs that use zmm registers may not
gain as much or may even lose performance. We recommend that you try both option values to measure the
performance of your programs.

This option is ignored if you do not specify an option that enables Intel® AVX-512, such as [Q] xCORE-AVX512
or option [Q] xCOMMON-AVX512.

This option has no effect on loops that use directive SIMD SIMDLEN(n) or on functions that are generated by
vector specifications specific to CORE-AVX512.

IDE Equivalent

None

Alternate Options

None

See Also
x, Ox compiler option
SIMD Directive for OpenMP clause SIMDLEN

qoverride-limits, Qoverride-limits

Lets you override certain internal compiler limits that
are intended to prevent excessive memory usage or
compile times for very large, complex compilation
units.
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Syntax

Linux OS:
-gqoverride-limits
Windows OS:

/Qoverride-limits

Arguments

None
Default

OFF Certain internal compiler limits are not overridden. These limits are determined by default
heuristics.

Description

This option provides a way to override certain internal compiler limits that are intended to prevent excessive
memory usage or compile times for very large, complex compilation units.

If this option is not used and your program exceeds one of these internal compiler limits, some optimizations
will be skipped to reduce the memory footprint and compile time. If you chose to create an optimization
report by specifying [g or Q]opt-report, you may see a related diagnostic remark as part of the report.

Specifying this option may substantially increase compile time and/or memory usage.

NOTE
If you use this option, it is your responsibility to ensure that sufficient memory is available.
If there is not sufficient available memory, the compilation may fail.

This option should only be used where there is a specific need; it is not recommended for
inexperienced users.

IDE Equivalent

None

Alternate Options

None

reentrancy

Tells the compiler to generate reentrant code to
support a multithreaded application.

Syntax
Linux OS:
-reentrancy keyword

-noreentrancy

Windows OS:
/reentrancy: keyword

/noreentrancy
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Arguments
keyword Specifies details about the program. Possible values are:

none Tells the runtime library (RTL) that the program does not rely on
threaded or asynchronous reentrancy. The RTL will not guard against
such interrupts inside its own critical regions. This is the same as
specifying noreentrancy.

async Tells the runtime library (RTL) that the program may contain
asynchronous (AST) handlers that could call the RTL. This causes the
RTL to guard against AST interrupts inside its own critical regions.

threaded Tells the runtime library (RTL) that the program is multithreaded, such
as programs using the POSIX threads library. This causes the RTL to use
thread locking to guard its own critical regions.

Default

threaded The compiler tells the runtime library (RTL) that the program is multithreaded.

Description
This option tells the compiler to generate reentrant code to support a multithreaded application.
If you do not specify a keyword for reentrancy, it is the same as specifying reentrancy threaded.

To ensure that a threadsafe and/or reentrant runtime library is linked and correctly initialized, option
reentrancy threaded should also be used for the link step and for the compilation of the main routine.

Note that if option threads is specified, it sets option reentrancy threaded, since multithreaded code
must be reentrant.

IDE Equivalent

Windows

Visual Studio: Code Generation > Generate Reentrant Code

Alternate Options

None

See Also
threads compiler option

safe-cray-ptr, Qsafe-cray-ptr
Tells the compiler that Cray* pointers do not alias
other variables.

Syntax

Linux OS:
-safe-cray-ptr
Windows OS:

/Qsafe-cray-ptr

126



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference 1

Arguments

None
Default

OFF The compiler assumes that Cray pointers alias other variables.

Description

This option tells the compiler that Cray pointers do not alias (that is, do not specify sharing memory with)
other variables.

IDE Equivalent

Windows

Visual Studio: Data > Assume CRAY Pointers Do Not Share Memory Locations (/Qsafe-cray-ptr)

Alternate Options

None

Example

Consider the following:

pointer (pb, b)
pb = getstorage ()
doi=1, n

b(i) = a(i) + 1
enddo

By default, the compiler assumes that b and a are aliased. To prevent such an assumption, specify the
-safe-cray-ptr (Linux*) or /Qsafe-cray-ptr (Windows*) option, and the compiler will treat b(i) and a(i)
as independent of each other.

However, if the variables are intended to be aliased with Cray pointers, using the option produces incorrect
results. In the following example, you should not use the option:

pointer (pb, b)
pb = loc(a(2))
do i=1, n

b(i) = a(i) +1
enddo

scalar-rep, Qscalar-rep

Enables or disables the scalar replacement
optimization done by the compiler as part of loop
transformations. This feature is only available for ifort.

Syntax
Linux OS:
-scalar-rep

-no-scalar-rep

Windows OS:
/Qscalar-rep

/Qscalar-rep-
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Arguments

None

Default

-scalar-rep Scalar replacement is performed during loop transformation at optimization levels of

or /Qscalar-rep 02 and above.

Description

This option enables or disables the scalar replacement optimization done by the compiler as part of loop
transformations. This option takes effect only if you specify an optimization level of 02 or higher.

IDE Equivalent

None

Alternate Options

None

See Also
O compiler option

simd, Qsimd
Enables or disables compiler interpretation of SIMD
directives.This feature is only available for ifort.

Syntax
Linux OS:
-simd
-no-simd
Windows OS:
/Qsimd
/Qsimd-
Arguments
None
Default
—simd SIMD directives are enabled.

or /Qsimd

Description
This option enables or disables compiler interpretation of SIMD directives.

To disable interpretation of SIMD directives, specify —-no-simd (Linux*) or /Qsimd- (Windows*). Note that
the compiler may still vectorize loops based on its own heuristics (leading to generation of SIMD instructions)
even when -no-simd (or /Qsimd-) is specified.
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To disable all compiler vectorization, use the "-no-vec -no-simd" (Linux*) or "/Qvec- /Qsimd-"
(Windows*) compiler options. The option -no-vec (and /Qvec-) disables all auto-vectorization, including
vectorization of array notation statements. The option -no-simd (and /Qsimd-) disables vectorization of
loops that have SIMD directives.

NOTE

If you specify option -mia32 (Linux*) or option /arch:Ia32 (Windows*), SIMD directives are
disabled by default and vector instructions cannot be used. Therefore, you cannot explicitly
enable SIMD directives by specifying option [Q]simd.

IDE Equivalent

None

Alternate Options

None

See Also
vec, Qvec compiler option
SIMD Directive

unroll, Qunroll
Tells the compiler the maximum number of times to
unroll loops.

Syntax

Linux OS:
-unroll [=n]
Windows OS:
/Qunroll[:n]

Arguments

n Is the maximum number of times a loop can be unrolled. To disable loop enrolling, specify 0.
Default

—unroll The compiler uses default heuristics when unrolling loops.

or /Qunroll

Description
This option tells the compiler the maximum number of times to unroll loops.

If you do not specify n, the optimizer determines how many times loops can be unrolled.
IDE Equivalent

Windows

Visual Studio: Optimization > Loop Unroll Count
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Alternate Options
Linux: -funroll-loops

Windows: /unroll (this is a deprecated option)

unroll-aggressive, Qunroll-aggressive

Determines whether the compiler uses more
aggressive unrolling for certain loops. This feature is
only available for ifort.

Syntax

Linux OS:
-unroll-aggressive
-no-unroll-aggressive
Windows OS:
/Qunroll-aggressive

/Qunroll-aggressive-

Arguments

None
Default

-no-unroll-aggressive The compiler uses default heuristics when unrolling loops.
or /Qunroll-aggressive-
Description

This option determines whether the compiler uses more aggressive unrolling for certain loops. The positive
form of the option may improve performance.

This option enables aggressive, complete unrolling for loops with small constant trip counts.

IDE Equivalent

None
Alternate Options

None

vec, Qvec
Enables or disables loop vectorization.

Syntax
Linux OS:
-vec
-no-vec
Windows OS:
/Qvec

/Qvec-—
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Arguments

None

Default

—vec Loop vectorization is enabled if option 02 or higher is in effect.

or /Qvec

Description

This option enables or disables loop vectorization.

To disable loop vectorization, specify -no-vec (Linux*) or /Qvec- (Windows*).
On ifort:

e To disable interpretation of SIMD directives, specify -no-simd (Linux*) or /Qsimd- (Windows*).

e To disable all compiler vectorization, use the "-no-vec -no-simd" (Linux*) or "/Qvec- /Qsimd-"
(Windows*) compiler options. The option —-no-vec (and /Qvec-) disables all auto-vectorization, including
vectorization of array notation statements. The option —-no-simd (and /Qsimd-) disables vectorization of
loops that have SIMD directives.

NOTE

Using this option enables vectorization at default optimization levels for both Intel®
microprocessors and non-Intel microprocessors. Vectorization may call library routines that
can result in additional performance gain on Intel microprocessors than on non-Intel
microprocessors.

On ifort, the vectorization can also be affected by certain options, such as /arch (Windows), -m
(Linux), or [Q]x.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

See Also

simd, Osimd compiler option

ax, Qax compiler option

%, Ox compiler option

vec-guard-write, Qvec-guard-write compiler option
vec-threshold, Qvec-threshold compiler option

vec-guard-write, Qvec-guard-write
Tells the compiler to perform a conditional check in a
vectorized loop. This feature is only available for ifort.

131



1 Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Syntax

Linux OS:
-vec-guard-write
-no-vec-guard-write
Windows OS:
/Qvec-guard-write

/Qvec—-guard-write-

Arguments

None

Default

-vec-guard-write
or /Qvec-guard-write

Description

The compiler performs a conditional check in a vectorized loop.

This option tells the compiler to perform a conditional check in a vectorized loop. This checking avoids
unnecessary stores and may improve performance.

IDE Equivalent

None

Alternate Options

None

vec-threshold, Qvec-threshold

Sets a threshold for the vectorization of loops.

Syntax

Linux OS:

-vec-threshold[n]

Windows OS:
/Qvec—-threshold[[:]n]

Arguments

n
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Is an integer whose value is the threshold for the vectorization of
loops. Possible values are 0 through 100.

If n is 0, loops get vectorized always, regardless of computation work
volume.

If nis 100, loops get vectorized when performance gains are predicted
based on the compiler analysis data. Loops get vectorized only if
profitable vector-level parallel execution is almost certain.
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The intermediate 1 to 99 values represent the percentage probability
for profitable speed-up. For example, n=50 directs the compiler to
vectorize only if there is a 50% probability of the code speeding up if
executed in vector form.

Default

—vec-threshold100 Loops get vectorized only if profitable vector-level parallel execution is
or /Qvec-threshold100 almost certain. This is also the default if you do not specify n.
Description

This option sets a threshold for the vectorization of loops based on the probability of profitable execution of
the vectorized loop in parallel.

This option is useful for loops whose computation work volume cannot be determined at compile-time. The
threshold is usually relevant when the loop trip count is unknown at compile-time.

The compiler applies a heuristic that tries to balance the overhead of creating multiple threads versus the
amount of work available to be shared amongst the threads.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

Windows

Visual Studio: Optimization > Threshold For Vectorization

Alternate Options

None

vecabi, Qvecabi (ifort only)

Determines which vector function application binary
interface (ABI) the compiler uses to create or call
vector functions. This description is only for ifort.

Syntax
Linux OS:

-vecabi=keyword

Windows OS:

/Qvecabi: keyword

Arguments

keyword Specifies which vector function ABI to use. Possible values are:

compat Tells the compiler to use the compatibility vector
function ABI. This ABI includes Intel®-specific features.
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cmdtarget

gcc

legacy (ifort only)

Default

compat

Description

Tells the compiler to generate an extended set of vector
functions. The option is very similar to setting compat.
However, for compat, only one vector function is
created, while for cmdtarget, several vector functions
are created for each vector specification. Vector
variants are created for targets specified by compiler
options [Q]x and/or [Q]ax. No change is made to the
source code.

Tells the compiler to use the gcc vector function ABI.
Use this setting only in cases when you want to link
with modules compiled by gcc. This setting is not
available on Windows* systems.

Tells the compiler to use the legacy vector function ABI.
Use this setting if you need to keep the generated
vector function binary backward compatible with the
vectorized binary generated by older versions of the
Intel® compilers (V13.1 or older).

The compiler uses the compatibility vector function ABI.

This option determines which vector function application binary interface (ABI) the compiler uses to create or

call vector functions.

NOTE

To avoid possible link-time and runtime errors, use identical [Q]vecabi settings when
compiling all files in an application that define or use vector functions, including libraries. If
setting cmdtarget is specified, options [0]x and/or [Q]ax must have identical values.

Be careful using setting cmdtarget with libraries or program modules/routines with vector function
definitions that cannot be recompiled. In such cases, setting cmdtarget may cause link errors.

On Linux* systems, since the default is compat, you must specify legacy if you need to keep the generated
vector function binary backward compatible with the vectorized binary generated by the previous version of

Intel® compilers.

When cmdtarget is specified, the additional vector function versions are created by copying each vector
specification and changing target processor in the copy. The number of vector functions is determined by the

settings specified in options [Q]x and/or [Q]ax.

For example, suppose we have the following function declaration:

interface
integer function foo(a)

!dir$ attributes vector: (processor(core 2 duo ssed4 1)) :: foo

integer a
end function
end interface

and the following options are specified: -axAVX, CORE-AVX2.
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The following table shows the different results for the above declaration and option specifications when
setting compat or setting Intel® SSE2 cmdtarget is used:

compat

cmdtarget

One vector version is created for Intel® SSE4.1 (by
vector function specification).

Four vector versions are created for the following
targets:

¢ Intel® SSE2 (default because no -x option is
used)

¢ Intel® SSE4.1 (by vector function specification)

¢ Intel® AVX (by the first —ax option value)

+ Intel® AVX2 (by the second -ax option value)

For more information about the Intel®-compatible vector functions ABI, see the downloadable PDF titled

Vector Function Application Binary Interface.

For more information about the GCC vector functions ABI, see the item Libmvec - vector math library

document in the GLIBC wiki at sourceware.org.

Product and Performance Information

Performancelndex.

Notice revision #20201201

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/

IDE Equivalent

None

Alternate Options

None

vecabi, Qvecabi (ifx only)

Determines which vector function application binary
interface (ABI) the compiler uses to create or call
vector functions. This description is only for ifx.

Syntax
Linux OS:

-vecabi=keyword

Windows OS:
/Qvecabi: keyword

Arguments
keyword Specifies which vector function ABI to use. Possible values are:
cmdtarget Tells the compiler to generate an extended set of vector
functions. Vector variants are created for all targets
specified by compiler options [Q]x and/or [Q]ax. No
change needs to be made to the source code.
gcc Tells the compiler to use the gcc vector function ABI.
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Default

gce The compiler uses the gcc-compatible vector function ABI.

Description

This option determines which vector function application binary interface (ABI) the compiler uses to create or
call vector functions.

All files in an application that define or use vector functions must make identical use of -vecabi=cmdtarget
(and /Qvecabi:cmdtarget); otherwise, link-time or runtime errors may occur. For all files where
-vecabi=cmdtarget (or /Qvecabi:cmdtarget) is specified, options [Q]x and/or [Q]ax must have
identical values.

Similarly, link errors may occur if you attempt to link code compiled with -vecabi=cmdtarget
(or /Qvecabi:cmdtarget) with libraries or other program modules/routines that contain vector function
definitions that have not or cannot be recompiled.

When cmdtarget is specified, the additional vector function versions are created by copying each vector
specification and changing target processor in the copy. The number of vector functions is determined by the
settings specified in options [Q]x and/or [Q]ax.

For example, suppose we have the following function declaration:

function foo(a)
!Somp declare simd processor (core 2 duo ssed 1)
implicit none
integer, intent(in) :: a
integer 38 OO
end function foo

and the following options are specified: -axAvVX, CORE-AVX2.

The following table shows the different results for the above declaration and option specifications when
setting gcc or setting cmdtarget is used:

gcc cmdtarget

A vector version is created for each of the following A vector version is created for each of the following

targets: targets:

¢ Intel® SSE2 e Intel® SSE2 (default because no -x option is

e Intel® AVX used)

¢ Intel® AVX2 e Intel® SSE4.1 (by vector function specification)
¢ Intel® AVX512 ¢ Intel® AVX2 (by the ax option value)

These variants are always created independently of
target options.

NOTE

To avoid possible link-time and runtime errors, use identical [0]vecabi settings when
compiling all files in an application that define or use vector functions, including libraries. If
setting cmdtarget is specified, options [0]x and/or [Q]ax must have identical values.

For more information about the Intel®-compatible vector functions ABI, see the downloadable PDF titled
Vector Function Application Binary Interface.

For more information about the GCC vector functions ABI, see the item Libmvec - vector math library
document in the GLIBC wiki at sourceware.org.
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Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

Code Generation Options

This section contains descriptions for compiler options that pertain to code generation. They are listed in
alphabetical order.

arch

Tells the compiler which features it may target,
including which instruction sets it may generate.

Syntax
Linux OS:

—-arch code
Windows OS:

/arch: code

Arguments

code Indicates to the compiler a feature set that it may target, including which instruction sets it
may generate. Possible values are:

ALDERLAKE May generate instructions for processors that support the
AMBERLAKE specified Intel® processor or microarchitecture code name.

BROADWELL Keyword ICELAKE is deprecated and may be removed in a
CANNONLAKE future release

CASCADELAKE
COFFEELAKE
COOPERLAKE
GOLDMONT
GOLDMONT-PLUS
HASWELL
ICELAKE-CLIENT (or ICELAKE)
ICELAKE-SERVER
IVYBRIDGE
KABYLAKE
ROCKETLAKE
SANDYBRIDGE
SAPPHIRERAPIDS
SILVERMONT

137


https://www.intel.com/PerformanceIndex
https://www.intel.com/PerformanceIndex

1 Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

SKYLAKE

SKYLAKE-AVX512

TIGERLAKE
TREMONT
WHISKEYLAKE

CORE-AVX2

CORE-AVX-I

AVX2

AVX

SSE4.2

SSE4.1

SSSE3

SSE3
SSE2 (ifort only)

SSE (ifort only)

1A32 (ifort only)

Default

varies

Description

May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions.

May generate the RDRND instruction, Intel® Advanced
Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions.

May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, Intel® SSE4.2, SSE4.1, SSE3, SSE2,
SSE, and SSSE3 instructions.

May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

May generate Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE,
and SSSE3 instructions.

May generate Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

May generate SSSE3 instructions and Intel® SSE3, SSE2,
and SSE instructions.

May generate Intel® SSE3, SSE2, and SSE instructions.
May generate Intel® SSE2 and SSE instructions.

This setting has been deprecated. It is the same as
specifying 1a32.

Generates x86/x87 generic code that is compatible with
IA-32 architecture. Disables any default extended
instruction settings, and any previously set extended
instruction settings. It also disables all feature-specific
optimizations and instructions.

This value is only available on IA-32 architecture. IA-32
support is deprecated; it will be removed in a future
release.

If option arch is not specified, the default target architecture supports
Intel® SSE?2 instructions.

This option tells the compiler which features it may target, including which instruction sets it may generate.
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Code generated with these options should execute on any compatible, non-Intel processor with support for
the corresponding instruction set.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

NOTE
ifx only generates 64-bit objects.

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Enable Enhanced Instruction Set

Alternate Options

None

See Also

%, Ox compiler option

xHost, QxHost compiler option
ax, Qax compiler option

arch compiler option

march compiler option

m compiler option

ax, Qax

Tells the compiler to generate multiple, feature-
specific auto-dispatch code paths for Intel® processors
if there is a performance benefit.

Syntax
Linux OS:

—-axcode
Windows OS:
/Qaxcode
Arguments

code Indicates to the compiler a feature set that it may target, including which instruction sets it
may generate. The following descriptions refer to Intel® Streaming SIMD Extensions (Intel®
SSE) and Supplemental Streaming SIMD Extensions (SSSE). Possible values are:

ALDERLAKE May generate instructions for processors that support the
AMBERLAKE specified Intel® processor or microarchitecture code name.
BROADWELL Keyword ICELAKE is deprecated and may be removed in a
CANNONLAKE future release.

CASCADELAKE
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COFFEELAKE
COOPERLAKE

GOLDMONT

GOLDMONT-PLUS

HASWELL
ICELAKE-CLIENT (or ICELAKE)
ICELAKE-SERVER

IVYBRIDGE

KABYLAKE

ROCKETLAKE

SANDYBRIDGE
SAPPHIRERAPIDS

SILVERMONT

SKYLAKE

SKYLAKE-AVX512

TIGERLAKE

TREMONT

WHISKEYLAKE

COMMON-AVX512

CORE-AVX512

CORE-AVX2

CORE-AVX-I

AVX

SSE4.2

SSE4.1

SSSE3

May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), as well as the
instructions enabled with CORE-AVX2.

May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), Intel® AVX-512
Doubleword and Quadword Instructions (DQI), Intel®
AVX-512 Byte and Word Instructions (BWI) and Intel®
AVX-512 Vector Length extensions, as well as the
instructions enabled with CORE-AVX2.

May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions for Intel® processors.

May generate the RDRND instruction, Intel® Advanced
Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions for Intel®
processors.

May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors.

May generate Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE,
and SSSE3 instructions for Intel processors.

May generate Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors.

May generate SSSE3 instructions and Intel® SSE3, SSE2,
and SSE instructions for Intel® processors.
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SSE3 May generate Intel® SSE3, SSE2, and SSE instructions for
Intel® processors.

SSE2 (ifort only) May generate Intel® SSE2 and SSE instructions for Intel®
processors.

You can specify more than one code value. When specifying more than one code value, each value must be
separated with a comma. See the Examples section below.

Default

OFF No auto-dispatch code is generated. Feature-specific code is generated and is controlled by the
setting of the following compiler options:
e Linux*: -march and -x
e Windows*: /arch and /Qx

Description

This option tells the compiler to generate multiple, feature-specific auto-dispatch code paths for Intel®
processors if there is a performance benefit. It also generates a baseline code path. The Intel feature-specific
auto-dispatch path is usually more optimized than the baseline path. Other options, such as 03, control how
much optimization is performed on the baseline path.

The baseline code path is determined by the architecture specified by options -march or -x (Linux*) or
options /arch or /Qx (Windows*). While there are defaults for the [Q]x option that depend on the operating
system being used, you can specify an architecture and optimization level for the baseline code that is higher
or lower than the default. The specified architecture becomes the effective minimum architecture for the
baseline code path.

If you specify both the [0]ax and [Q]x options, the baseline code will only execute on Intel® processors
compatible with the setting specified for the [Q] x.

If you specify both the -ax and -march options (Linux) or the /Qax and /arch options (Windows), the
baseline code will execute on non-Intel® processors compatible with the setting specified for the -march
or /arch option.

A Non-Intel® baseline and an Intel® baseline have the same set of optimizations enabled, and the default for
both is SSE4.2 for x86-based architectures.

The [Q]ax option tells the compiler to find opportunities to generate separate versions of functions that take
advantage of features of the specified instruction features.

If the compiler finds such an opportunity, it first checks whether generating a feature-specific version of a
function is likely to result in a performance gain. If this is the case, the compiler generates both a feature-
specific version of a function and a baseline version of the function. At runtime, one of the versions is chosen
to execute, depending on the Intel® processor in use. In this way, the program can benefit from performance
gains on more advanced Intel processors, while still working properly on older processors and non-Intel
processors. A non-Intel processor always executes the baseline code path.

You can use more than one of the feature values by combining them. For example, you can specify
-axSSE4.1,SSSE3 (Linux) or /QaxSSE4.1, SSSE3 (Windows).

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.
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NOTE

When using the ifx compiler, if you experience any program failure when using option -ax

during this release, please remove the option to see if that solves the problem
solved the problem, please report a bug.

. If that action

NOTE
ifx only generates 64-bit objects.

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Add Processor-Optimized Code Path

Alternate Options

None

Examples

The following shows an example of how to specify this option:

ifx -axSKYLAKE file.cpp ! Linux* systems
ifx /QaxSKYLAKE file.cpp ! Windows* systems

The following shows an example of how to specify more than one code value:

ifx -axSKYLAKE, BROADWELL file.cpp ! Linux* systems
ifx /QaxBROADWELL, SKYLAKE file.cpp ! Windows* systems

Note that the comma-separated list must have no spaces between the names.

See Also

%, Ox compiler option

xHost, QxHost compiler option
march compiler option

arch compiler option

m compiler option

fasynchronous-unwind-tables

Determines whether unwind information is precise at
an instruction boundary or at a call boundary.

Syntax
Linux OS:

-fasynchronous-unwind-tables

-fno-asynchronous-unwind-tables

Windows OS:

None

Arguments

None
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Default

Intel® 64 architecture: The unwind table generated is precise at an instruction boundary,
-fasynchronous-unwind-tables €nabling accurate unwinding at any instruction.

IA-32 architecture (ifort only): The unwind table generated is precise at call boundaries only.

-fno-asynchronous-unwind-tables

Description

This option determines whether unwind information is precise at an instruction boundary or at a call
boundary. The compiler generates an unwind table in DWARF2 or DWARF3 format, depending on which
format is supported on your system.

If -fno-asynchronous-unwind-tables is specified, the unwind table is precise at call boundaries only. In
this case, the compiler will avoid creating unwind tables for routines such as the following:

e A C++ routine that does not declare objects with destructors and does not contain calls to routines that
might throw an exception.

e A C/C++ or Fortran routine compiled without -fexceptions and without -traceback.

e A C/C++ or Fortran routine compiled with -fexceptions that does not contain calls to routines that
might throw an exception.

IDE Equivalent

None

Alternate Options

None

See Also
fexceptions compiler option

fcf-protection, Qcf-protection

Enables Intel® Control-Flow Enforcement Technology
(Intel® CET) protection, which defends your program
from certain attacks that exploit vulnerabilities. This
option offers preliminary support for Intel® CET.

Syntax
Linux OS:

—-fcf-protection[=keyword]

Windows OS:

/Qcf-protection|: keyword]

Arguments

keyword Specifies the level of protection the compiler should perform. Possible values are:

return Enables shadow stack protection. This keyword
is only available for ifx, and only on Linux.

branch Enables endbranch (EB) generation. This
keyword is only available for ifx, and only on
Linux.
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shadow stack Enables shadow stack protection. On ifx, this
N keyword is only available for Windows.

branch tracking Enables endbranch (EB) generation. On ifx, this
keyword is only available for Windows.

full Enables shadow stack protection and endbranch
(EB) generation.
This is the same as specifying this compiler
option with no keyword.

none Disables Intel® CET protection.

Default

-fcf-protection=none No Control-flow Enforcement protection is performed.

or /Qcf-protection:none

Description

This option enables Intel® CET protection, which defends your program from certain attacks that exploit
vulnerabilities.

Intel® CET protections are enforced on processors that support Intel® CET. They are ignored on processors
that do not support Intel® CET, so they are safe to use in programs that might run on a variety of processors.

Shadow stack protection helps to protect your program from return-oriented programming (ROP). Return-
oriented programming (ROP) is a technique to exploit computer security defenses such as non-executable
memory and code signing by gaining control of the call stack to modify program control flow and then
execute certain machine instruction sequences.

Endbranch (EB) generation helps to protect your program from call/jump-oriented programming (COP/JOP).
Jump-oriented programming (JOP) is a variant of ROP that uses indirect jumps and calls to emulate return
instructions. Call-oriented programming (COP) is a variant of ROP that employs indirect calls.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options
Linux: —gcf-protection

Windows: None

fexceptions
Enables exception handling table generation.

Syntax
Linux OS:

-fexceptions
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-fno-exceptions

Windows OS:

None

Arguments

None
Default

-fno-exceptions Exception handling table generation is disabled.

Description

This option enables C++ exception handling table generation, preventing Fortran routines in mixed-language
applications from interfering with exception handling between C++ routines.

The -fno-exceptions option disables C++ exception handling table generation, resulting in smaller code.
When this option is used, any use of C++ exception handling constructs (such as try blocks and throw
statements) when a Fortran routine is in the call chain will produce an error.

IDE Equivalent

None

Alternate Options

None

fomit-frame-pointer
Determines whether EBP is used as a general-purpose
register in optimizations.

Syntax
Linux OS:

-fomit-frame-pointer
-fno-omit-frame-pointer

Windows OS:

None
Arguments
None
Default

-fomit-frame-pointer EBP is used as a general-purpose register in optimizations.
However, the default can change depending on the following:

If option -00 or -g is specified, the default is -fno-omit-frame-pointer.

Description

These options determine whether EBP is used as a general-purpose register in optimizations. Option
-fomit-frame-pointer allows this use. Option -fno-omit-frame-pointer disallows it.
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Some debuggers expect EBP to be used as a stack frame pointer, and cannot produce a stack backtrace
unless this is so. The -fno-omit-frame-pointer option directs the compiler to generate code that
maintains and uses EBP as a stack frame pointer for all functions so that a debugger can still produce a stack
backtrace without doing the following:

e For -fno-omit-frame-pointer: turning off optimizations with -00

The -fno-omit-frame-pointer option is set when you specify option -00 or the -g option. The
-fomit-frame-pointer option is set when you specify option -01, -02, or -03.

On ifort, using the -fno-omit-frame-pointer option reduces the number of available general-purpose
registers by 1, and can result in slightly less efficient code.

IDE Equivalent

Windows

Visual Studio: Optimization > Omit Frame Pointers

Alternate Options
Linux: —fp (this is a deprecated option)

Windows: None

See Also
momit-leaf-frame-pointer compiler option

guard
Enables the control flow protection mechanism.

Syntax
Linux OS:

None

Windows OS:

/quard: keyword

Arguments

keyword Specifies the control flow protection mechanism. Possible values are:

cf[-] Tells the compiler to analyze control flow of valid targets for indirect calls and to insert
code to verify the targets at runtime.

To explicitly disable this option, specify /guard:cf-.

Default

OFF The control flow protection mechanism is disabled.

Description

This option enables the control flow protection mechanism. It tells the compiler to analyze control flow of
valid targets for indirect calls and inserts a call to a checking routine before each indirect call to verify the
target of the given indirect call.

The /guard:cf option must be passed to both the compiler and linker.
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Code compiled using /guard:cf can be linked to libraries and object files that are not compiled using the
option.

This option has been added for Microsoft compatibility. It uses the Microsoft implementation.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

hotpatch

Tells the compiler to prepare a routine for
hotpatching. This feature is only available for ifort.

Syntax

Linux OS:
-hotpatch[=n]
Windows OS:
/hotpatch[:n]

Arguments

n An integer specifying the number of bytes the compiler should add
before the function entry point.

Default

OFF The compiler does not prepare routines for hotpatching.

Description

This option tells the compiler to prepare a routine for hotpatching. The compiler inserts nop padding around
function entry points so that the resulting image is hot patchable.

Specifically, the compiler adds nop bytes after each function entry point and enough nop bytes before the
function entry point to fit a direct jump instruction on the target architecture.

If n is specified, it overrides the default number of bytes that the compiler adds before the function entry
point.

IDE Equivalent

None

Alternate Options

None
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m, Qm
Tells the compiler which instruction set extensions
based on CPUID bits it may generate.

Syntax
Linux OS:

-mcode

Windows OS:
/Omcode (1fx)

None (ifort)

Arguments

code Indicates the instruction set extensions based on CPUID bits that the compiler may
generate.
ifx: Many of the Clang settings for option -m are supported. For more information on Clang
settings for -m, see the Clang documentation.
ifort: Many of the gcc settings for option -m are supported. For more information on gcc
settings for -m, see the gcc documentation.

Default

varies If option arch is not specified, the default target architecture supports

Intel® SSE2 instructions.
Description

This option tells the compiler which instruction set extensions based on CPUID bits it may generate.

Code generated with these options should execute on any compatible, non-Intel processor with support for
the corresponding instruction set.

NOTE

Options -m and /om enable specific sets of instructions based on CPUID bits. If you want to
enable all instructions supported by a named microarchitecture, you should use option
-march (Linux) or /arch (Windows).

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None
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See Also

%, Ox compiler option

xHost, QxHost compiler option
ax, Qax compiler option

arch compiler option

march compiler option

m32, m64, Qm32, Qm64

Tells the compiler to generate code for a specific
architecture. Option m32 (and Qm32) is deprecated
and will be removed in a future release. 32-bit options
are only available for ifort.

Syntax

Linux OS:
-m32 (ifort only)

-m64

Windows OS:
/0m32 (ifort only)
/Qm64

Arguments

None

Default

ifort: OFF The compiler's behavior depends on the host system.

On ifx: The compiler generates code for Intel® 64 architecture.
-m64
or /Qm64

Description

These options tell the compiler to generate code for a specific architecture.

Option Description

-m32 or /Qm32 Tells the compiler to generate code for IA-32
architecture. IA-32 support is deprecated and will
be removed in a future release. 32-bit options are
only available for ifort.

-m64 or /Qm64 Tells the compiler to generate code for Intel® 64
architecture.

On Linux* systems, these options are provided for compatibility with gcc.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.
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IDE Equivalent

None

Alternate Options

None

m80387
Specifies whether the compiler can use x87
instructions.

Syntax
Linux OS:
-m80387
-mno-80387
Windows OS:

None

Arguments
None
Default

-m80387 The compiler may use x87 instructions.

Description
This option specifies whether the compiler can use x87 instructions.

If you specify option -mno-80387, it prevents the compiler from using x87 instructions. If the compiler is
forced to generate x87 instructions, it issues an error message.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

-m[no-]x87

march
Tells the compiler to generate code using the CPU
feature set of a specific processor as the baseline.

Syntax
Linux OS:

-march=processor
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Windows OS:

None
Arguments

processor

Default

OFF

Tells the compiler which CPU features it can use. Possible values are:

nocona, core2, penryn,

bonnell, atom,
silvermont, slm,
goldmont, goldmont-plus,
tremont, gracemont,
nehalem, corei?”,
westmere, sandybridge,
corei7-avx, ivybridge,
core-avx-i, haswell,
broadwell,

common-avx512,

core-avx2,
skylake,
skylake-avx512, skx,
cascadelake, cooperlake,
cannonlake, icelake-
client, rocketlake,
icelake-server,
tigerlake,
sapphirerapids,
alderlake,

meteorlake,

raptorlake,
sierraforest,
grandridge,
graniterapids,
emeraldrapids

x86-64

x86-64-v2

x86-64-v3

x86-64-v4

Generates code using the CPU feature set of the specified
Intel® processor or microarchitecture code name.

Keywords amberlake, coffeelake, icelake,
kabylake, and whiskeylake are only available for ifort.

Note that keyword icelake is deprecated and may be
removed in a future release.

Generates code for a generic CPU with 64-bit extensions.

Generates code for Intel® SSE4.3, SSE4.2, SSE4.1, SSE3,
SSE2, SSE, and SSSE3.

Generates code for Intel® Advanced Vector Extensions 2
(Intel® AVX2), Intel® AVX, Intel® SSE4.3, SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3.

Generates code for Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), Intel® AVX-512
Doubleword and Quadword Instructions (DQI), Intel®
AVX-512 Byte and Word Instructions (BWI) and Intel®
AVX-512 Vector Length Extensions (VLE).

If option -march is not specified, the compiler may generate Intel® SSE2 and SSE

instructions.
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Description

This option tells the compiler to generate code using the CPU feature set of a specific processor as the
baseline.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

NOTE
ifx does not support compilation for 32-bit architectures; only processor values for 64-bit
instruction sets can be specified for ifx.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

xHost, OxHost compiler option

x, Ox compiler option

ax, Qax compiler option

arch compiler option

minstruction, Qinstruction compiler option
m compiler option

masm
Tells the compiler to generate the assembler output
file using a selected dialect.

Syntax
Linux OS:

-masm=dialect

Windows OS:

None

Arguments

dialect Is the dialect to use for the assembler output file. Possible values are:
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Tells the compiler to generate the assembler

att
output file using AT&T* syntax.
intel Tells the compiler to generate the assembler
output file using Intel syntax.
Default
—masm=att The compiler generates the assembler output file using AT&T* syntax.
Description

This option tells the compiler to generate the assembler output file using a selected dialect.

NOTE

This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

mauto-arch, Qauto-arch

Tells the compiler to generate multiple, feature-
specific auto-dispatch code paths for x86 architecture
processors if there is a performance benéefit.

Syntax
Linux OS:

-mauto-arch=value

Windows OS:

/Qauto-arch:value

Arguments

value Is any setting you can specify for option [Q] ax.

Default

OFF No additional execution path is generated.

Description

This option tells the compiler to generate multiple, feature-specific auto-dispatch code paths for x86
architecture processors if there is a performance benefit. It also generates a baseline code path.

This option cannot be used together with any options that may require Intel-specific optimizations (such as

[Q]lx or [Q]ax).
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NOTE

This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None
Alternate Options

None

See Also
ax, Qax compiler option

mbranches-within-32B-boundaries, Qbranches-within-32B-boundaries

Tells the compiler to align branches and fused

branches on 32-byte boundaries for better
performance.

Syntax
Linux OS:

-mbranches-within-32B-boundaries
-mno-branches-within-32B-boundaries

Windows OS:
/Qbranches-within-32B-boundaries

/Obranches-within-32B-boundaries-

Arguments

None
Default

-mno-branches-within-32B-boundaries
or /Qbranches-within-32B-boundaries-

Description

Branches and fused branches are not aligned on 32-
byte boundaries.

This option tells the compiler to align branches and fused branches on 32-byte boundaries for better

performance.

NOTE

When you use this option, it may affect binary utilities usage experience, such as

debugability.

NOTE

This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.
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IDE Equivalent

None

Alternate Options

None

mconditional-branch, Qconditional-branch

Lets you identify and fix code that may be vulnerable
to speculative execution side-channel attacks, which

can leak your secure data as a result of bad

speculation of a conditional branch direction. This

feature is only available for ifort.

Syntax
Linux OS:

-mconditional-branch=keyword

Windows OS:

/Qconditional-branch:keyword

Arguments

keyword Tells the compiler the action to take. Possible values are:

keep

pattern-report

pattern-fix

all-fix

all-fix-1lfence

Tells the compiler to not attempt any vulnerable code detection
or fixing. This is equivalent to not specifying the
-mconditional-branch option.

Tells the compiler to perform a search of vulnerable code
patterns in the compilation and report all occurrences to
stderr.

Tells the compiler to perform a search of vulnerable code
patterns in the compilation and generate code to ensure that
the identified data accesses are not executed speculatively. It
will also report any fixed patterns to stderr.

This setting does not guarantee total mitigation, it only fixes
cases where all components of the vulnerability can be seen or
determined by the compiler. The pattern detection will be more
complete if advanced optimization options are specified or are
in effect, such as option 03 and option -ipo (or /Qipo).

Tells the compiler to fix all of the vulnerable code so that it is
either not executed speculatively, or there is no observable
side-channel created from their speculative execution. Since it
is a complete mitigation against Spectre variant 1 attacks, this
setting will have the most runtime performance cost.

In contrast to the pattern-fix setting, the compiler will not
attempt to identify the exact conditional branches that may
have led to the mis-speculated execution.

This is the same as specifying setting all1-fix.
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all-fix-cmov Tells the compiler to treat any path where speculative
execution of a memory load creates vulnerability (if
mispredicted). The compiler automatically adds mitigation
code along any vulnerable paths found, but it uses a different
method then the one used for all-fix (or all-fix-1fence).

This method uses CMOVcc instruction execution, which
constrains speculative execution. Thus, it is used for keeping
track of the predicate value, which is updated on each
conditional branch.

To prevent Spectre v.1 attack, each memory load that is
potentially vulnerable is bitwise ORed with the predicate to
mask out the loaded value if the code is on a mispredicted
path.

This is analogous to the Clang compiler's option to do
Speculative Load Hardening.

This setting is only supported on Intel® 64 architecture-based

systems.
Default
-mconditional-branch=keep The cqmpiler _d(_)es not attempt any vulnerable code
and /Qconditional-branch:keep detection or fixing.
Description

This option lets you identify code that may be vulnerable to speculative execution side-channel attacks,
which can leak your secure data as a result of bad speculation of a conditional branch direction. Depending
on the setting you choose, vulnerabilities may be detected and code may be generated to attempt to mitigate
the security risk.

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Spectre Variant 1 Mitigation

Alternate Options

None

minstruction, Qinstruction

Determines whether MOVBE instructions are
generated for certain Intel® processors. This feature is
only available for ifort.

Syntax
Linux OS:

-minstruction=[no]movbe

Windows OS:

/Qinstruction: [no]movbe
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Arguments

None

Default

—minstruction=nomovbe The compiler does not generate MOVBE instructions

. . ®
or/0instruction:nomovbe for Intel Atom® processors.

Description

This option determines whether MOVBE instructions are generated for Intel Atom® processors. To use this
option, you must also specify [Q]xATOM SSSE3 or [Q]xATOM SSE4.2.

If -minstruction=movbe or /Qinstruction:movbe is specified, the following occurs:

e MOVBE instructions are generated that are specific to the Intel Atom® processor.

e Generated executables can only be run on Intel Atom® processors or processors that support
Supplemental Streaming SIMD Extensions 3 (Intel® SSSE3) or Intel® Streaming SIMD Extensions 4.2
(Intel® SSE4.2) and MOVBE.

If -minstruction=nomovbe Or /Qinstruction:nomovbe is specified, the following occurs:

e The compiler optimizes code for the Intel Atom® processor, but it does not generate MOVBE instructions.
e Generated executables can be run on non-Intel Atom® processors that support Intel® SSE3 or Intel®
SSE4.2.

IDE Equivalent

None

Alternate Options

None

See Also
x, Ox compiler option

momit-leaf-frame-pointer
Determines whether the frame pointer is omitted or
kept in leaf functions.

Syntax
Linux OS:

-momit-leaf-frame-pointer
-mno-omit-leaf-frame-pointer

Windows OS:

None

Arguments

None
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Default

Varies If you specify option -fomit-frame-pointer (or it is set by default), the default is
-momit-leaf-frame-pointer. If you specify option —fno-omit-frame-pointer, the default is
-mno-omit-leaf-frame-pointer.

Description

This option determines whether the frame pointer is omitted or kept in leaf functions. It is related to option
-f[no-]Jomit-frame-pointer and the setting for that option has an effect on this option.

Consider the following option combinations:

Option Combination Result

-fomit-frame-pointer -momit-leaf-frame-pointer Both combinations are the same as

or specifying -fomit-frame-pointer.
Frame pointers are omitted for all

-fomit-frame-pointer -mno-omit-leaf-frame-pointer routines.

-fno-omit-frame-pointer -momit-leaf-frame-pointer In this case, the frame pointer is
omitted for leaf routines, but other
routines will keep the frame pointer.
This is the intended effect of option
-momit-leaf-frame-pointer.

-fno-omit-frame-pointer -mno-omit-leaf-frame-pointer In this case,

-mno-omit-leaf-frame-pointer is
ignored since
-fno-omit-frame-pointer retains
frame pointers in all routines .

This combination is the same as
specifying
-fno-omit-frame-pointer.

This option is provided for compatibility with gcc.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

See Also
fomit-frame-pointer compiler option
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mstringop-inline-threshold, Qstringop-inline-threshold
Tells the compiler to not inline calls to buffer
manipulation functions such as memcpy and memset
when the number of bytes the functions handle are
known at compile time and greater than the specified
value. This feature is only available for ifort.

Syntax
Linux OS:
-mstringop-inline-threshold=val

Windows OS:

/QOstringop-inline-threshold:val

Arguments

val Is a positive 32-bit integer. If the size is greater than val, the compiler
will never inline it.

Default

OFF The compiler uses its own heuristics to determine the default.

Description

This option tells the compiler to not inline calls to buffer manipulation functions such as memcpy and memset
when the number of bytes the functions handle are known at compile time and greater than the specified val.

IDE Equivalent

None

Alternate Options

None

See Also
mstringop-strategy, Qstringop-strategy compiler option

mstringop-strategy, Qstringop-strategy

Lets you override the internal decision heuristic for the
particular algorithm used when implementing buffer
manipulation functions such as memcpy and memset.
This feature is only available for ifort.

Syntax
Linux OS:

-mstringop-strategy=alg
Windows OS:
/Qstringop-strategy:alg
Arguments

alg Specifies the algorithm to use. Possible values are:
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const size loop Tells the compiler to expand the string operations into an inline
loop when the size is known at compile time and it is not
greater than threshold value. Otherwise, the compiler uses its
own heuristics to decide how to implement the string
operation.

libcall Tells the compiler to use a library call when implementing
string operations.

rep Tells the compiler to use its own heuristics to decide what form
of rep movs | stos to use when inlining string operations.

Default

varies If optimization option Os is specified, the default is rep. Otherwise, the default is
const_size loop.

Description

This option lets you override the internal decision heuristic for the particular algorithm used when
implementing buffer manipulation functions such as memcpy and memset.

This option may have no effect on compiler-generated string functions, for example, a call to memcpy
generated by the compiler to implement an array copy or structure copy.

IDE Equivalent

None

Alternate Options

None

See Also
mstringop-inline-threshold, Qstringop-inline-threshold compiler option
Os compiler option

mtune, tune

Performs optimizations for specific processors but
does not cause extended instruction sets to be used
(unlike -march).

Syntax
Linux OS:

—mtune=processor

Windows OS:

/tune:processor

Arguments

processor Is the processor for which the compiler should perform optimizations. Possible values
are:
generic Optimizes code for the compiler's default behavior.
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alderlake
amberlake
broadwell
cannonlake
cascadelake
coffeelake
cooperlake
goldmont
goldmont-plus
haswell
icelake-client (or
icelake)
icelake-server
ivybridge
kabylake
rocketlake
sandybridge
sapphirerapids
silvermont
skylake
skylake-avx512
tigerlake
tremont
whiskeylake

core-avx2

core-avx-i

corei7-avx

corei’

atom

Optimizes code for processors that support the
specified Intel® processor or microarchitecture code
name.

Keywords amberlake, coffeelake, icelake,
kabylake, and whiskeylake are only available for
ifort.

Keywords icelake-client and icelake are
deprecated and may be removed in a future release.

Optimizes code for processors that support Intel®
Advanced Vector Extensions 2 (Intel® AVX2), Intel®
AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

Optimizes code for processors that support the RDRND
instruction, Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions.

Optimizes code for processors that support Intel®
Advanced Vector Extensions (Intel® AVX), Intel®
SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

Optimizes code for processors that support Intel® SSE4
Efficient Accelerated String and Text Processing
instructions. May also generate code for Intel® SSE4
Vectorizing Compiler and Media Accelerator, Intel®
SSE3, SSE2, SSE, and SSSE3 instructions.

Optimizes code for processors that support MOVBE
instructions, depending on the setting of option
-minstruction (Linux) or /Qinstruction
(Windows). May also generate code for SSSE3
instructions and Intel® SSE3, SSE2, and SSE
instructions.
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Optimizes for the Intel® Core™2 processor family,

core?2
including support for MMX™, Intel® SSE, SSE2, SSE3,
and SSSE3 instruction sets.
Default
generic Code is generated for the compiler's default behavior.
Description

This option performs optimizations for specific processors but does not cause extended instruction sets to be
used (unlike -march).

The resulting executable is backwards compatible and generated code is optimized for specific processors.
For example, code generated with -mtune=core2 or /tune:core2 runs correctly on 4th Generation Intel®
Core™ processors, but it might not run as fast as if it had been generated using -mtune=haswell

or /tune:haswell.

Code generated with -mtune=haswell (/tune:haswell) or -mtune=core-avx2 (/tune:core-avx2) will
also run correctly on Intel® Core™2 processors, but it might not run as fast as if it had been generated using
-mtune=core2 Or /tune :core?2.

This is in contrast to code generated with -march=core-avx2 or /arch:core-avx2, which will not run
correctly on older processors such as Intel® Core™2 processors.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

NOTE
ifx does not support compilation for 32-bit architectures; only processor values for 64-bit
instruction sets can be specified for ifx.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Windows

Visual Studio: Code Generation >Intel Processor Microarchitecture-Specific Optimization

Alternate Options

None

See Also
march compiler option
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Qpatchable-addresses

Tells the compiler to generate code such that
references to statically assigned addresses can be
patched. This feature is only available for ifort.

Architecture Restrictions

Only available on Intel® 64 architecture

Syntax
Linux OS:

None
Windows OS:
/Qpatchable-addresses

Arguments

None
Default

OFF The compiler does not generate patchable addresses.

Description

This option tells the compiler to generate code such that references to statically assigned addresses can be
patched with arbitrary 64-bit addresses.

Normally, the Windows* system compiler that runs on Intel® 64 architecture uses 32-bit relative addressing
to reference statically allocated code and data. That assumes the code or data is within 2GB of the access
point, an assumption that is enforced by the Windows object format.

However, in some patching systems, it is useful to have the ability to replace a global address with some
other arbitrary 64-bit address, one that might not be within 2GB of the access point.

This option causes the compiler to avoid 32-bit relative addressing in favor of 64-bit direct addressing so that
the addresses can be patched in place without additional code modifications. This option causes code size to
increase, and since 32-bit relative addressing is usually more efficient than 64-bit direct addressing, you may
see a performance impact.

IDE Equivalent

None

Alternate Options

None

X, Qx

Tells the compiler which processor features it may
target, including which instruction sets and
optimizations it may generate.

Syntax
Linux OS:

-xcode
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Windows OS:
/Qxcode

Arguments

code Specifies a feature set that the compiler can target, including which instruction sets and
optimizations it may generate. Possible values are:

ALDERLAKE May generate instructions for processors that support the
AMBERLAKE specified Intel® processor or microarchitecture code name.
BROADWELL Optimizes for the specified Intel® processor or
CANNONLAKE microarchitecture code name.

CASCADELAKE Keyword ICELAKE is deprecated and may be removed in a
COFFEELAKE future release.

COOPERLAKE

GOLDMONT

GOLDMONT-PLUS

HASWELL

ICELAKE-CLIENT (or ICELAKE)
ICELAKE-SERVER

IVYBRIDGE

KABYLAKE

ROCKETLAKE

SANDYBRIDGE

SAPPHIRERAPIDS

SILVERMONT

SKYLAKE

SKYLAKE-AVX512

TIGERLAKE

TREMONT

WHISKEYLAKE

COMMON-AVX512 May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), as well as the
instructions enabled with CORE-AVX2. Optimizes for Intel®
processors that support Intel® AVX-512 instructions.

CORE-AVX512 May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), Intel® AVX-512
Doubleword and Quadword Instructions (DQI), Intel®
AVX-512 Byte and Word Instructions (BWI) and Intel®
AVX-512 Vector Length Extensions (VLE), as well as the
instructions enabled with CORE-AVX2. Optimizes for Intel®
processors that support Intel® AVX-512 instructions.

CORE-AVX?2 May generate Intel® Advanced Vector Extensions 2 (Intel®

AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions for Intel® processors. Optimizes for
Intel® processors that support Intel® AVX2 instructions.
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CORE-AVX-I

AVX

SSE4.2

SSE4.1

ATOM SSEA4.2

ATOM SSSE3

SSSE3

SSE3

SsE2 (ifort only)

May generate the RDRND instruction, Intel® Advanced
Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions for Intel®
processors. Optimizes for Intel® processors that support
the RDRND instruction.

May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors. Optimizes for Intel
processors that support Intel® AVX instructions.

May generate Intel® SSE4 Efficient Accelerated String and
Text Processing instructions, Intel® SSE4 Vectorizing
Compiler and Media Accelerator, and Intel® SSE3, SSE2,
SSE, and SSSE3 instructions for Intel® processors.
Optimizes for Intel processors that support Intel® SSE4.2
instructions.

May generate Intel® SSE4 Vectorizing Compiler and Media
Accelerator instructions for Intel® processors. May generate
Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3 instructions
for Intel processors that support Intel® SSE4.1 instructions.

May generate MOVBE instructions for Intel® processors,
depending on the setting of option -minstruction (Linux)
or /Qinstruction (Windows). May also generate Intel®
SSE4.2, SSE3, SSE2, and SSE instructions for Intel
processors. Optimizes for Intel Atom® processors that
support Intel® SSE4.2 and MOVBE instructions.

This keyword is only available on Windows and Linux
systems.

May generate MOVBE instructions for Intel® processors,
depending on the setting of option -minstruction (Linux)
or /Qinstruction (Windows). May also generate SSSE3,
Intel® SSE3, SSE2, and SSE instructions for Intel
processors. Optimizes for Intel Atom® processors that
support Intel® SSE3 and MOVBE instructions.

This keyword is only available on Windows and Linux
systems.

May generate SSSE3 and Intel® SSE3, SSE2, and SSE
instructions for Intel® processors. Optimizes for Intel
processors that support SSSE3 instructions.

May generate Intel® SSE3, SSE2, and SSE instructions for
Intel® processors. Optimizes for Intel processors that
support Intel® SSE3 instructions.

May generate Intel® SSE2 and SSE instructions for Intel®
processors. Optimizes for Intel processors that support
Intel® SSE2 instructions.

You can also specify a Host. For more information, see option [Q]xHost.
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Default

OFF If option -x or -march is not specified (Linux), or if option /0x
or /arch is not specified (Windows), the default target architecture
supports Intel® SSE2 instructions.

Description

This option tells the compiler which processor features it may target, including which instruction sets and
optimizations it may generate.

The resulting executables created from these option code values can only be run on Intel® processors that
support the indicated instruction set.

Do not use code values to create binaries that will execute on a processor that is not compatible with the
targeted processor. The resulting program may fail with an illegal instruction exception or display other
unexpected behavior.

Compiling the main program with any of the code values produces binaries that display a fatal runtime error
if they are executed on unsupported processors, including all non-Intel processors.

Compiler options -march (Linux) and /arch (Windows) produce binaries that can be run on processors not
made by Intel that implement the same capabilities as the corresponding Intel® processors.

The -x and /Qx options enable additional optimizations not enabled with options -march or /arch (nor with
options -ax and /Qax).

Linux

Options -x and -march are mutually exclusive. If both are specified, the compiler uses the last one specified
and generates a warning.

Windows

Options /Qx and /arch are mutually exclusive. If both are specified, the compiler uses the last one specified
and generates a warning.

NOTE
All settings (except SSE2) do a CPU check. However, if you specify option -00 (Linux) or
option /od (Windows), no CPU check is performed.

NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

NOTE
ifx does not support compilation for 32-bit architectures; only code values for 64-bit
instruction sets may be specified for ifx.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.
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Product and Performance Information

Notice revision #20201201

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Intel Processor-Specific Optimization

Alternate Options

None

See Also

xHost, OxHost compiler option

ax, Qax compiler option

arch compiler option

march compiler option

minstruction, Qinstruction compiler option
m compiler option

xHost, QxHost

Tells the compiler to generate instructions for the
highest instruction set available on the compilation
host processor.

Syntax
Linux OS:
-xHost

Windows OS:

/QOxHost

Arguments

None
Default

OFF If option -x or -march is not specified (Linux), or if option /Qx
or /arch is not specified (Windows), the default target architecture
supports Intel® SSE2 instructions.

Description

This option tells the compiler to generate instructions for the highest instruction set available on the
compilation host processor.

The instructions generated by this compiler option differ depending on the compilation host processor.

For more information on other settings for option [Q]x, see that option description.
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NOTE
This option only applies to host compilation. When offloading is enabled, it does not impact
device-specific compilation. Offloading can only be enabled when using ifx.

NOTE
ifx does not support compilation for 32-bit architectures; only 64-bit instruction set names
may be specified for ifx.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Intel Processor-Specific Optimization

Alternate Options

None

See Also

%, Ox compiler option
ax, Qax compiler option
m compiler option

arch compiler option

Offload Compilation, OpenMP*, and Parallel Processing Options

This section contains descriptions for compiler options that pertain to offload compilation, OpenMP*, or
parallel processing. They are listed in alphabetical order.

device-math-lib
Enables or disables certain device libraries.

Syntax

Linux OS:
-device-math-lib=I1ibrary
-no-device-math-lib=1ibrary
Windows OS:
/device-math-1lib:library
/no-device-math-1ib:library
Arguments

library Possible values are:
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fp32 Links the fp32 device math library.
fp64 Links the fp64 device math library.

To link more than one library, include a comma between the library names.

For example, if you want to link both the fp32 and fp64 device libraries, specify: fp32,
fp64

Default

fp32, fp64 Both the fp32 and fp64 device libraries are linked.

Description
This option enables or disables certain device libraries.

This is a deprecated option that may be removed in a future release. There is no replacement option.

IDE Equivalent

None

Alternate Options

None

See Also
fopenmp-device-lib compiler option
fsycl-device-lib compiler option

fiopenmp, Qiopenmp

Enables recognition of OpenMP* features and tells the
parallelizer to generate multi-threaded code based on

OpenMP* directives. Provides the ability to offload to a
GPU when -fopenmp-targets (or /Qopenmp-targets) is
also specified. This feature is only available for ifx.

Syntax
Linux OS:
-fiopenmp
Windows OS:
/Qiopenmp
Arguments
None
Default

OFF No OpenMP* multi-threaded code is generated by the compiler.

Description

This option enables recognition of OpenMP* features and tells the parallelizer to generate multi-threaded
code based on OpenMP* directives. The code can be executed in parallel on both uniprocessor and
multiprocessor systems.
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This option sets option auto.

This option works with any optimization level. Specifying no optimization (-00 on Linux* or /0d on
Windows*) helps to debug OpenMP applications.

To ensure that a threadsafe and/or reentrant runtime library is linked and correctly initialized, the same
option should also be used for the link step and for the compilation of the main routine.

NOTE
If you want to offload to a GPU target, you need to specify -fiopenmp (Or /Qiopenmp) along
with option -fopenmp-targets (Or /Qopenmp-targets).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio
Visual Studio: Language > OpenMP Support

Alternate Options
Linux: —gopenmp

Windows: /Qopenmp

See Also

fopenmp, Qopenmp compiler option

auto compiler option

fopenmp-targets, Qopenmp-targets conpreropHon

flink-huge-device-code

Tells the compiler to place device code later in the
linked binary. This is to prevent 32-bit PC-relative
relocations between surrounding Executable and
Linkable Format (ELF) sections when the device code
is larger than 2GB. This feature is only available for
ifx.

Syntax

Linux OS:
-flink-huge-device-code
-fno-link-huge-device-code
Windows OS:

None

Arguments

None
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Default

fno-link-huge-device-code No change is made to the linked binary.

Description

This option tells the compiler to place device code later in the linked binary. This is to prevent 32-bit PC-
relative relocations between surrounding Executable and Linkable Format (ELF) sections when the device
code is larger than 2GB.

This option impacts the host link for a full offload compilation. It does not impact device compilation directly,
but it is only useful when offloading is performed.

NOTE
When using this option, you must also specify option -fsycl or option -fopenmp-targets.

NOTE
This option only takes effect if a link action needs to be executed. For example, it will not
have any effect if certain other options are specified, such as -c or -E.

IDE Equivalent

None

Alternate Options

None

Example

The following shows an example of using this option:

ifx -fsycl -flink-huge-device-code c.o b.o -o b.out

fmpc-privatize

Enables or disables privatization of all static data for
the MultiProcessor Computing environment (MPC)
unified parallel runtime. This feature is only available
for ifort.

Architecture Restrictions

Only available on Intel® 64 architecture
Syntax

Linux OS:

-fmpc-privatize
-fno-mpc-privatize

Windows OS:

None

Arguments

None
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Default

-fno-mpc-privatize The privatization of all static data for the MPC unified parallel runtime
is disabled.

Description

This option enables or disables privatization of all static data for the MultiProcessor Computing environment
(MPC) unified parallel runtime.

Option -fmpc-privatize causes calls to extended thread-local-storage (TLS) resolution, runtime routines
that are not supported on standard Linux* distributions.

This option requires installation of the MPC unified parallel runtime. For more information, see http://
mpc.hpcframework.com/.

IDE Equivalent

None

Alternate Options

None

fopenmp, Qopenmp
Enables recognition of OpenMP* features and tells the
parallelizer to generate multi-threaded code based on
OpenMP* directives.

Syntax

Linux OS:
-fopenmp
-fno-openmp
Windows OS:
/Qopenmp
/Qopenmp-—

Arguments

None

Default

OFF No OpenMP* multi-threaded code is generated by the compiler.

Description

This option enables recognition of OpenMP* features and tells the parallelizer to generate multi-threaded
code based on OpenMP* directives. The code can be executed in parallel on both uniprocessor and
multiprocessor systems.

This op